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“Through my postgraduate studies, under 
the Unit for Urban Citizenship, in the 
University of Pretoria, I found passion within 
Architecture.  Having lived and studied 
in multiple cities across South Africa, I 
have been exposed to numerous contexts 
and approaches to the spatial discipline. 
This journey has guided my architectural 
approach for urban citizenship. It challenges 
conventional attitudes to the discipline, by 
focussing on user-centered design through 
the processes of co-design. Through this 
approach I have become fascinated with the 
use of design games as a mediating tool in 
assisting the co-design process. I am grateful 
that, through my postgraduate studies, I 
was able to put this approach into practice 
and explore the potential it has to offer the 
discipline. This accumulation of experiential 
wealth has shaped my perspective of the 
role of architecture within society. I intend 
this dissertation to serve as an imprint of 
discovered passion and an ignition for further 
development.”

- Purll Naidoo
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This document serves as a mini dissertation in 
the professional Master of Architecture degree in 
the Department of Architecture at the University 
of Pretoria. It focuses on the educational 
ecosystem within the context of South Africa, with 
emphasis placed on the economically distressed 
environment of Mamelodi East. Mamelodi is a 
township situated in the north east of the City of 
Tshwane, Gauteng. Due to the location of the 
University of Pretoria’s Mamelodi Campus, this 
area has been a study of investigation for many 
faculties over the years. 

The spatial consequences of architecture on the 
educational ecosystem are questioned, with focus 
placed on the shift in the learning environment 
towards lifelong learning. The dissertation deals 
with this concept from the perspective of the 
holistic development of a person through the 
qualitative social activities of learning. 

Lifelong learning is explored throughout the 
dissertation from a spatial and non-spatial point 
of view. The spatial conversation deals with the 
intersection between architecture and education, 
whilst the non-spatial conversation advocates for a 
relationship between a community and its school, 
as integral in achieving lifelong learning. 
The study is grounded in a typological 
understanding of the schooling environment that 
arises as a result of South African educational 
policy documents. A critical stance is taken where 

the resulting school typology is challenged in 
relation to context. 

The intention is to redefine the current teacher-
centric classroom and corridor typology.  It is 
proposed that the schooling environment should 
be publicly redefined and serve as a support 
structure within its context, instead of isolating 
the educational experience. This is explored 
through the concepts of building as a boundary 
and building for pedagogy with the resulting 
development of a spatial matrix to provide 
architectural definition to South African educational 
policy. 

Tsako Thabo Secondary School was used as 
a case study school for the application of the 
matrix principles, however it is intended that the 
developed principles could be applied to other 
schools within similar contexts and typologies to 
achieve lifelong learning potential. 

Both the research and design process of the 
dissertation has been directed through the lens 
of Participatory Action Research (PAR) involving 
co-design and spatial agency theories. Particular 
focus within the co-design process was given to 
the development of design games as a mediation 
tool. An intimate use of both analogue and digital 
design games has been applied throughout. 
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Understanding the role of architecture on the 
educational ecosystem has been an ongoing topic 
of investigation within postgraduate studies in 
the Department of Architecture at the University 
of Pretoria for several years. Through the Unit of 
Urban Citizenship studio, within the Department, 
Mamelodi East has been the site of investigation 
for this topic. Research has been conducted 
within this area since 2017, however personal 
involvement within this field began in 2019 
(Honours year) and continued into 2020 (Masters 
year).

Multiple postgraduate students within the studio 
have continued conducting research under the 
studio’s research and architectural philosophies. 
Due to this common ground, this document is 
presented in two volumes. 

The first volume contains a selection of co-
authored chapters compiled by Professional 
Master  of Architecture students from 
the Department of Architecture, Lauren 
Konstantinou and Kelsey Smith and myself, Purll 
Naidoo.

These chapters introduce:

•	 us as students
•	 our reasons for working within the educational 

ecosystem and its relevance to architectural 
discourse 

•	 the context of Mamelodi East and the case 
study school

•	 the studios research and architectural 
approach that has been followed 

•	 our involvement in a National Research 
Foundation (NRF) project that resulted in the 
collaborative development and application of 
a research methodology to capture qualitative 
data. 

This volume one serves as an introduction and 
foundation for volume two which has been 
individually authored and directed towards the 
specific themes dealt with by each student. 

Volume two continues to question the 
spatial consequences of architecture on the 
educational ecosystem, with particular emphasis 
placed on the shift in the learning environment 
towards lifelong learning. 

Lifelong learning is positioned within the 
dissertation as the qualitative social activity of 
learning that contributes towards a person’s 
holistic development. This volume intimately 
deals with the spatial (tangible) and non-spatial 
(intangible) conversations surrounding education: 
an understanding of pedagogical typology 
(spatial conversation) as well as the importance 
of a community-school relationship (non-spatial 
conversation) in encouraging lifelong learning 
potential. 
These two topics have been investigated through 
the lens of the South African educational policy 
for public school infrastructure, to understand the 
role that policy has on the resulting public school 
typology. 

The intention of the dissertation is to develop 
the limited architectural language within current 
schooling policy and to align the educational built 
environment with the South African government’s 
intention to promote lifelong learning for its 
people. 

This volume is structured according to:

•	 an introductory chapter to ground the study
•	 a literature review and data collected on site 

using the studio’s research and architectural 
methodology

•	 a reflective chapter on the use of analogue and 
digital design games as a mediating tool in the 
co-design process

•	 a design development chapter focusing on the 
creation of a spatial matrix for policy

•	 technical development chapter 
•	 a reflective chapter illustrating the developed 

spatial matrix and its application to the case 
study school. 
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Herewith lies our discovered passion,  
Wherein we hope to inspire like-minded 
creatives.

“Architecture is about people, [...] it can do 
more than we expect.” - Francis Kéré  

Agents of change,
Kelsey, Lauren & Purll 
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MCLC: (Mamelodi Community of Learning 
Collaborative) Through the University of 
Pretoria (UP) Mamelodi Campus, the university 
has engaged with multiple community 
upliftment projects. The MCLC is funded by 
the Kresge Foundation. 

Educational Ecosystem: a concept through 
which there is a large focus on the educational 
sector of a community, identifying and 
understanding the interrelationships between 
stakeholders and how these can be enhanced 
in order to uplift the educational quality of the 
community as a whole. 

UUC: (Unit for Urban Citizenship) Within 
the Department of Architecture, this unit 
involves agents of change, engaging deeply 
with under-served communities through 
participatory-based projects. 

Tsako Thabo Secondary School: Part of 
the MCLC’s effort to uplift the educational 
ecosystem within Mamelodi East. The principal 
is Mr Clement Gama who has worked closely 
with us during the participatory process of 
both 2019 and 2020. 

JCP: Community engagement course that 
makes provision for university funded 
community service projects to be completed 
by undergraduate students in the EBIT faculty 
during their second year of study.

GLOSSARY 

STINT: National Research Foundation project 
titled, Stitching the city: From micro-data to 
macro-views (STINT), aimed at establishing a 
“transdisciplinary collaboration” to develop a 
methodology for collecting and sharing non-
traditional types of information, on a digitized 
platform.

STEM & STEAM: approach to learning and 
development that integrates the areas of 
Science, Technology, Engineering and 
Mathematics. STEAM was recently created to 
incorporate the Arts as well, to ensure an all-
rounded and inclusive educational system. 

PAR: (Participatory Action Research) An 
approach to investigation that involves 
participants and researchers working together 
in order to uncover issues and solutions within 
a community or topic. 

ukuDoba Method: A methodological 
framework that has been developed for the 
collection and sharing of non-traditional types 
of spatial and socioeconomic data at a street 
and precinct level in an online platform. All 
three researchers were actively involved in 
the creation of this method. 



Chapter One

INTRODUCTION



01
CHAPTER
Introduction



38 39Volume One  |  Introduction

This document is inclusive in three mini-
dissertations in the professional Master of 
Architecture degree in the Department of 
Architecture at the University of Pretoria: Lauren 
Konstantinou, Purll Naidoo and Kelsey Smith. We 
have collectively been a part of the University of 
Pretoria’s (UP) Unit for Urban Citizenship, in the 
Department of Architecture, since our Honours 
year in 2019. As part of our involvement, we have 
engaged with the topic of investigating the spatial 
consequences of the architectural discipline on the 
educational ecosystem, through the approach of 
the Unit for Urban Citizenship. This engagement 
began in 2019 and occurred over the year within 
Mamelodi East, as a collaboration with the 
Mamelodi Community of Learning Collaborative 
(MCLC). This resulted in a focused study of 
Tsako Thabo Secondary School and a continued 
collaboration into the 2020 Master’s year. 

The 2019 experience highlighted the power of 
alternative architectural processes and the depth 
that can be added to a project when engaging in 
participatory design methods.  There is a desire 

and need, within us, to challenge conventional 
architectural processes by focusing on the end-
users as knowledgeable and tangible assets to 
design projects. We were all captivated by our 
experience during the 2019 Honours year and 
sought to continue our engagement in the Master’s 
year, 2020. Due to our common foundation 
and architectural approach, we have closely 
collaborated during the Master’s year. As an 
outline, each researcher’s dissertation is made up 
of two parts (Fig. 01): Volume One being the co-
authored chapters and Volume Two outlining our 
individually authored chapters. Volume One of this 
dissertation document engages in our collective 
experience and foundation that contributed to our 
individually focused chapters in Volume Two. 

Our research methods and architectural 
approach to the dissertation are influenced by 
our involvement in the Unit for Urban Citizenship 
(UUC). The UUC is a collaboration within the 
Department of Architecture and is currently 
headed by Dr. Carin Combrinck. Both students and 
staff from the department form part of the UUC, 

01
INTRODUCTION

as well as identified community members who are 
integral to the success of the unit. 

The unit is intended to be used as a platform for 
civic engagement and participatory development 
within disadvantaged communities. This is done 
in an effort to gain real-world understanding 
and result in community upliftment (Kilfoil 2019). 
The particular research method, carried out in 
each dissertation, is the outcome of the unit’s 
involvement in a National Research Foundation 
(NRF) project, titled ‘Stitching the City” (STINT). This 
project is a joint effort between the University of 
Pretoria in South Africa and Chalmers University 
in Gothenburg, Sweden. All three researchers 
were integral to the research project from 2019 to 
2020 (See appendix A) and contributed towards 
the development of the ukuDoba Method, a 
methodology for both data collection and sharing 
on an easily accessible digital platform. Together 
with the ukuDoba research method (See appendix 
B), participatory design processes are integral 
to the approach of the unit, therefore all three 
dissertations place particular emphasis on this in 

Fig. 01. Dissertation Structure Division (Authors 2020) 

the design process. 
From the start, we set out to change the way we 
tackle the architectural discourse at UP from a 
Master’s point of view. We intended to actively 
engage with our participants, site, community 
members, architectural professionals and peers 
as well as to be part of a movement of students 
who actively challenge the standardized process 
of a Master of Architecture (Professional) degree. 
We started the year with the intention of adapting 
the prescribed design format of the Master’s 
year-end exam. This included hosting a winter 
studio in July that would involve a live-build in 
partnership with the community and other active 
participants in our respective projects. The 
winter studio was to be implemented so that 
a part of our designs could be physically built 
and form part of our technical resolution and 
design outcome for our dissertations. This was to 
extend and consciously involve ourselves in the 
participatory design process. Due to the nature of 
the COVID-19 pandemic and lockdown restrictions 
within the country, the possibility of a live-build 
was short-lived. Our shift in thinking happened 
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immediately concerning producing a piece of work 
that could still possibly be executed in smaller 
increments and thus contribute to potential future 
implementation. 

The end goal remains for us to be proactive in 
developing platforms and ways of engaging the 
end-user under any given circumstance. COVID-19 
has posed its set of challenges regarding 
interaction and design development regarding 
participatory design processes. The impact of 
the circumstances surrounding this pandemic 
has been inevitably consequential to our design 
process. However, it has encouraged us to think 
out of the box while remaining in the box more 
so than ever. Most importantly it has challenged 
us, as researchers and designers, to become 
resilient in our architectural approach. To ensure 
that, even when obstacles present themselves, 
we are still able to adapt and ground ourselves in 
our approach, instead of accepting the traditional 
approach to architecture. The pandemic has also 
shed light and caused reflection on the outcome 
of our designs and the role we play as designers 
going forward into our careers as young architects. 

Collectively we adjusted to online engagement 
to continue our paths and include participants in 
the design development process. Our resilience 
as researchers and designers has remained intact 
throughout our journey to obtain our Master of 
Architecture (Professional) degree and we have 
continued and will continue to learn and adapt 
along the way.

The following information provides the foundation 
for our three dissertation topics. Lauren 
Konstantinou’s study has a focus on the spatial 
decentralization of music-making as a platform 
for positive self-expression to enhance collective 
community identities. Purll Naidoo considers the 
redefinition of South African government school 
typologies to encourage lifelong learning potential 
and Kelsey Smith explores the role of architecture 
and its intersection with food sovereignty in an 
attempt to rehabilitate secondary school feeding 
schemes within South Africa. Overall, we hope 
that Volume One of this dissertation document will 
provide a deeper understanding of the context we 
are engaging with, our approach to architecture 
and rationale for our individual dissertations. 
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02
BACKGROUND

2.1 Educational Ecosystem 

It was Nelson Mandela who declared that 
“Education is the most powerful weapon which 
you can use to change the world” (Mandela 
2003). To equip children with an engine for 
development (Mandela 2007) is to equip them with 
the knowledge and practical learning to maintain a 
sustainable life.

The educational ecosystem (Fig. 02) is a 
concept in which there is a large focus on the 
education sector of a community (Kurshan 
2015).  “Ecosystems are defined by the network 
of interactions among organisms, and between 
organisms and their environment” (Mueller & 
Toutain 2015: 6), therefore when looking at the 
educational ecosystem it becomes important 
to understand the interrelationships within that 
environment. There has been a focus on education 
as a means to direct a cultural shift, where the 
school is seen as the medium for moulding the 
society we envision. It is recognised that an 
effective educational ecosystem is seen as a nodal 
point to connect people and to address societal 
challenges. However, even though it is recognised 
that our educational ecosystem has the largest 
impact on society, it, unfortunately, remains the 
most fragmented (Luksha et al. 2018). Real-world 
case studies, stakeholders and implementations 
are used to see how relationships between 
educational facilities can benefit “urban education 
environments” (Kurshan 2015). Within a well-

Fig. 02. Educational Ecosystem (Authors 2020)

functioning ecosystem, educational institutions 
have the opportunity to work together to improve 
the current curriculum, equip staff and teachers 
with more knowledge and skills, and create a more 
enhanced and engaging learning environment 
(Kilfoil 2019). Referring to the educational 
environment as an ecosystem is to understand 
the impact of educational institutions as nuclear 
agents. They have the capabilities of reinforcing 
existing and creating durable connections within 
networks in their context. For this reason, it 
becomes increasingly important to address the 
role of education within an ecosystemic context. 

As part of the United Nations (UN) Sustainable 
Development Goals (SDG), education is seen as 
a priority (Fig. 03). The vision of quality education 
for all is stressed as an important aspect in 
the development of better lives and social 
sustainability, by the year 2030 (United Nations 
2016). Education is a primary focus of the UN as 
it is essential to achieving numerous goals on the 
SDG list. Importantly, education is seen as the key 
to addressing the world’s poverty cycle. In the 

Fig. 03. Sustainable Development Goals (United Nations 2016)

same light that education is seen as a determining 
factor in achieving multiple SDG’s, it also functions 
widely within poverty-stricken areas. Schools 
serve, not only as a medium for knowledge transfer 
but are integral in the support they provide to 
learners and communities, such as the provision of 
a learners’ daily meal source (Peterson 2020). 

In 2020, the COVID-19 pandemic resulted in 
the temporary closure of schools across the 
majority of the world’s countries (United Nations 
2020). Specifically, within underprivileged and 
marginalized areas, the underlying issues of 
the current education system were suddenly 
exposed, both globally and locally (Carte Blanche 
2020; United Nations 2020). As stated by Basil 
Manuel from the National Professional Teachers’ 
Organisation of South Africa (NAPTOSA), in South 
Africa the nation-wide lockdown exposed and 
exaggerated the inequalities of the education 
system almost overnight. The issues discussed 
are particularly related to inclusivity, participation, 
equality and transformation (Peterson 2020). 
These issues proved that middle to upper-class 
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learners were able to continue their education 
through online platforms. However, those who are 
financially disadvantaged, could not. This stems 
from a general lack of technological knowledge 
and skills to the lack of finances to buy internet 
data or even print notes (Carte Blanche 2020; 
Peterson 2020). Parents are also often unable 
to help their children learn from home as in most 
households, their child is the first to go to school, 
leaving the rest of the family illiterate (Peterson 
2020). As the schools have closed, many are left 
without a safe learning environment to attend daily, 
resulting in increased stress and anxiety for both 
learners and parents (Peterson 2020). Exposing 
this significant gap in both the economy and 
the knowledge of these citizens truly highlights 
the importance of the evolution of the current 
education system. 

When engaging with the educational ecosystem 
it is important to be aware of the influence of 
STEM (Science, Technology, Engineering and 
Mathematics). Both globally and locally, the focus 
on STEM has a major influence on the educational 

ecosystem, in terms of curriculum. Since 2009, 
in South Africa, the subjects Mathematics and 
Science were seen to result in public schools 
being in a state of “national crisis” (Pols 2019). This 
affected the qualitative outcomes of scientists, 
engineers and health practitioners in the 
workforce. The concept of STEM was introduced 
into schools as a way to increase the critical 
thinking capacity of current school generations 
(White 2014), ultimately leading to a stronger 
workforce that is more employable, setting up 
South Africa’s society for success (World Economic 
Forum 2017). This would contribute to breaking 
the poverty, crime and unemployment cycle of 
underprivileged communities within the country 
(Pols 2019). 

However, there have been numerous debates 
and much research conducted regarding the 
addition of the arts into STEM to expand scientists’ 
knowledge from critical to humanitarian and 
empathetic (Lachman 2018). STEAM (Science, 
Technology, Engineering, Arts and Mathematics) 
education allows for learners to be critical and 

Fig. 04. STEM vs. STEAM (Authors 2020)

Fig. 06. Relation to Architecture (Authors 2020)

analytical while recognizing the personal, social 
and cultural potentials of what they are doing 
(Pienaar 2017) (Fig. 04). Such pedagogical methods 
align and challenge school curricular reform to 
challenge the current education model. 

Psychologically, this educational concept 
teaches learners self-expression, wider forms of 
criticism and ultimately helps to develop them 
for the working world where they would be more 
susceptible to taking risks and developing new 
ideas (Lachman 2018; Pienaar 2017). Initiatives 
such as Leap Science and Maths schools are a 
chain of non-fee paying schools that aim at offering 
quality education to underprivileged, low-income 
communities. Sustainable models like these are 
imperative to empowering people as they focus on 
the fostering of learners’ cultural and communal 
identity while ultimately creating a pathway to 
future employment (LEAP 2017). Robinson (2010) 
emphasizes that schools are currently failing 
to acknowledge and encourage multiple types 
of intelligence. He states that the traditional 
standardization of education needs to be revised 
to develop the youth’s ability for creative and 
practical thinking. This type of curriculum change 
impacts the educational ecosystem by allowing 
more opportunities for the inclusivity of all 
students, not only those that fit the critical-thinkers 
mould. As designers and researchers, this is 
the standpoint from which we approached the 
educational ecosystem. Robinson (2010) highlights 
that the future of our economy is dependent on 
innovation and a person’s ability to anticipate 
future concerns and have the skills and capability 
to implement solutions. This way of learning 

encourages students to engage realistically with 
skills that will help them sustain their lives in the 
future (Carson 2016). 

Within the educational ecosystem, it is crucial to 
understand the relationship between people and 
their environments and to engage in how/why 
these relationships are created and exist (Mueller 
& Toutain 2015: 8) (Fig. 05). An understanding 
of these relationships is crucial to inform our 
approach as designers. As designers and 
researchers with a major interest in developing 
social cohesion within communities, the 
educational ecosystem becomes a significant 
influence on design considerations. This is due 
to thinking beyond the case of standard systems 
within a community, but rather considering a 
number of deeper and interconnected themes that 
accumulate and influence the way communities 
work. It is about looking beyond surface 
observations and engaging in uncovering the 
social interrelations making up a community. 

2.2 Relation to Architecture

The importance of addressing the educational 
ecosystem has already been established across 

Fig. 05. Interrelation Between People and Their Environments 
(Authors 2020)

various disciplines. However, as designers and 
researchers within the architectural discipline, 
we must ask ourselves how we can contribute to 
educational ecosystem discourse. The educational 
ecosystem has largely been discussed from a 
non-spatial point of view, however, the role that 
architecture plays within that discussion is limited 
in comparison (Cleveland & Fisher 2013:1) (Fig. 
07). The spatial constructs of the educational 
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ecosystem affect a child’s ability to learn, however, 
the design consideration given to these learning 
environments is significantly under-developed 
(Higgins et al 2005). Our project motives align with 
the Action Plan towards schooling 2025 released 
by the Department of Basic Education (DBE) which 
focuses on giving priority to the wellbeing of the 
learner. Goal 24 emphasizes the need to “ensure 
that the physical infrastructure and environment 
of every school inspires learners to want to come 
to school and learn, and teachers to teach “(DBE 
2014).

One of the biggest challenges facing South 
Africa is the development and improvement of 
the knowledge and skills of its learners, primarily 
amongst disadvantaged and low-income sectors of 
the population (Albertyn 2015).
Although access to education has improved 
significantly since the educational reform in 1994, 
the equality of access does not yet translate to 
opportunity. According to Dr. Jonathon Clark, 
director of the Schools Development Unit and 
Schools Improvement Initiative at the University 
of Cape Town, the quality of learning outcomes 
has not escalated in parallel (Albertyn 2015). Clark 

states the importance of building a network of 
innovators and educators who are “like-minded 
change-makers”, who are actively willing to 
transform the educational ecosystem in South 
Africa to improve the quality of education. We see 
our dissertation proposals not only contributing 
to this network but also stretching its outlook to 
understand the impact of this type of architecture.

An ecosystem, in an academic environment, 
constructively frames the need for 
interdependency and sustainability. A schools’ 
functioning through a facility and built environment 
point of view, is a result of its infrastructure 
and resource management (NEIMS, 2014). The 
control and implementation of these elements 
allow for the creation of a safe and enabling 
learning environment. Networks are catalysts 
used to enhance knowledge as well as provide 
support for innovators. A shift in paradigm that 
fosters an educational ecosystem is necessary 
to advocate for education that is facilitated by 
a network of teachers. Educators are lifelong 
learners, so to improve learning, the commitment 
to educator development is crucial. Our research 
and dissertations unpack key educators and 

Fig. 07. Non-Spatial and Spatial Contribution (Authors 2020) Fig. 08. Educational Ecosystem Collaborators (Authors 2020)

knowledge innovators in the community that form 
part of a larger educational ecosystem used as 
part of lifelong learning within the schools, as well 
as the surrounding communities (Albertyn 2015) 
(Fig. 08).

Through investigating the relationship between 
architecture and education with specific relation 
to our case study, Tsako Thabo, we found a 
need to go further into exploration and design, 
to create a significant change in the education 
environment. This can often be perceived as 
a place that is confining and static. Herman 
Hertzberger (2008:169) unpacks this concept 
further when he discusses the culmination of 
multiple schools within a neighborhood mutually 
benefiting from their shared resources. Bringing 
together multiple schools, all of which have 
different aspects to add to the success of the 
ecosystem, results in flexibility, social cohesion and 
saving of funds (Hertzberger 2008). The learning 
between the schools becomes far more inclusive 
for all. Through an architectural lens, to contribute 
towards a well-functioning educational ecosystem, 
“new, more stimulating spatial conditions and 
forms” need to be considered (Hertzberger Fig. 09. Tsako Thabo (Naidoo 2019)

2008: 57). Our dissertations serve to contribute 
to that discussion and engage in the impact of 
architecture on the educational ecosystem. 
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Fig. 10. Tsako Thabo (Naidoo 2019)

Fig. 11. Tsako Thabo (Naidoo 2019)

Fig. 12. Mamelodi (Naidoo 2019)
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3.1 Mamelodi Community of Learning 
Collaborative 

The following chapter provides the foundation for 
the contextual understanding of the dissertations. 
Our dissertations are based within the context of 
Mamelodi East, where the University of Pretoria’s 
Mamelodi Campus serves as an anchor institution. 
As such, the Campus has increased its awareness 
of the role it plays within its context by contributing 
to overall community upliftment and individual 
student success within schools (Kilfoil 2019). The 
Campus has engaged in multiple community 
projects within Mamelodi since 2008 (Ogude 
2019). These projects are conducted in an effort 
to uplift the community as a whole and to socially, 
academically and economically impact the larger 
society of South Africa. 

A relationship was established between the UP 
Mamelodi Campus and Rutgers University in 
Newark, United States, when the universities 
recognised that their ambitions, as anchor 

institutions within their contexts, aligned. An 
outcome of this relationship is the Collaborative 
of Learning Community (CLC), funded through 
the support of the Kresge Foundation. In 2017, 
the initiatives were officially founded in both 
Newark (NCLC) and Mamelodi (MCLC) (Ogude 
2019). The involvement of the MCLC is influential 
within the dissertations. The MCLC is composed of 
numerous faculties within UP, each investigating 
the educational ecosystem from the perspective 
of their discipline. The collaborative has identified 
key partners within the Mamelodi educational 
ecosystem to engage with, including Early 
Childhood Development centres (ECDs), Primary 
and Secondary schools as well as the local and 
provincial departments of Basic Education. Tsako 
Thabo Secondary stood out within this selection 
of partners due to the growing relationship the 
university has with its principal and MCLC member, 
Mr. Clement Gama. The school has been open to 
engaging with the university and its students and 
is, therefore, a significant collaborating partner. 

The Department of Architecture, within the 
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Engineering, Built Environment and Information 
Technology (EBIT) Faculty is represented in the 
MCLC through the Unit for Urban Citizenship 
(UUC). The Unit’s contribution to the collaborative 
is to investigate the educational ecosystem within 
Mamelodi from the perspective of the architectural 
discipline. Numerous projects undertaken within 
the Unit have contributed to our spatial knowledge 
database of Mamelodi’s educational ecosystem. 
Throughout the Unit’s investigations, smaller nodes 
of activity are recognized as active educational 
nodes that could potentially contribute to a lifelong 
learning process within the community.

The MCLC actively intends to contribute to 
its hyper-local context. As part of its initiative, 
the collaborative is also involved in the Joint 
Community Project module (JCP), situated within 
the EBIT Faculty. This course makes provision for 
University-funded community service projects to 
be completed by undergraduate students in the 
EBIT faculty during their second year of study. 
The volume of these students makes this course 
a powerful tool within community action initiatives. 

Many schools in the Mamelodi East community 
have collaborated with students from the JCP 
course. Tsako Thabo is amongst the schools to 
have received support from these projects, in 
the form of personal protective equipment (PPE) 
to maintain health standards for the reopening 
post-2020 COVID-19 lockdown. Due to our long 
involvement in Mamelodi, we have become 
acquainted with pressing areas of concern that 
have the potential to be addressed through the 
JCP course. Using this knowledge, we intend to 
produce directed JCP project briefs for students to 
undertake at Tsako Thabo. 

3.2 Mamelodi East 

The MCLC provided the direction towards the 
township of Mamelodi East in the City of Tshwane 
as our context for the investigation. This township 
was formed during the Apartheid regime for the 
African population in 1945 (van der Waal 2000). 
Like most disadvantaged communities in South 
Africa, this settlement has a history of government 
neglect and social struggle. The oldest part of 

Fig. 13. MCLC Diagram (Authors 2020)
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Mamelodi runs along Tsamaya Road and the 
Moretele River (van der Waal 2000), including the 
area surrounding the case study school. 

The UUC has been actively involved in 
investigating the spatial qualities of the 
educational ecosystem in Mamelodi East since 
2017. Our engagement began in February 2019. 
The following timeline sets out our period of 
involvement.  

In 2019, the following themes were uncovered 
through the participatory process of mapping 
conducted by the UUC Bachelor of Architecture 
Honours group:

Routes: pedestrian access and movement in terms 
of safety and trade (Du Bois and Mulder 2019) (Fig. 
18, 19 & 20)
Recreation: sports as a platform for social cohesion 
and ownership (Ras 2019) (Fig. 21)
Social capital: relationships and networking that 
strengthen the community (vd Hoven 2019) 
Food culture: informal and formal distribution of 

food (Smith 2019) (Fig. 22 & 23)
Informal Economy: the value of trade and trends of 
income (Mlambo 2019)
Education typologies: quality of school typologies 
and the impact on education (Achi 2019)  (Fig. 24 & 
25)
Cultural aspects: social cohesion through music, 
dance and the arts (Konstantinou 2019) (Fig. 26 & 
27)
Sacred space: understanding ownership and 
the role sacred space has within the community 
(Motshabi & Naidoo 2019) (Fig. 28)

These themes were all thoroughly unpacked 
through mapping, unstructured interviews, 
community action planning and participatory 
sessions. This information moved beyond the 
surface of simple observation and assisted in our 
directed understanding of the context we are 
dealing with. 

All data accumulated over the period, as indicated 
in the timeline above, has formed a database 
of information for our dissertations. The type 

Fig. 14. Mamelodi Context Map (Authors 2020)

of information mapped and recorded includes 
patterns of movement, the evolution of the space 
over the years, activity and program mapping as 
well as public and private space indicators. 

To better understand architecture and the story 
we are trying to tell, we have to contextualize the 
environment, the people and the process. These 
elements involved in our research have influenced 

Fig. 16. Mamelodi Context (Honours 2019)

our perspective on the community itself and 
provided us with insightful knowledge on how 
certain systems, groups and programs function. 
We have had the privilege to work in and with such 
a culturally rich community who’s potential and 
passions have remained the drivers during our 
process of development. 

Fig. 15. Mamelodi Transect Walk (Honours 2019) Fig. 17. Mamelodi Context (Honours 2019)
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Fig. 18. Pedestrian Routes Mapping 
(Authors 2020)
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Fig. 19. Vehicular Routes Mapping 
(Authors 2020)
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Fig. 20. Safety Mapping (Authors 
2020)
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Fig. 21. Recreational Mapping 
(Authors 2020)
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Fig. 21. Recreational Mapping 
(Authors 2020)

Fig. 22. Food Culture Khalambazo 
Mapping (Authors 2020)
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Fig. 23. Food Culture Tsako Thabo 
Mapping (Authors 2020)
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Fig. 24. School Typologies 
Mapping (Authors 2020)
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Fig. 25. Classroom Typologies 
Mapping (Authors 2020) 
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Fig. 26. Cultural Aspects Mamelodi 
Mapping (Authors 2020)
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Fig. 27. Cultural Aspects Tsako 
Thabo Mapping (Authors 2020) 
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Fig. 28. Sacred Space Mapping 
(Authors 2020) 
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3.3 Tsako Thabo as a Case Study

Due to the relationship with the MCLC and 
the open engagement with UP, Tsako Thabo 
Secondary School was identified as a base case 
study for our dissertations. The intensive mapping 
conducted within Mamelodi East provided us with 
contextual grounding for our investigation into the 
school. Thereafter, the school provided a platform 
to observe, investigate and explore the current 
educational ecosystem within Mamelodi East. It 
was the foundation for identifying opportunities 
for an expansive educational network that could 
empower and contribute to the community.

At a postgraduate level, UUC architecture 
students have worked closely with Tsako Thabo 
Secondary School, since 2019 (Kilfoil 2019). The 
school is currently used as the anchor node for 
postgraduate architecture studies within the UUC. 
These students actively engaged within the school 
and the surrounding community, where school 
learners and community members participated 
in intensive mapping and participatory research. 
This methodology was a part of the process that 
resulted in community action planning strategies, 
urban visions and responsive architectural 
interventions (Kilfoil 2019). 

Our personal involvement with the school began 
with our introduction to Mamelodi East, in 2019. 
From an introduction session with the current 
principal, Mr. Clement Gama, a brief overview of 
the school was conducted: 

“The aim of the school is to be all-inclusive, 
however, it is difficult as the staff is not equipped 
or trained to do so. [...] They have the number one 
volleyball team in Tshwane but use the community 
hall to practice (not the school). Their goal is to 
have a proper art studio. [...] [The school] was built 
in 1981 in a train layout. Now it looks more like a 
jail because it has been fortified [due to the many 
break ins]. People steal metal (cooking pots, chairs, 
etc.), electronics and food. [...] There are eight or 
nine unused classrooms that could be used for 
other [community] activities. This is a good idea 
as community centres are far from this area. [...] 
There is a direct correlation between doing well in 
school and attendance (influenced by the parent’s 
input). Parents try to live their dreams through their 

children and give pressure in the wrong areas 
(therefore kids don’t enjoy school). However, 
most parents of the school are not involved (e.g. 
parent’s associations)” (Personal notes during 2019 
introduction by L. Konstantinou).

Thereafter, we carried out intensive participatory 
research at the school. Previous engagements 
with students in the school ranged across a wide 
variety of themes. 

Focusing on sport and the current facilities, 
”Students of the volleyball team, in particular, 
are extremely proud and their involvement in the 
sport is a constant grounding and motivator to 
them” (Personal notes during 2019 introduction 
by R. Ras). Music focused workshops also took 
place within the corridors of the school, “the 
melodies generated from these participants 
were so evident of their passion and zest for life 
and clearly illustrates the power music instills 
for social inclusion” (Personal notes during 2019 
introduction by L. Konstantinou). Food Sovereignty 
was unpacked through design activities involving 
the students interacting in games that illustrated 
what food types and proportions are consumed 
daily [...] “ Entrepreneurial activities of food selling 
ignited negotiators and good sales people within 
the participant group” and kitchen conversations 
were welcomed by the kitchen staff as they 
prepared lunch daily (Personal notes during 2019 
introduction by K. Smith). Transect walks in and 
around the school led by the students provided 
a perspective of the unseen activity that exists 
between transition times within the school…...
(Personal notes during 2019 introduction by P. 
Naidoo).

The Mamelodi East mapping as well as the 
collected sources of information from the above 
formed the basis for our dissertations. With this 
information we hoped to layer on our specific 
dissertation focus through our 2020 participatory 
action research (discussed in volume 2 of our 
individual dissertations), to inform our design 
interventions that are rooted in the school’s ethos 
and are catalytic contributors to the school and 
surrounding community. 

As a primary participant target group, the 
dissertations focused on high school learners, 
between the ages of 13 and 20, that attend Tsako Fig. 29. Tsako Thabo as a Case Study (Honours 2019)
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Thabo Secondary School.  Each of the student 
participants was specifically identified through the 
Honours mapping of 2019, through unstructured 
interviews and word of mouth through social 
groups within the school. Within our individual 
dissertations, we have expanded on this focused 
target group to include participants related 
specifically to our dissertation topics. It is important 
to note that due to each researchers’ specific topic 
and the COVID-19 nation-wide lockdown of 2020, 
additional participants from other schools and 
elsewhere, were identified to partake in certain 
stages of the research and design. 

From observations, mappings and analysis done 
over the last few years within Mamelodi East, a 
common spatial language was found between 
most schools in the area (Achi & Venter 2019). This 
is specifically related to their social context and 
built form. Although our dissertations are based 
at Tsako Thabo, it is important to note that we 
intend to not spatially resolve surfaced issues at 
a single school. Tsako Thabo Secondary School 
has been used as a case study to represent other 
schools in Mamelodi East. Although each school 
still has its unique characteristics, issues and 
opportunities, Tsako Thabo has been used as 
a basis to understand and test the researchers’ 
solutions through proposed design interventions. 
These proposals are then not limited to the school 
and can be proposed for other schools across the 
area, addressing similar social issues. We intend 
that the lessons learned, information captured and 
designs developed, through our dissertations, will 
contribute to the knowledge base for addressing 
similar issues existing within our country and even 
globally. 
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4.1 Unit for Urban Citizenship

The Unit for Urban Citizenship (UUC) has provided 
a much-needed platform, within the University 
of Pretoria’s (UP) Department of Architecture, to 
challenge conventional architectural discourse. 
It was once run as a studio within our Honours 
year in 2019 (Fig. 30) but has grown in recognition 
within the Department, in 2020. Urban Citizenship 
is now one of the three research fields in 
the department (Fig. 31), along with Heritage 
and Cultural Landscapes and Environmental 
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Fig. 31. UUC Programme Development (Authors 2020)

Fig. 30. Qualitative Research at Tsako Thabo (Konstantinou 
2019)

Potential. During the Unit’s introduction session, 
a question was posed to the staff and students 
of the department to construct a collaborative 
description of what it meant to be an “Urban 
Citizen”. Collectively the “Urban Citizen” was 
described to be an agent of change, who strives 
to create sustainable relationships and maintain 
unity through diversity and social inclusion. The 
studio is run by urban citizenship enthusiast Dr. 
Carin Combrinck, who currently oversees both the 
Honours and Master’s Programmes in Architecture 
at UP. Dr. Combrinck’s active involvement in 
community-driven projects, engagement in 
the MCLC and passion for urban citizenship 
contributed to the foundation of the unit. The 
impact of the UUC is not isolated to postgraduate 
approaches to architecture. It has influenced all 
years within the architecture department, from 
small scale modules in undergraduate years to 
full-scale studios at a postgraduate level. UUC has 

been the driving force for our dissertations and 
has provided the foundation for our research and 
architectural approach. Urban Citizenship values 
the diversity of people, cultures and environments 
and aims at encouraging citizen participation 
throughout the design process to establish a 
framework for architecture that is inclusive and 
empowering to the user. 
					   

4.2 Research Approach 

Due to the nature of the UUC, the approach to our 
research was through the interpretive paradigm 
by collecting and analyzing qualitative data of the 
real-world context of Mamelodi East. Our particular 
focus was on participatory action research (PAR) 
to expand the discourse of architecture. PAR 
allowed for the process of analysis and critical 
reflection to happen simultaneously at intervals 
throughout the design and engagement phase. 

Fig. 32. Qualitative Research at Tsako Thabo (du Bois 2019) 
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The research approach values diversity and is 
focused on positive social change as an outcome 
(Macbeth 2020). It constantly kept us grounded 
on the basis to create greater awareness for 
citizen participation to address issues with a 
greater sense of agency (Awan et al. 2011). The 
spatial agency defines the process as working 
at the intersections between the individual and 
the collective, the virtual and reality realm (Awan 
et al. 2011). Qualitative data collection has been 
integral to our PAR approach. Collecting qualitative 
data allowed us to study end-users’ lives from a 
direct and engaged perspective within their own 
environments, resulting in contextually relevant 
data sets. This represented the real-life views 
of the people who would directly be affected by 
the research conducted (Merriam 2009, Yin 2011) 
and the potential outcomes that the dissertations 
posed. This method is supported by professionals, 
researchers and creatives that use collaborative 
design strategies from a conceptual approach to 

the tangible outcome phase.  

Mapping and unpacking qualitative data allow 
researchers to contribute to existing and 
current emerging ideas within the human social 
environment. This allows for trends to be noticed 
and certain events to be explained through 
existing social concepts (Yin 2011). 

It is vital for researchers to be completely 
transparent with their methodologies when taking 
a qualitative approach. This is necessary for future 
researchers to contribute to the data or test the 
mapped trends for credibility (Merriam 2009, Yin 
2011). To do this, analysis of data must be taken 
from a grounded framework that allows focused 
reflection and removes the researcher’s personal 
bias (Merriam 2009, Yin 2011). Describing fieldwork 
should also show that the researcher was “really 
and fully present - physically, cognitively and 
emotionally” (Yin 2011: 574). Using the actual 

Fig. 33. Qualitative Research at Tsako Thabo (Greyling 2019)

Fig. 34. UUC Studio (Unknown 2019) 
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Fig. 35. Qualitative Research at Tsako Thabo (Greyling 2019)

Fig. 36. Qualitative Research in Mamelodi East (Combrinck 2020)

language quoted in interviews and collecting data 
from multiple sources aids in finding patterns and 
contradictions which ultimately strengthen the 
credibility and value of qualitative research (Yin 
2011).

Through our engagement in the context of 
Mamelodi East over the two years, qualitative 
research was conducted through fieldwork 
observations, interviews and engaging 
conversations (Yin 2011). Our process was 
incremental and built up our qualitative data sets 
through a series of interactions with the context. 
Firstly, we documented our first impressions 
through our observations of the site. This set 
up our biased opinion which was important 
to reflect upon once we accumulated richer 
information. Thereafter, we conducted transect 
walks with community members to gather an 
educated outlook on the context and to assist us 
in organising our first impressions of the site. Once 
this was done, we moved onto semi-structured and 
formal interviews for more background information 
on our observations, as well as the intangible 
information we missed (Hamdi 2010:69). This type 
of data collection involved asking, watching and 
reviewing (Wolcott 1992). Data that was collected 
in the field was run in parallel with desktop data 
collection of literature and case studies (Merriam 
2009). All of these data sets helped develop 
a deeper understanding and discover insights 
relevant to our research problem. 

The collective processes and data resulted in the 
development of the Ukudoba Method, further 
described in chapter 5, which serves as our 
research methodology for our dissertations.

It is important to acknowledge that this type of 
research is only based on a sample of people 
within the area the researcher is investigating. 
It does not represent all extents of the issue 
uncovered but allows for future addition and 
comparison of research and trends (Yin 2011). 

4.3. Design Approach 

As architects, we use design to unpack, 
understand, translate and address issues and 
opportunities. However, this process is usually 
biased to the individual outlook of the design 
practitioner. The process of design starts to 

evolve when the emphasis is placed on certain 
characteristics of design thinking methods and 
tools. Our particular focus on design was through 
the processes of co-design. Co-design explores 
a parallel narrative that emphasizes engagement 
and collaboration. Within the design thinking 
process, this method of engagement favours 
participatory involvement throughout the design 
process, from the discovery of the project to the 
delivery of a solution (Muller 2002, Steen et. al 
2007). This collective nature often includes a 
variety of stakeholders and participants involved 
in the design process, from design practitioners to 
end-users (Zamenopoulos et al. 2018). Involving 
the end-user in the design process is an integral 
part of effective and efficient design decision-
making (Hamdi 2010). Co-design encourages user 
participation and aids in transferring the power of 
decision-making from design practitioners, who 
traditionally have it, to the affected marginalized 
target group within society. It is acknowledged that 
every participant around the co-design table holds 
tacit knowledge, integral to the success of the 
project. Vital contributions from the marginalized 
group result in higher quality outputs (Ehn 1993, 
Schuler et. al 1993, Spinuzzi 2005) that are socially 
inclusive and able to live beyond the years of the 
project development. 

Co-design contributes to the design process 
as well as the lives of the participants involved. 
The methods are aimed at a specific context 
and require the input of spatial agents through 
citizen participation. It uses participatory action 
research to mediate and facilitate the process of 
engagement, knowledge sharing and problem-
solving. The hope is to create a collaborative 
approach that democratizes societies and 
allows citizens to take ownership and control of 
their environment (Zamenopoulos et al. 2018). 
Participants benefit from this approach through 
social interaction and developing a sense of 
community, through shared values and interests 
(King 1983). It provides citizen attachment to 
the particular site of investigation within the 
community, inspiring action and motivation to 
protect and improve the location at an individual 
and community scale (Sanoff 2011). 

Professor Nabeel Hamdi, along with other key 
theorists advocating for co-design processes, 
has impacted our positioning as researchers. 
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These theorists move away from the traditional 
approach to design and suggest “other ways of 
doing architecture” (Awan et. al 2011). Co-design 
moves towards socially engaging architecture. This 
alternative approach aims to use architecture to 
uncover existing potentials within communities that 
can be harnessed for upliftment overall and act 
as mediators to improve the conditions, wellbeing 
and functioning of societies. Architecture becomes 
more about spatial agency and collaboration, 
focusing on the social implications of the built 
environment rather than the typical aesthetic and 
monetary value. Each individual’s interpretation of 
architecture is challenged and criticism is invited 
into the practitioner’s design process, resulting in 
constant iteration and reflection on the value of 
social architectural work (Spatial Agency Online 
n.d.). Hamdi focuses on “small-scale change at 
a grass-roots level” (Spatial Agency Online n.d.), 
where he aims to work with the given, having small 
changes over time that lead to agency and success 
in the long run, rather than a quick solution led 
from the outside. 

There are numerous methods to co-design 
engagement. Model building, sketching, writing, 
role-playing and design games are amongst the 
list of interactive and collaborative tools to mediate 
the co-design process between stakeholders, 
participants and designers. These are traditionally 
held face-to-face, to form relationships with one 
another (Kensing 2003, King 1983, Simonsen 
and Robertson 2013), that allows for mutual 
understanding and respect to create an open 
and supportive environment amongst the 
group (Markus and Mao 2000). As participatory 
researchers, we aimed to have multiple face-

Fig. 37. COVID-19 Impact (Authors 2020)

to-face participatory and co-design sessions. 
This would add to our co-design workshops 
that were conducted in our 2019 Honours year. 
However, due to the COVID-19 pandemic, our 
co-design methods were adjusted (Fig. 37). The 
circumstances of the pandemic, and the resulting 
country-wide lockdown, pushed the need for 
digital engagement to interact with participants 
and collaborate on the design development of 
our projects. These platforms and methods of 
engagement included websites, participatory 
games, conversational platforms and social media 
platforms to maintain our ability to co-design 
through social distancing restrictions. Having to 
adapt to changing circumstances widened our 
spectrum of co-design experience. Our varied 
engagement spoke to the resilience of co-
design discourse, as we were able to adapt our 
process along the way, without losing sight of the 
importance of collaboration. 

This method of collaborative design thinking 
challenges architectural discourse, particularly 
within our department. Co-design encourages 
the design practitioner to act as a spatial agent 
and to look beyond familiar contexts. It focuses 
on marginalized communities that are often 
discriminated against and deals with real-
life issues present within less fortunate, rural 
contexts (Zamenopoulos et al. 2018). As we 
are trying to challenge the current discourse, 
it is important to point out that small steps are 
required to incur big change. According to Hamdi 
(2010:19), “Clever projects have a small number 
of meaningful indicators”. Therefore, throughout 
our dissertations, co-design has been used at 
particular stages of our design processes to enrich 
a design response that is true to the context and 
community involved. 

4.4 Reflection

Layers of rich information were uncovered 
through our PAR approach within Mamelodi 
East, highlighting the untapped goldmine of 
opportunities for upliftment. Numerous qualitative 
data collection methods were tested throughout 
our process. Through reflection and iteration 
throughout the process, we were able to learn and 
grow in our understanding of how to efficiently and 
effectively approach participants during our limited 
time in the area. 

Due to the UUC’s continual engagement in 
Mamelodi East, layers of data had accumulated 
over the years (Fig. 38). Year after year students 
aimed at building on the previous years’ work 
to contribute to the existing data collected and 
to inform a richer design response. Amongst 
the data set, recurring themes and observations 
were presented, however, the storage of the 
data in unorganised folders on a Google DriveTM 
hindered access to the information. This made 
it difficult, during our dissertations, to collate the 
collected information and fully grasp the richness 
of the layered data. This stagnant method of data 
storage led to the need to change the format (later 
discussed in Chapter 5) and method in which we 
were capturing this intangible qualitative data, to 
assist future researchers.

Fig. 38. Continuous Data Collection (Authors 2020)
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Mamelodi East in the City of Tshwane, South Africa 
and Hammarkullen in Gothenburg, Sweden. 

Due to UP’s architecture Head of Department, 

5.1 STINT Research Project

In 2019 we were afforded the opportunity to be 
involved in a Departmental National Research 
Foundation (NRF) project. The NRF project titled, 
Stitching the City: From micro-data to macro-views 
(STINT), aimed at establishing a “transdisciplinary 
collaboration” to develop a “methodological 
framework and digital platform for the collection, 
storage, and sharing of spatial, socio-economic 
data at a street and precinct-level” (Roussou, 
Brandao, Adelfio & Thuvander 2019). The STINT 
project was a collaborative effort between 
the University of Pretoria (UP), South Africa 
(Departments of Architecture and GeoInformatics) 
and Chalmers University in Gothenburg, Sweden 
(Department of Architecture) from 2019 to 2020. 
In particular, the collaboration was between the 
Unit for Urban Citizenship (UUC) and the Social 
Inclusion Studio (SIS) from Chalmers University’s 
architecture department. For many years, both 
studios worked within similar contexts that were 
socially marginalised and segregated (Chalmers 
2018). The two contexts under investigation were 
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Fig. 39. Hammarkullen: First immersion walk (Konstantinou 
2019) 

Prof. Chrisna Du Plessis’ working relationship 
with members of SIS, this collaboration was 
born. To understand the complex layers of cities 
and communities of today, it is vital for multiple 
components of involvement, as a way to inform 
and shape the social and built environment 
(Roussou, Brandao, Adelfio & Thuvander 2019). 
University students routinely collected quantitative 
and qualitative data. Both studios found common 
ground in their methods of data collection. This 
took the form of visual and spatial data from 
immersive field research sessions. Over the years, 
this data revealed many significant trends and 
patterns related to the real-world context and use 
of the environments investigated. We shared in the 
issue that layers of rich data were being collected 
by students within both studios, critical to the 
holistic understanding of the contexts in question. 
However, this information piled up in printed 
notes or shared folders on an online server. These 
invaluable discoveries were lost due to the ad hoc 
storage of data in multiple formats. This made it 
increasingly difficult to effectively access, layer 
and share the collected data with decision-makers 
and the end-user to effect change. It became 
frustrating that the methods of data collection 
invoked static data storage methods. The STINT 
project was therefore developed in response to 
this common issue. 

Fig. 40. Hammarkullen: Analogue data collection from first 
immersion walk (Konstantinou 2019)

Fig. 41. Hammarkullen: Run-through of digital data collection 
methods using KoboToolboxTM   (Konstantinou 2019) 

The Department of GeoInformatics, at UP, 
involvement in the STINT/NRF project resulted 
in the creation of an online server (GeonodeTM), 
to store the collected data. This platform allows 
the digitalisation of collected information and 
the database will continue to develop for future 
endeavours. The information contributes to a 
large collaborative database and forms the basis 
for many design projects and research initiatives. 
The collaboration between the universities, allows 
the developed platform to be tested in two areas, 
to compare the effectiveness of the platform in 
capturing non-traditional data sets (Chalmers 
2018). Part of our involvement in this process was 
the testing of this through field research for our 
dissertations. 

Collectively, we needed to change the way data 
was collected, translated, stored and shared within 
our department, to make a greater contribution 
to society and research. By acknowledging these 
shortcomings and actively engaging in the STINT/
NRF project we collectively contributed to the 
development of a framework (ukuDoba Method). 
The framework allows non-traditional information 
types to be collected using digital and geospatial 
tools, thereafter, stored and shared on an online 
platform. It allows for local and global collaboration 
between researchers and designers on shared 
issues and similar contexts (ukuDoba manual 
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2020). The aim of collecting and sharing data of 
this nature is to allow informed and responsive 
urban and socio-economic transformation policies 
for future development (Chalmers 2018) and 
identification of contextually relevant development 
interventions. 

5.2. ukuDoba - The Methodological 
Framework

The ukuDoba Method was created from a 
collaboration between three Master of Architecture 
students from Chalmers University of Technology, 

Fig. 42. Hammarkullen: Social Inclusion Studio (Unknown 
2019)

Sweden (Robin Eskilsson, Mumtaheena Rifat and 
Markus Zorn) and three Master of Architecture 
students from the University of Pretoria, South 
Africa (Lauren Konstantinou, Purll Naidoo and 
Kelsey Smith). All authors were actively involved 
in the STINT/NRF research project and have 
a background in participatory design, social 
inclusion and urban citizenship within architecture. 
This background influenced the interest in the 
creation of the ukuDoba Method. In Zulu, the word 
ukuDoba means ‘fishing’. This methodological 
framework aims to assist users in ‘fishing’ for non-
traditional types of data that can be collectively 

Fig. 43. Pretoria: Digital Tool Analysis (Naidoo 2020)

stored, openly shared, layered over and analysed 
qualitatively over time. The ukuDoba Method was 
developed in response to the STINT/NRF project, 
to guide researchers, from various fields, in the 
methods of data collection and translation to 
efficiently store and access the data thereafter.

ukuDoba - the methodological framework, has 
been developed for the collection and sharing of 
non-traditional types of spatial and socioeconomic 
data at a street and precinct level in an online 
platform. Cross-disciplinary micro-data can 
be added over time and easily accessed by 
researchers from different disciplines as well as 
students and community members. This makes 
it susceptible to comparison and trend studies, 
as well as documenting the rich histories of 
communities. The developed methodology can 
eventually replace hard-copy storage that is limited 
in accessibility and fragmented in data. 

The UkuDoba method was developed through 
multiple trials and tests during the process of 
collaboration between the two universities. For 
the duration of the research project, two exchange 
trips were planned between the two contexts, 
to test the effectiveness of a digital method. 
The first exchange trip was hosted by the Social 
Inclusion Studio from Chalmers University in 
September 2019. The UP Masters students (Lauren 
Konstantinou, Purll Naidoo and Kelsey Smith) and 

supervisor (Dr. Carin Combrinck), involved in the 
project, travelled to Sweden intending to test the 
developed data storage platform (GeonodeTM) in 
Hammarkullen, Gothenburg. The platform was 
first tested according to its ability to capture 
traditional analogue methods of data collection. 
Thereafter, it was tested against its compatibility 
with various digital data collection tools. The 
information and feedback gathered from these 
sessions were used for further development of 
the GeonodeTM platform. This part of the project 
was developed further for the remainder of 2019. 
In January 2020, the continuation of the STINT/
NRF investigation was given a trial in the City of 
Tshwane, South Africa. The team from SIS joined 
the UUC’s STINT/NRF team in South Africa. The 
main aim of the exchange in South Africa was to 
build on the testing of the various tools for data 
collection and the effectiveness of the storage 
platform. This was done within Mamelodi East. We 
intended to see if GeonodeTM was able to store the 
information collected without losing the richness of 
the data. A recurring issue was the understanding 
of these tools by the research team. Thereafter, 
it was decided that due to the complex nature of 
the process, it needed to be broken down into 
streamlined steps. This resulted in developing an 
instruction manual, referred to as ukuDoba - the 
methodological framework, dictating a simplified 
but guided process from data collection to storage. 

Multiple data collection tools were considered 
and tested, each against their accessibility and 
usability. It was important for the research team 
that the tools selected allowed for the inclusivity 
of researchers from various fields and the 
consideration for the use of the framework by 
the end-user. This consideration widened the 
contribution that a project of this nature could 
make. Providing allowance for wider use, meaning 
that the data collected could not only be layered 
by time, but also by discipline and community 
perspective. 

The ukuDoba method makes use of three 
platforms and functions in a three-step systematic 
process, to make the data capturing and sharing 
process seamless and productive. Firstly, Kobo 
ToolboxTM (Data collection tool) was used as a 
digital platform to geospatially capture information, 
such as interviews, surveys and conversations.  
Secondly, QQISTM (Data translation tool) was used 



109Volume One  |  Methodology & Research Design108 109

Fig. 44. Pretoria: Testing the effectiveness of KoboToolboxTM, on site, in the data collection process (Brandao 2020) 

as a “middle-man” to translate collected data into 
an appropriate format to be imported into the third 
platform, GeonodeTM (Data Storage Platform). This 
platform was used to document all the geospatially 
collected data. Having GeonodeTM as the single 
platform for data storage allows for the layering of 
data year after year by researchers from various 
fields of research. 

As part of the Participatory Action Research (PAR) 
approach of the UUC, the ukuDoba method, allows 
researchers to do justice to the rich information 
collected.  Using this methodology also provides 
the opportunity for community members to collect 
real-time information within their communities 
and this contributes to their social empowerment, 
providing them with opportunities to uplift their 
own surroundings. 

The developed framework has been workshopped 
by postgraduate students, within the UUC, by 
the student research team. Feedback from these 
workshops influenced the refinement of the 
manual, which later guided the beginnings of our 
PAR approach within our mini dissertations, in 
2020. This method was used for mapping and 
analysis of existing social trends in Mamelodi 
East as a way to gain a hands-on understanding 
of the area and its community. As this method 
is an iterative process over months and years, it 
is important for us to reflect on our process and 
experience with the application of the framework 
to continuously update the methodology to the 
current research conditions and development 
in technology. As Master’s students, we have 
constantly engaged with the method alongside 
our peers and colleagues. The framework has 
encouraged this interaction of fieldwork. We hope 

Fig. 45. Pretoria: Composing Draft 1.0 of the ukuDoba 
Framework Booklet (Naidoo 2020)

Fig. 46. Pretoria: Presenting ukuDoba Framework Draft 1.0 to 
the Honours Urban Citizen studio (Naidoo 2020) 

Fig. 47. Pretoria: Presenting ukuDoba Framework Draft 1.0 to 
the Masters Urban Citizen studio (Naidoo 2020) 

Fig. 48. Pretoria: On site testing of ukuDoba Framework Draft 
1.0 with the Honours and Masters Urban Citizen studio (Naidoo 
2020) 

to influence other fields within the department 
to take to the method to create opportunities for 
collaborative data collection and sharing.

Being part of this collaborative process during the 
development and application phases has been 
crucial to our understanding of the importance of 
the data collected in the field. The information, 
often personal and engaged, allows for a 
greater perspective of the user and the people 
in a community and is vital in the field of Urban 
Citizenship. Collectively, during our Honours year 

in 2019, we had to recapture data and mapping 
that was conducted previously, rather than build on 
it. The STINT/NRF project gave us an opportunity 
to be part of creating a framework that would not 
only benefit ourselves but also contribute to the 
discourse of Urban Citizenship within architecture. 
Locally and globally we share similar contexts 
and issues. This project allowed us to collaborate, 
discuss and have a broader understanding of the 
issues and possible resolutions. 
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As active participants in the Unit for Urban 
Citizenship, we consider ourselves to be Urban 
Citizens. The Urban Citizen is proactive for change; 
they challenge rules and constraints and are 
intentional about their involvement. We strive to 
be agents of change and to not fall victim to the 
star architect mindset, but to be receptive to the 
knowledge that exists within others (Awan et al 
2011). It is important for us that we continue to 
rewrite our own professional code of conduct 
as we are exposed to the values attached to 
participatory action methods.

Including participatory action methods in the 
architectural design process needs to be 
distinguished from a community outreach project. 
Participation of all stakeholders is integral, adding 
to the efficiency and resulting in the effectiveness 
of the overall project (Hamdi 2010). Architects 
and other built environment practitioners have 
loosely implemented community projects over the 
years. However, these projects deal with surface-
level issues due to their lack of engagement 
with the end-user. Therefore, the intervention is 
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Fig. 49. Researchers collaboration (Smith 2019) Fig. 50. The Team (Unknown 2019)
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Fig. 52. Dr Carin Combrinck, our supervisor, in the field (Zorn 2020) 

a product of the ‘outsiders’ interpretation of the 
community needs. Often these interventions fail 
due to the lack of ownership and pride by the 
targeted community. Challenging the conventional 
methodologies of architecture can be highly 
influential in the creation of higher-performing 
interventions that address multi-issued layers 
(Awan et al 2011, Hamdi 2010, Sanoff 2011).

Ultimately, the dissertations following this 
Volume One, unpack alternate ways of ‘doing 
architecture’ that result in an increased social 
responsibility within communities, causing 
upliftment and a stronger sense of belonging for 
community members (Sanoff 2011). Unfortunately, 
within the Department of Architecture at the 
University of Pretoria, there is no precedent for 
this approach being undertaken by a Master of 
Architecture (Professional) student. We hope 
that the participatory design process that we 
have undertaken in our dissertations opens the 
conversation within our discipline (Fig. 51). 

Our contribution to the establishment of the Unit 
for Urban Citizenship is the hope that we have 
helped create a foundation for future like-minded 

students to collectively participate and take on 
real projects that impact communities in need. 
The Unit has encouraged us to challenge the 
authorship of architecture in the design process 
(Hamdi 2010) and prioritize the participatory action 
research approach. Our ambition is to encourage 
others to start thinking and designing by acting 
as spatial agents who effect change through 
the empowerment of others (Awan et al 2011). 
Our research collectively aims at emphasizing 
architectures’ role and capacity in contributing to 
social inclusion and transformative action (Awan et 
al 2011:33).

Ultimately we aspire to widen and embrace 
young, innovative designers’ perspectives on 
the true definition of community engagement in 
architecture and the opportunity for architecture 
to be socially inclusive. Our dissertation outcomes 
intend to pave the way for projects of this nature 
in the future. Projects that combine elements 
of interdisciplinary discourse to actively make a 
change to the community, as well as to contribute 
to the research development of spatial design 
within the co-design context locally and globally.

Fig. 51. Recognition of the PAR approach (Authors 2020) 
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Fig. 53. Authors (Combrinck 2019)
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1.1 Background

Nelson Mandela once proclaimed that “Education 
is the most powerful weapon which you can 
use to change the world” (Department of Basic 
Education 2019). Although our educational system 
has the largest impact on society, it unfortunately 
still remains the most fragmented (Luksha et al 
2018). The educational environment is undergoing 
exponential change and dormant learning 
approaches cannot keep up with this rate. A new 
culture of learning has emerged to respond to 
fast developing contexts. This concept is referred 
to as lifelong learning, which is multifaceted and 
encompasses the qualitative, social activities of 
daily life that contribute to our overall learning 
(Weeks 2012:1). 

“Education has been hit particularly hard by the 
COVID-19 pandemic with 1.53 billion learners 
out of school ... Drop-out rates across the globe 
are likely to rise as a result of this massive 
disruption to education access” (Education 
Cannot Wait 2020).

01
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Lifelong learning has become increasingly relevant 
in light of the COVID-19 pandemic where education 
has been disrupted worldwide (Education 
Cannot Wait 2020). Due to the unreliability of 
traditional educational pathways, the relevance 
of alternative learning opportunities have been 
brought to the forefront (Education Cannot Wait 
2020). These alternative pathways are critical to 
vulnerable groups where extended disruptions 
to the traditional learning process can have a 
detrimental impact (Education Cannot Wait 2020). 
With this outlook on lifelong learning, education 
goes beyond traditional knowledge transfer and 
includes a child’s holistic development as well as 
the growth of the communities around schools, 
through the support structure they provide. The 
dissertation deals with this topic within the context 
of South Africa, with a particular focus on mitigating 
the impact on economically distressed contexts 
such as Mamelodi East. 

Fig. 2.1.1. Model of Tsako Thabo built by Honours Architecture Mamelodi Group (Naidoo 2019)
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There are two pertinent ongoing conversations, 
regarding the educational ecosystem. The 
dissertation classifies these conversations as 
tangible and intangible. 
The tangible conversation deals with the spatial 
qualities of the built environment and its relation 
to learning and the intangible conversation deals 
with a non-spatial point of view of the relationships 
present within the educational environment. 
The tangible conversation, within educational 
discourse, criticises the school environment and 
its lack of sufficient evolution since its inception 
in comparison to other architectural models 
(Hertzberger 2008). 
The intangible conversation suggests that 
establishing a relationship between a school 
and its community promotes lifelong learning 
potential and enhances the holistic development 
of a person. It is seen that this relationship can be 
mutually beneficial where alternative education is 
received through the collective intelligence from 
the interaction between school and society (Global 
Education Futures 2018).

Designers and researchers within the architectural 
discipline must question the contribution 
architecture has to support the direction towards 
lifelong learning. The spatial constructs of our 
educational environment affect a child’s ability 
to learn, however their design considerations 
are significantly under-developed (Higgins et al., 
2005). Investigating the physical quality of the 
learning environment has gained momentum 
amongst design professionals and educators as a 
relevant topic in understanding architecture’s role 
in education (Cleveland & Fisher 2013:1). 

Fig. 2.1.2. Spatial and non-spatial conversation (Naidoo 2020)

Fig. 2.1.3. PAR at Tsako Thabo (Naidoo 2019)
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Therefore, the dissertation investigates the 
tangible and intangible intersection between 
architecture and education and the evident ways 
in which the built environment affects learning 
potential.

“Our vision is of a South Africa in which all our 
people will have access to lifelong learning, 
education and training opportunities, which will, 
in turn, contribute towards improving the quality 
of life and building a peaceful, prosperous and 
democratic South Africa.” (Department of Basic 
Education 2019) 

The concept of lifelong learning is not new, 
however it is increasing in relevance as societies 
rapidly change and embrace their dynamic 
quality. Organizations such as the United Nations 
Educational, Scientific and Cultural Organization 
(UNESCO) and the United Nations (UN) have 
started to incorporate the concept into their 
practice (Jarvis 2004:29) and we are starting to see 
this reflected in global and local policies regarding 
education. Lifelong learning is a priority within 
South African educational policy documentation 
(Department of Statistics South Africa 2019:53). 

However, policy for public school infrastructure 
fails to stipulate how, through the built educational 
environment, lifelong learning will be achieved. 
This observation reiterates Former President 
Thabo Mbeki statement that South Africa’s 
educational sector is convoluted with too many 
words and too little action (Weeks 2012:2). Policy 
for public school infrastructure lacks spatial 

definition and is thinly composed of architectural 
guidelines to achieve the intentions set out by the 
government. As a result, the dissertation intimately 
deals with South African policy for public school 
infrastructure to align the government’s intangible 
intentions for lifelong learning with the tangible 
spatial environment achieved through policy 
guidelines.

To direct the study and provide spatial definition, 
the dissertation is grounded in a typological 
understanding of the schooling environment that 
arises as a result of South African educational 
policy documents. A critical stance is taken where 
the resulting school typology is challenged in 
relation to context. The intention is to redefine 
the current teacher-centric classroom and 
corridor typology. The dissertation argues that the 
tangible (spatial) environment should encourage 
lifelong learning through stimulating a community 
school relationship as well as acknowledging the 
qualitative social activity of learning outside of 
traditional means. It is proposed that the schooling 
environment should be publicly redefined and 
serve as a support structure within its context, 
instead of isolating the educational experience. 
This is explored through the concepts of building 
as a boundary and building for pedagogy with 
the resulting development of a spatial matrix to 
provide architectural definition to South African 
educational policy. 
Tsako Thabo Secondary School, within Mamelodi 
East, is identified as a case study school for the 
application of the matrix principles, however it is 
intended for these principles to be applied to other 
schools within similar contexts and typologies to 
achieve lifelong learning potential. 

1.2 General, Urban and Architectural 
Issue

1.2.1 General issue

South Africa is dealing with a struggling 
educational system, where high dropout levels 
and low learning levels of children within the 
system have been recorded (Department 
of Basic Education 2019:16). The country 
currently measures its learning capabilities of its 
educational system through three international 
studies focussing on maths, science and literacy Fig. 2.1.4. Method of data analysis (Naidoo 2020)

Fig. 2.1.5. Tsako Thabo Secondary  School (Naidoo 2020)

(Department of Basic Education 2019:17). These 
skills are the focus of the South African educational 
system (Department of Basic Education 2019:43).  
However, basic life skills for holistic child 
development are not included as a factor.  

1.2.2 Urban Issue

Community engagement becomes an important 
aspect in the success of the school. This is 
particularly true within the South African context, 
where a study found that the social context 
impacted the schools’ culture of learning (Weeks 
2012:4). Integrating a school into its context 
allows it to function as a learning environment 
and community support structure (Higgins et al 
2014:30). Therefore, it is disappointing to see, 
through interaction with the school and community 
members, that this relationship is strained. This 
unfortunately is the case for multiple Township 

schools across South Africa (Lebesa 2015:9)

Multiple schools across Mamelodi East reflect the 
teacher-centric classroom and corridor model as 
a result of educational policy within South Africa. 
The impact of this model isolates schools from 
their context, creating a detachment between the 
community and school. The detachment results in 
school facility vandalism. Furthermore, the mono 
programmatic function of schools within Mamelodi 
East, bypass the opportunity to serve their 
context as a community support structure. This 
is problematic for the context of Mamelodi which 
already lacks community facilities. 
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1.2.3 Architectural issue

There are two core architectural themes dealt with 
in the dissertation: building in relation to pedagogy 
and building in relation to threshold. It has been 
established that education and architecture have 
an influence on each other (Hertzberger 2008). 
However, the tangible design of our learning 
environments is significantly under-developed 
(Higgins et al 2005). The school environment is 
criticised for its lack of sufficient evolution since 
its inception in comparison to other architectural 
models (Hertzberger 2008). The typology of 
the educational environment has progressed 
over time, however Mamelodi schools reflect an 
outdated school typology based on a teacher-
centric classroom and corridor model. The 
dissertation closely deals with the synergy of the 
tangible moves we make to the built educational 
environment and the resulting intangible social 
implications that affect lifelong learning. 

Fig. 2.1.6. Model of Tsako Thabo built by Honours Architecture Mamelodi Group (Naidoo 2019)

The theme of building as a threshold aims to 
address section 12 on school safety and security 
in the policy for public school infrastructure which 
addresses the interface between community and 
school with strict fencing guidelines (Department 
of Basic Education 2012). This stipulation is 
acknowledged as a deterrent to stimulating a 
community school relationship, which is advocated 
for within policy documentation (Department of 
Basic Education 2012). 

1.3  Problem Statement

The spatial consequences of the architectural 
discipline on the South African educational 
ecosystem have not been afforded the level of 
importance that it needs. Architectural guidelines 
within South African policy documents for public 
school infrastructure remain loosely defined 
(Department of Basic Education 2012). The spatial 

configuration of the schooling typologies within 
South Africa affect a child’s ability to complete their 
education (Jimenez 2018). 
“Our vision is of a South Africa in which all our 
people will have access to lifelong learning, 
education and training opportunities, which will, 
in turn contribute towards improving the quality 
of life and building a peaceful, prosperous and 
democratic South Africa.” (Department of Basic 
Education 2019) 

Throughout South African policy documents, 
the concept of lifelong learning is constantly 
advocated for as integral to the development of 
the country and its people (Department of Basic 
Education 2019; Department of Statistics South 
Africa 2019:53). However, once we seek out 
spatial definition within policy for this concept 
there is a disconnect. Within the written policy for 
public school infrastructure there are 8 principles 
discussed (Department of Basic Education 2013):

•	 universal access
•	 school location
•	 classroom size and ratios
•	 electricity, water and sanitation
•	 library and laboratory
•	 sports and recreation
•	 security and safety
•	 lights, ventilation and acoustics  

Within the guidelines of these principles there is 
an overall lack of spatial definition as to how the 
concept of lifelong learning is to be achieved. 
Therefore, understanding the implications of 
written policy on lifelong learning is a point of 
concern within the dissertation. 

Fig. 2.1.7. Education as public node (Naidoo 2020)
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1.4 Research Aim, Objective and 
Questions

The main research aim is to address this major gap 
within South African policy documentation. The 
dissertation seeks to understand the educational 
ecosystem within the South African context, with 
the objective of redefining the typology of the 
public school environment. 

This redefinition of the typology will be in relation 
to the research question: 

•	 How does the typology of a school influence 
its tangible and intangible integration into its 
context to promote lifelong learning? 

The sub questions: 

•	 How does school typology affect learning 
potential 

•	 How does school boundary affect the 
relationship between a school and its 
community 

•	 How does school typology contribute 
towards lifelong learning? 

The dissertation objective is to develop a spatial 
matrix that addresses the redefinition of typology 
in relation to building for pedagogy and building 
as a threshold to achieve lifelong learning. This 
spatial matrix is intended to inform policy for public 
school infrastructure to address the gap. The 
design objective of the dissertation is to provide an 
example of how the developed design principles 
from the spatial matrix can be applied to a case 
study school, such as Tsako Thabo Secondary 
School in Mamelodi East. 

Fig. 2.1.8. Typologically similar schools within the study area (Naidoo 2020)
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1.5 Justification for the Topic

Education is a primary concern in South Africa, with 
the government allocating 19.7% of the country’s 
budget towards this. This figure is considered 
to be high in comparison to international cases 
(Craddock 2017). Improving education and training, 
expanding infrastructure and transforming urban 
and rural communities are amongst the list of 
top focus areas of South Africa’s sustainable 
development goals (Department of Statistics 
South Africa 2019:53). Part of the country’s 
social goals is to “ensure inclusive and equitable 
quality education and promote lifelong learning 
opportunities for all (SDG 4)” (Department of 
Statistics South Africa 2019:53). Therefore, 
we need to look at the contribution of the 
architectural discipline, so that allocated funds to 
the educational built environment are impactfully 
spent.

1.6 Delineations & Limitations

The dissertation deals with how the typology 
of a teacher-centered classroom and corridor 
model, within an economically distressed context, 
such as Mamelodi East, affects lifelong learning 
potential.  Research focused on a typological 
study of the resulting spatial qualities from South 
African policy for public school infrastructure and 

is limited to South African policy on education. 
Tsako Thabo Secondary School is used as a case 
study to understand the spatial implications of 
South African policy on the relationship between 
a school and its community. Primary data was 
collected within and around the boundaries of 
Tsako Thabo Secondary School, with the study 
area limited to Ward 23, Mamelodi East. This is due 
to the fact that Participatory Action Research (PAR) 
was conducted, therefore the site was limited to 
a walking radius to carry out PAR data collection 
methods on site. 
The two themes of building for pedagogy and 
building as threshold were used to develop design 
principles for the dissertation to achieve lifelong 
learning. 
Building for pedagogy was analysed through a 
developed set of principles according to recurring 
themes present in school typology analysis: 

•	 plan type
•	 circulation
•	 spatial configuration

Fig. 2.1.9. Dissertation contribution (Naidoo 2020)

Building as threshold was investigated under 
the guidelines of Boettger (2015) parameters for 
threshold analysis: 

•	 spatial delimitation
•	 spatial sequence
•	 spatial geometry
•	 spatial topography
•	 spatial materiality

These parameters guided analysis of both the 
current site and precedents and was used as the 
guiding principles for the development of the 
spatial matrix intended to inform policy. 

1.7 Contribution 

1.7.1 Architectural Profession and Spatial 
Design

The research engages with an understanding 
of the spatial consequences of architecture on 
the educational ecosystem. Within this broad 
spectrum, an intimate investigation of the 
relationship between space, pedagogy and 
threshold is conducted. This investigation collates 
themes addressed across literature to provide 
the architectural profession with further insight 
on its impact on education and the potential 
for achieving lifelong learning through the built 
environment. 

1.7.2 South African Educational Built 
Environment

South African policy documents mention that 
the educational environment should encourage 
the lifelong learning potential of a person 
(Department of Basic Education 2012), however 
it is not stipulated as to how the written policy 
sets out to achieve this potential. Therefore, 
there is a detachment between the aims of the 
government for South African education and the 
implementation of those aims (as discussed in 1.3 
Problem Statement). An important outcome of the 
dissertation is to provide much needed spatial 
definition to South African Policy for Public School 
Infrastructure that aligns with the Government’s 
intentions for achieving lifelong learning, through 
the development of a spatial matrix according to 
the dissertation theme parameters (as discussed in 

1.6 Delineations and Limitations). This is intended 
to also assist the government in impactfully 
spending the allocated funds towards the 
educational built environment (see 1.5 Justification 
for the Topic).

1.7.3 Co-design Discourse: Design Games

Throughout the dissertation, design games were 
utilised as a tool to mediate the co-design process. 
Engaging with this process over a two-year period 
saw a shift in approach from analogue design 
games to digital design games, to adapt to the 
changing circumstances surrounding the COVID-19 
pandemic lockdown. Through this adaptation a 
series of design games were accumulated, which 
ranged in inventive game mechanics, to continue 
the co-design process despite challenging 
circumstances (see chapter 3). This alternative 
approach to co-design through the use of design 
games in various formats has the potential to 
contribute to subsequent studies, as well as the 
overall co-design discourse. 
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2.1 Lifelong Learning

2.1.1 Lifelong Learning and its Relationship to 
Social Activity 

Our educational environment is undergoing 
exponential change and dormant learning 
approaches cannot keep up with this rate. A new 
culture of learning, referred to as lifelong learning, 
has emerged to respond to fast developing 
contexts (Weeks 2012:1). The dissertation takes a 
stance on education and acknowledges that social 
and academic activity are integral in the lifelong 
learning process. Therefore, lifelong learning is 
defined within the dissertation as an emergent 
concept of learning which is multifaceted and 
encompasses the qualitative social activities of 
daily life that contribute to our overall learning and 
holistic development. 

The need to learn is a fundamental aspect of 
the function of a human being (Jarvis 2004:35). 
Children are born with a mind ready to absorb 
information. For learning experience to become 

beneficial, they need contextual stimulation 
that encourages exploration and curiosity. 
This contributes to their holistic educational 
development (Weeks 2012:6). A child’s universe 
is under constant expansion and with that 
growth comes multiple questions of meaning. 
However, through the learning taking place in 
the confines of a classroom, answers to the list 
of growing questions may go unanswered or 
remain irrelevant to the pressing questions of a 
child (Jarvis 2004:36). The new culture of learning 
moves further than the linear learning process 
from teacher to learner. Rather, learning is seen 
as circular where learners are encouraged to 
learn from each other and through interaction with 
their context (Weeks 2012:7). “Higher functions of 
learning originate as social relationships” (Dovey 
& Fischer 2014:45). Particular focus is given to 
the term ‘learning communities’ where interaction 
with the world is through a collaboration between 
learner and community (Weeks 2012:7). Therefore, 
this new culture of learning is closely associated 
with social interaction (Weeks 2012:10).

Learning is discussed as a journey rather than 
a linear process limited to the narrow period 
of school years. Education is seen as a lifelong 
learning process with benefits for the student and 
the community (Global Education Futures 2018:50). 

In this model, education is mutually beneficial 
and received outside of the traditional classroom 
set-up. Rather, alternative education is received 
through the collective intelligence from the 
interaction between school and society. With 
this approach to education, the school becomes 
more relevant within society. It provides a second 
chance to those out of the schooling system to 
continue the lifelong learning process. This model 
increases cognizance of society’s role within the 
educational ecosystem, therefore tying the school 
back into its context. 

2.1.2 Lifelong Learning within the South 
African Context

The concept of lifelong learning is not new; 
however it is increasing in relevance as societies 
rapidly change and embrace their dynamic 
quality. Organizations such as UNESCO and 
the UN have started to incorporate this concept 
into their practice (Jarvis 2004: 29) and we are 
starting to see this reflected in global and local 
policies regarding education. Lifelong learning 
is an ongoing mission within the South African 
educational context and is frequently mentioned 
throughout educational policy (Department of 
Basic Education 2019) as well as the country’s 
Sustainable Development Goals (Department of 
Statistics South Africa 2019:53). This conversation 
has become increasingly relevant in light of 
the COVID-19 pandemic where education has 
been disrupted worldwide (Education Cannot 
Wait 2020). Due to the unreliability of traditional 
educational pathways, the relevance of alternative 
learning opportunities has been brought to the 
forefront (Education Cannot Wait 2020).

South Africa is currently facing a skills paradox, 
where the need for skills is prominent, however the 
knowledge transfer of skills at school level is non-
existent and overshadowed by static knowledge 
transfer (Weeks 2012:1). Static knowledge transfer 
during schooling years is detrimental to the 
South African school learner (Weeks 2012:1). 
Therefore, learners who fall out of the spectrum 

of careers birthed from static knowledge transfer, 
contribute to the unemployment margin in 
the country. A culture of learning needs to be 
established to ensure that school leaving learners 
are prepared for a dynamic, changing world. 
The lack of a culture of learning has negatively 
impacted multiple schools around South Africa. 
These schools experience a multitude of socio-
educational issues ranging from vandalism to high 
dropout rates (Weeks 2012:2). It is suggested that 
if South African schools actively engage through 
social interaction and sharing with key role players 
in their context, this can positively contribute to 
a culture of learning and therefore impact the 
learning potential of learners and community 
members involved (Weeks 2012:11). 

Change is an inevitable factor, especially within 
technologically driven societies. Therefore, 
learning should not be halted during childhood 
years. Society recognised this need for education 
to keep up with new ideas and around the 
eighteen century, additional learning avenues were 
explored (Jarvis 2004). Growth through learning 
was encouraged within society. Education serves 
many functions, but a major factor to consider and 
highlight is the ways in which education equips 
learners to adapt to a dynamic and changing social 
environment (Jarvis 2004:25). 

2.2 Tangible Conversation: Spatial 
Relationship between Architecture 
and Education

2.2.1 Relationship between Architecture and 
Education

It has been established that architecture and 
education have an influence on each other 
(Hertzberger 2008). However, the tangible design 
of our learning environments is significantly 
under-developed (Higgins et al 2005). The school 
environment is criticised for its lack of adequate 
evolution since its inception in comparison to 
other architectural models (Hertzberger 2008). 
This is disappointing considering the increased 
awareness that traditional learning environments 
are outdated (Jimenez 2018:21). The term ‘learning 
environment’ has been referred to numerously 
outside of architectural discourse. However, not 
much has been said for its spatial quality. Majority 
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of the research within the field has addressed the 
social and psychosocial aspects, however minor 
research has been conducted into the effects 
of the physical environment (Cleveland & Fisher 
2013:1). Fortunately, the spatial conversation 
regarding the ‘learning environment’ has gained 
momentum amongst design professional’s and 
educators as a relevant topic in understanding its 
role within education (Cleveland & Fisher 2013:1). 

2.2.2 Relationship between Policy and the 
Built Educational Environment in South 
Africa

Policy and the built educational environment have 
an interesting relationship with each other. “Built 
policy helps to see how the meanings, constraints 
and opportunities of the built environment are 
shaped and when, by whom and with what 
resources” (Wood 2019:16). Wood (2019) suggests 

that we should look at policy with a wider lens 
to understand it beyond a verbal document and 
rather focus on how we can spatially communicate 
it. 

The Department of Bantu Administration 
(Administration Boards) served a developmental 
role within townships and operated the building 
of schools for Black areas within South Africa 
pre-1980 (Candiotes 1997:18). During this time 
most of the schools within township areas 
were constructed according to standard types 
(Candiotes 1997:18) (See Fig 2.2.1). Candiotes 
(1997:20) also points out that there was minimal 
regulation guiding the physical realisation of these 
schooling environments and that no “particular 
module” was adhered to but rather “common 
sense” on general classroom sizes was a driving 
force. 

Fig. 2.2.1. Standard secondary school plan type (Candiotes 1997)

During 1983-1994, the Department of Education 
and Training (DET) took over and guided the 
building of schools.  “Space and Cost Norms” 
were introduced by the State Treasury Department 
which dictated public school design through 
restricting building to predetermined programmatic 
function (Candiotes 1997:24). The DET’s standard 
building school type was influenced by the 

Transvaal Provincial Administration (TPA) school 
agency and the Transvaal Department of Works 
(TDW) school section (Candiotes 1997:24). Along 
with the TPA and TDW’s developed and tested 
standard school type, two other schools within 
South Africa (See Fig 2.2.2 & Fig 2.2.3 ) were 
influential in the DET’s final standard school type 
due to its low cost reduced plan, which is still 
evident today (Candiotes 1997).  

These standard school types followed the 
teacher-centric classroom and corridor model 
where size was determined according to teacher 
instruction, with a ratio of 1 Teacher: 36 Learners 
per class. 3600mm remained the module in place 
to construct these classrooms as it resulted in 
the most cost-effective solution. Based on the 
pairing of modules, the classrooms ended up 
having a 50m2 floor area (Candiotes 1997:34) 
(See Fig 2.2.6). Decades later, we can still see the 
same standard plan type reflected within multiple 
schools across Mamelodi East (See Fig 2.2.7).  

The South African government is protective of 
its people’s right to education (South African 
Government 1996) and suggests that all should 
have access to lifelong learning (Department of 
Basic Education 2019) where the school should 
serve as a node for societal transformation 
(Department of Basic Education 2012). The spatial 
configuration of the schooling typologies within 
South Africa affect a child’s ability to complete 
their education (Jimenez 2018), however from 
policy analysis there is minimal guidance provided 
regarding the importance of spatial configuration 
and mechanisms to achieve the government’s 
intentions for education. 

Fig. 2.2.2. Mayville primary school site layout (Candiotes 1997) Fig. 2.2.3. Magaliesburg primary school site layout (Candiotes 
1997)

Fig. 2.2.5. Classroom at Tsako Thabo (Naidoo 2019)

Fig.2.2.4. Standard classroom layouts (Candiotes 1997)
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Fig. 2.2.6. Old administration board schools (Candiotes 1997)

Fig. 2.2.7. Tsako Thabo floor plan reflecting standard model (UP Arch Hons Mamelodi Group 2019)

South African policy for public school infrastructure 
can be classified according to 8 principles 
(Department of Basic Education 2012): 

•	 universal access
•	 school location
•	 classroom size and ratios
•	 electricity, water and sanitation
•	 library and laboratory
•	 sports and recreation
•	 security and safety
•	 light, ventilation and acoustics 

These 8 principles reduce the built educational 
environment down to basic guidelines. Within 
these sub sections of policy, there is minimal 
spatial insight regarding how these elements are 
brought into fruition. The architectural guidelines 
(section 18) are limited, even in comparison to the 
general policy principles: classroom to learner 
ratio, classroom size, lighting and ventilation 
and durable construction (Department of Basic 
Education 2012). The policy documents remain 
vague in tackling the effect that architectural 
design has on the spatial configuration of 

educational space (Department of Basic Education 
2012:13).

Built policy engages in the ways in which 
architecture embodies the philosophies of 
education (Wood 2019:2). Buildings take on a 
dynamic quality and start to represent policy as 
well as social constructs (Wood 2019:11). School 
is seen as a solution to address issues that arise 
around the educational environment. Addressing 
these issues at school level could potentially 
mitigate the resulting effect (Wood 2019:7). 
Policy results in a standardised approach to form, 
therefore across contexts and communities, 
where the school building typology is evident, the 
resulting experience of that spatial form is shared 
(Wood 2019:6). 
Therefore, even though the South African 
government has strong intentions for education, 
the policy that sees those intentions into fruition 
fall short. The resulting effect of the limited 
architectural and spatial definition results in the 
basic teacher-centric classroom and corridor 
model evident throughout Mamelodi East. With 
increased attention given to policy for public 
school infrastructure there is the potential to 
mitigate issues that arise at school level. 

Fig. 2.2.8. Policy principles (Naidoo 2020)
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Fig. 2.2.9. School typology timeline (Naidoo 2020)
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2.2.3 School Typology

2.2.3.1 Understanding Typology within 
Architectural Discourse

The word ‘type’ first appeared at the end of the 
eighteenth century and was later applied in the 
nineteenth century. Since then typology has 
received growing interest within the architectural 
profession (Rocha 2014:186).  Typology can be 
defined as a ‘classificatory study of buildings with 
shared functional and morphological traits’ (Jacoby 
2015:3).  However, a deeper understanding 
of typology as ‘a system of relations’, allows 
us to make sense of the complex interactions 
between the spatial and non-spatial world (Rocha 
2014:186). The latter being the basis for typological 
investigation within the dissertation. 

There is value in understanding typological 
approaches within architecture as it places the 
architecture within its own historical context  
(Rocha 2014:186). Therefore, typological 
understanding provides insight into how 
architecture has developed. Questioning typology 
can be paralleled to questioning the architecture 
itself. Therefore, as time and societies progress, 
we need to rethink and redefine the nature of the 
architecture we are creating in order to answer the 
questions that arise when we question typology 
(Rocha 2014:186). 

2.2.3.2 Typology and Pedagogy 

A historical overview of the development of 
school typologies outlines the move from the 
industrial classroom with its functional typology, 
to the typological consideration of well-being, to 
prefabrication and the modern classroom. With 
the rise of the modern classroom, typological 
importance fell away in favour of function (Guan 
2018). Majority of South African public schools, 
within the Mamelodi East area, are modelled on 
the teacher-centered classroom and corridor 
typology (Veldsman 2019). However, this typology 
is outdated and has not adapted to the shift in 
spatial and non-spatial discourse on education. 

‘Schools have always been a reflection of a 
society’s stage of development’ (Kuhn 2012), 
therefore if schooling typologies do not progress 

over time to reflect pedagogical development, it 
opens up room for detachment between school 
and society. 

A historical overview of the paradigms guiding 
schooling typology can be classified into three 
approaches. The first dealing with intentional 
building for pedagogical purposes. This paradigm 
guiding typology usually finds itself within a 
context bound by rules and regulations that 
guide the resulting pedagogical architecture. 
The approach shies away from focussing on the 
learner and rather aims to meet predetermined 
standards, resulting in limiting the educational 
experience of learners (Dudek 2015). The second 
being the adaptation of an existing learning facility 
to meet demands resulting from the progression of 
education. In comparison to the first paradigm, the 
second is not bound by a prescriptive approach 
and its architectural typology is rather guided by 
the dynamic learning process and the learners 
themselves (Dudek 2015). 

Lastly, the influence of the architectural profession 
with its focus on learner centred design has 
resulted in the greatest advancements within 
pedagogical typology design. This approach is 
heavily influenced by the architect’s personal 
interactions with pedagogy (Dudek 2015). In 
this case the architect uses their experiences 
to guide the typology using the potency of their 
architectural strategy that they have accumulated 
through experience. By drawing on their personal 
experience, the architect can empathise with 
the learner and therefore uses this to guide their 
architecture (Dudek 2015:10). Although these 
paradigms exist, a common issue found across 
the globe is that schooling typologies largely 
reflect the standard model of teacher-centered-
classroom-and-corridor design (Kuhn 2012)

2.3 Intangible Conversation: Non-
spatial Relationship between 
Community and School 

2.3.1 Background

The community-school strategy is rooted back to 
the 1800s and was supported by Jane Addams 
and John Dewey, who recognised that the school 

model was not living up to its full potential (Lubell 
2011:5). Community-schools are environments of 
mutual support between communities, families 
and learners, that assist in strengthening the 
overall educational experience (Lubell 2011:1). The 
community school model engages with the role of 
a community within school and a school within its 
community (Lubell 2011:3). 
This schooling strategy contributes towards 
transforming the educational experience. 
Community engagement becomes an important 
aspect in the success of the school.  It allows for 
effective use of the built environment, allowing it to 
function as a learning environment and community 
support structure (Higgins et al 2014:30). Through 
the support structure this strategy provides and 
the integration between a school and its context, 
communities are more invested in the education of 
learners. 
Overall, the model positively impacts the learning 
environment, by reducing the factors that 
inhibit learning, such as external disruption and 
vandalism. Therefore, it leaves valuable  time for 
learners to engage in the learning process (Higgins 
et al 2014:30; Lubell 2011:18). 

2.3.2 Relevance of Community-School 
relationships to the Educational Ecosystem

Due to the nature of the relationship between 
human beings and society, they are actively 
involved in the learning process for the duration of 
their lifetime (Jarvis 2004:24). Social interaction is 
an important driver in the educational ecosystem 
as it is through this engagement that a society’s 
knowledge wealth is transferred (Jarvis 2004:24). 
The Global Education Futures (2018:7) report draws 
our attention to the shift away from traditional 
forms of teaching to “higher functions of learning 
that originate as social relationships” (Dovey & 
Fisher 2014:45). Education and the schooling 
environment is seen as the node of societal 
transformation. Instead of education being in 
isolation from its context, it is becoming an integral 
part of establishing a connection within society. 
The school environment is seen as a support 
structure to the greater learning experiences from 
life, where students are able to build on what 
they know in terms of their “social construction of 
knowledge” (Dovey & Fisher 2014:43). 

Learning is seen as both social and academic, 
where learners are made aware of their integration 
and relationship with their community. Schools 
no longer becomes inward and readjusts learners 
perspective of education as outward (Dudek 
2015:18). Schools serve as support structures to 
their society and mould learners to become holistic 
individuals who understand that they are valued 
partners in their community (Community-based 
schools transform SA education 2018). Home, 
school and community form the three pillars of 
the urban context. This make-up of the urban 
context can be inhibiting or enabling to a student 
and thus affects their learning outcomes (Englert 
1993:16). Community-schools assist in the transition 
of children from one phase of life into another. 
They provide academic and non-academic 
learning opportunities that assist in the holistic 
development of a learner, such as social, emotional 
and physical development (Lubell 2011:ix). 

2.3.3 Community school relationship in the 
context of South Africa

Within the guidelines relating to planning for 
public school infrastructure (5.5.4), the Department 
of Basic Education (2012:6) states that the 
infrastructure of the schooling environment 
should contribute to transforming a school into a 
societal node. However, the policy documents fail 
to stipulate guidelines as to how this should be 
achieved. The guidelines contradict themselves 
by stating that infrastructure should establish this 
relationship between the school and community. 
However, Section 12 of Policy for Public School 
Infrastructure, on school safety and security, 
stipulates detailed fencing conditions to separate 
the community from the school premises 
(Department of Basic Education 2012:11). Although 
this is the case, South African educational policy 
supports the standpoint that schools are nodes 
for societal change and is seen as a supportive 
structure (Department of Education 2008:71)



157Volume Two  |  Educational Ecosystem156 157

The community-school model has been widely 
implemented throughout America, however 
adaptations of this model have also been brought 
into South Africa (Lubell 2011:15). Community-
schools have gained momentum within South 
Africa. Several community schools are currently 
being implemented in and around the Gauteng 
province of South Africa. These schools have 
become integral in the communities they are 
located within and challenge traditional school 
models which sit in isolation from their community.  
(Community-based schools transform SA 
education 2018). 

School context and the social interaction within 
that context play a significant role in promoting or 
inhibiting a culture of learning within the school 
environment. This is particularly true within the 
South African context, where a study found that 
the social context impacted the schools culture of 
learning (Weeks 2012:4). Schools that succeeded 
in their social context were able to establish a 
sense of pride in the school. In contrast to learners 
from privileged South African schools, who have 
the support of parents, disadvantaged schools in 
South Africa are heavily dependent on contextual 
support to establish a culture of learning  (Weeks 
2012:4). 
Therefore, the community-school model within 
economically distressed contexts within the 
country has a greater potential contribution to the 
educational ecosystem and could play a vital role 
in lifelong learning. 
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RESEARCH & FINDINGS

Data collection date: 
2017

Data collection time: 
N/A

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2017

Participant/s:
N/A

Location:
Mamelodi East

Collection method: 
MapAbleTM

Fig. 2.2.10. Mamelodi East mapping illustrating community facility deficit (LeGrange UP Arch Hons Mamelodi Group 2017)

2.4. Educational Context: Research 
and Findings
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RESEARCH & FINDINGS

Data collection date: 
2017

Data collection time: 
N/A

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2017

Participant/s:
N/A

Location:
Mamelodi East

Collection method: 
MapAbleTM

Fig. 2.2.11. Mamelodi East mapping illustrating high unemployment percentages (LeGrange UP Arch Hons Mamelodi Group 2017)
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Fig. 2.2.12. Community facilities within Ward 23 Mamelodi East (Naidoo 2020)
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Fig. 2.2.13. Typologically similar schools within the study area in Mamelodi East (Naidoo 2020)
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Fig. 2.2.14. Typologically similar schools within the study area in Mamelodi East (Achi & Venter Arch Hons Mamelodi Group 2019)
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Fig. 2.2.15. Typological characteristics (Naidoo 2020)



171Volume Two  |  Educational Ecosystem170 171

Fig. 2.2.16. Typological characteristics present at Tsako Thabo (Naidoo 2020)
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Fig. 2.2.17. Economic activity on the periphery of Tsako Thabo (Naidoo 2020)

Data collection date: 
2019

Data collection time: 
11h00

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2019

Participant/s:
Community members and 
businessman from Mamelodi 
East

Location:
Area around Tsako Thabo

Collection method: 
Transect walks, interviews & 
images

RESEARCH & FINDINGS
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Data collection date: 
2019

Data collection time: 
11h00

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2019

Participant/s:
Community members and 
businessman from Mamelodi 
East

Location:
Area around Tsako Thabo

Collection method: 
Transect walks, interviews & 
images

RESEARCH & FINDINGS

Fig. 2.2.22. Motor sales (Naidoo 2019)

Fig. 2.2.21. Car wash (Naidoo 2019)

Fig. 2.2.20. Spathlo shop (Naidoo 2019)

Fig. 2.2.19. Motor repairs (Naidoo 2019)

Fig. 2.2.18. Spaza shop (Naidoo 2019)
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Data collection date: 
February 2020

Data collection time: 
10h30

Researcher/s:
Author & UP Architecture 
Honours Mamelodi Group

Participant/s:
Mamelodi community members  
and Tsako Thabo staff & 
learners

Location:
Ward 23, Mamelodi East & 
Tsako Thabo Secondary School

Collection method: 
ukuDoba framework: Interviews 
using KoboToolboxTM

RESEARCH & FINDINGS

“We don’t have a relationship with the school”
-Community member

Fig. 2.2.23. ukuDoba interviews (Naidoo 2020)

Fig. 2.2.25. ukuDoba interviews (Naidoo 2020)

“Many people have broken into the school and 
stolen”

-School staff

“I’ve never been invited to any 
events at the school”

-Community member

“sometimes the children come to my shop”
-Spaza shop owner

“I don’t know anyone at the school”
-Community member

“They have no interest in what I do”
-Small business owner near school

Fig. 2.2.24. ukuDoba interviews (Naidoo 2020)

Fig. 2.2.26. ukuDoba interviews (Naidoo 2020) 
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Fig. 2.2. 27. Results of safety perception workshop by learners (Naidoo 2020)

Data collection date: 
2019

Data collection time: 
11h30

Researcher/s:
Achi & Venter UP Architecture 
Honours Mamelodi Group

Participant/s:
5-6 Learners from Tsako Thabo

Location:
Tsako Thabo Secondary School

Collection method: 
Participatory Action Research 
workshop involving learners 
allocating safety icons to a map 
of the school

RESEARCH & FINDINGS
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Fig. 2.2. 28. Results of safety perception on the use of the school (Naidoo 2020)

Data collection date: 
2019

Data collection time: 
11h30

Researcher/s:
Achi & Venter UP Architecture 
Honours Mamelodi Group

Participant/s:
5-6 Learners from Tsako Thabo

Location:
Tsako Thabo Secondary School

Collection method: 
Participatory Action Research 
workshop involving learners 
allocating safety icons to a map 
of the school

RESEARCH & FINDINGS
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RESEARCH & FINDINGS

Data collection date: 
February 2019 - March 2019

Data collection time: 
10h45 - 11h45

Researcher/s:
UP Architecture Honours 
Mamelodi Group 

Participant/s:
Tsako Thabo Learners

Location:
Tsako Thabo Secondary School

Collection method: 
Participatory Action Research 
workshops and interviews

Some classrooms sit unused (UP 
Arch Hons Mamelodi Group 2019)

School experiences multiple 
acts of vandalism and break ins 
(Naidoo 2019)

Fig. 2.2.30. Participatory Action Research workshop (UP Arch 
Hons Mamelodi Group 2019)

Fig. 2.2.29 Participatory Action Research workshop (UP Arch 
Hons Mamelodi Group 2019)

Fig. 2.2.31 Participatory Action Research workshop (UP Arch Hons Mamelodi Group 2019)

07h30 10h45

School Hours

Open to staff and learners

11h30 15h00

Lunch

School food 
vendors enter 

the school

School Hours

Open to staff 
and learners

School Inactive

Closed to 
learners and 
community

Timeline of school day
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Data collection date: 
February 2019 - March 2019

Data collection time: 
10h45 - 11h45

Researcher/s:
UP Architecture Honours 
Mamelodi Group 

Participant/s:
Community members and 
Tsako Thabo Learners & staff

Location:
Ward 23 Mamelodi East

Collection method: 
Participatory Action Research

RESEARCH & FINDINGS

Fig. 2.2.32. Participatory Action Research transect walks (UP 
Arch Hons Mamelodi Group 2019)

Fig. 2.2.33. Participatory Action Research community 
immersion (UP Arch Hons Mamelodi Group 2019)

Fig. 2.2.34. Participatory Action Research interviews (UP Arch 
Hons Mamelodi Group 2019)

Fig. 2.2.35. Participatory Action Research transect walks (UP Arch Hons Mamelodi Group 2019)

Fig. 2.2.36. Participatory Action Research interviews (UP Arch Hons Mamelodi Group 2019)
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2.6 Reflection

As a result of the Participatory Action Research 
(PAR) conducted, it is concluded that the 
community of Mamelodi East receives minimal 
community support from its context. This is due to 
the low percentage of community support facilities 
to accommodate the population. When we reflect 
on the number of schools within the context that 
sit dormant outside of schooling hours, there is 
an acknowledged missed opportunity for these 
facilities to better serve their context. 
As a result of interaction with members 
(community, school learners and teachers) of 
Mamelodi, this strained relationship became 
evident. A potential resultant effect of this strained 
relationship is the lack of care and respect 
afforded to the built educational environment 
within Mamelodi East. This is reflected in the 
vandalism and theft experienced by Tsako Thabo 
Secondary School. 

This lack of relationship between school and 
community is also reflected in the tangible (spatial) 
environment. As a result of policy stipulations, 
the boundary of public schools maintains a rigid 
1.8m fence around the periphery (Department of 
Basic Education 2012), which isolates the schools 
from their contexts. This condition, along with an 
inward-looking spatial configuration contribute 
to negative experience of the school edge, with 
the periphery of the school being perceived as 
unsafe by the learners. The most problematic 
element of school safety is the boundary condition 
as identified by most students. Tsako Thabo, 
along with multiple other schools within Ward 
23 of Mamelodi East, reflect the same teacher-
centric classroom and corridor typology and 
share multiple characteristics. According to Wood 
(2019:6), shared typological structures commonly 
emit the same resulting experience. A result of the 
safety perception within the school is the inefficient 
use of the physical educational environment. There 
is a missed opportunity in that the schools sit at 
key points around clusters of activity but have 
limited connection with them.

The strained relationship between school 
and community can be a potentially hindering 
agent to lifelong learning. Multiple interviewees 
acknowledged their inclination to continue their 

education that was halted at some point in their 
life due to arising issues. This finding, along with 
the high unemployment rate in Mamelodi East, 
emphasizes the importance of an educational 
environment in this context and for it to serve as a 
community support structure to mitigate the issues 
that arise. 
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3.1 Abstract

Co-design has become a recognised approach 
within architectural discourse to challenge the role 
of the author in the design process. It has been 
the major architectural approach of a Professional 
Master of Architecture mini-dissertation. The 
dissertation focussed on Tsako Thabo High 
School in Mamelodi East, Tshwane and explored 
the spatial consequences of architecture on the 
educational ecosystem. In particular, the focus 
was on how South African government school 
typologies impact the tangible (spatial) and 
intangible (non-spatial) integration of a school into 
its context to promote lifelong learning potential. 
The engagement with participants throughout the 
process has importantly involved children due to 
the dissertation focus. Praise is given to co-design 
processes involving a collaboration with children 
due to their innovative outlook on life which 
contributes towards creativity. 
However, for such collaboration to become useful, 
appropriate tools need to be considered to elicit 
creative responses. 

Design games are supportive tools in co-design 
architectural processes. They provide an effective 
avenue in engaging with participants, particularly 
when children are the focus group. Conventionally, 
design games would be applied in analogue 
form on site. However, as technology advances, 
alternative online platforms present themselves 
that widen the spectrum of possibilities for the 
creation and application of digital design games for 
the co-design process. 
This paper compares the application of analogue 
design games to digital design games. Both game 
types were compared according to their ability to 
contribute to the design process of the dissertation 
project. 

This research contributes towards a Professional 
Master of Architecture dissertation, which under 
normal circumstances would be using analogue 
design games in the co-design process. However, 
due to the COVID-19 pandemic, alternative 
methods of engagement needed to be considered. 
Conducting analogue design games within 

03
COMPARING THE 
APPLICATION OF DIGITAL 
DESIGN GAMES AGAINST 
ANALOGUE DESIGN GAMES 
IN THE ARCHITECTURAL CO-
DESIGN PROCESS 

this context presented multiple limitations and 
challenges, which were exacerbated in digital 
design game format due to the reliance on online 
communication tools. The paper explores methods 
for the creation and application of digital design 
games that deal with the presented challenges. 
Through the comparison of digital design games 
against analogue design games, the paper opens 
the discussion on how design games in various 
formats differ in their contribution to the co-design 
process.

3.2 Introduction 

The practice of design is under constant 
progression with the involvement of the end user 
growing in importance (Lee 2008). Challenging the 
role of the author has been an ongoing discussion 
within architectural discourse. There is movement 

Fig. 2.3.1. Analogue design game application (Naidoo 2019)

away from single authorship to a collaborative 
one, which includes the voices of those inevitably 
affected by decisions made from single authorship. 
The concept of user participation in the design 
process was first introduced in 1971 where the term 
“Design Participation” was conceived (Lee 2008). 
“Design Participation” is more notably identified 
as co-design in today’s context. Co-design is an 
acknowledged process, within Participatory Action 
Research, in tackling the debate on authorship. 

This paper moves beyond the standpoint of 
why co-design should be considered, but rather 
how it can be approached. Co-design has been 
recognised as an essential process, however it can 
only become useful in the collaboration towards a 
creative design, if the appropriate tools are used. 
Design games are useful tools, structures and 
mindsets to include the participant in the co-design 
process (Vaajakallio & Mattelmäki 2014:2). They 
serve as tools to bridge the gap between design 
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Fig. 2.3.2. Analogue design game application at Tsako Thabo (Naidoo 2019)

professionals and end users allowing for mutual 
understanding (Howard & Somerville 2014).

Within co-design there is limited research being 
conducted by design professionals themselves, 
who are actively participating in the process (Lee 
2008). To contribute to this gap, the research was 
positioned from the standpoint of a Professional 
Master of Architecture student who actively 
engaged with participants in the co-design 
process, through the means of design games. 
Design games were used at varying points of the 
design process to assist in the development of 
the dissertation project. The dissertation explored 
the spatial consequences of architecture on the 
educational ecosystem. In particular, the focus 
was on how South African government school 
typologies impact the tangible and intangible 
integration of a school into its context to promote 
lifelong learning. Tsako Thabo High School in 

Mamelodi East, Tshwane was used as a case study 
for investigation within the dissertation. Various 
participants were involved at key points in the co-
design process to engage in design games. Due 
to the focus on education and the involvement 
of the high school, participants included children 
from the school,  to understand the impact of the 
school typology on education and their learning 
experience. Design professionals were also 
engaged to gather their views on the relationship 
between architecture and education in light of the 
dissertation focus. 

Co-design processes were introduced in the 
Honours year, in 2019, at the University of Pretoria, 
as a way to challenge the discipline within the 
Department of Architecture. My engagement with 
co-design occurred over the period of two years 
from the Honours year and into the Masters, in 
2020. Design games were used as a medium to 

Fig. 2.3.3. Researcher (Author) on site for analogue design game application (du Bois 2019)
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engage participants, ranging from professionals 
to the end user,  in eliciting design informants 
to apply to the architectural development of 
my project. Upon introduction to the co-design 
process, various participatory workshops were 
engaged with by my peers. My focus shifted 
towards design games as a medium. I became 
fascinated by the mindset of using game play 
within architecture. 

The Honours year of engagement focussed on 
the creation and application of analogue design 
games, due to my physical access to participants. 
However, in the Masters year, this access was 
limited due to the lockdown restrictions within 
South Africa in response to the COVID-19 
pandemic.  This created a new dynamic and a 
shift in mindset. Due to my commitment to the co-
design process, I adapted to digital engagement 

Fig. 2.3.4. Design GameKit intention (Naidoo 2020)

to continue the creation and application of design 
games. This surfaced a range of issues that I had 
to tackle as a researcher and designer, in terms 
of appropriate digital channels for engagement, 
how to create a design game to function digitally, 
access to participants, participation in game play 
and so forth. In the absence of the pandemic, 
normal circumstances would have seen me 
continue engaging in analogue design games 
throughout the Masters year. 
However, due to the challenges and being forced 
to adapt to alternative formats, I have become 
resilient as a co-design practitioner in advocating 
for design games as an effective medium. This 
paper serves as a reflection of that experience to 
compare the creation and application of analogue 
and digital design games to the co-design process 
of a Master of Architecture (Professional) mini-
dissertation. Digital and analogue design games 

are discussed in terms of their contribution 
to different parts of the design process of the 
dissertation. The paper describes these two 
varying design game experiences to open the 
discussion on how design games in various 
formats differ in their contribution to the co-design 
process. 

3.3 Design Games in the Co Design 
Process: A literature Review

Hamdi (2010) clarifies the notion of participation as 
an integral part in the design process. Participation 
is linked to three key aspects that are vital in the 
creation of community; namely ownership, sense of 
belonging and responsibility.  Therefore, it should 
not be seen as an add-on but rather a vital step in 
efficient and effective design. As researchers and 

designers, we need to be cognizant of different 
levels of participation so that we do not manipulate 
the design process but allow the true nature of 
the participation to flourish (Higgins et al 2014).  
Design games allow for effective participation 
and have gone through significant evolution, 
being approached differently by various theorists 
(Vaajakallio & Mattelmäki 2014:2). It is important 
that the use of design games in the co-design 
process is to not achieve a finalised design, 
however it is about collectively understanding a 
situation in the present and providing potential 
design solutions for the near future. A design game 
should therefore allow collaborators to “share 
current and past experiences in order to envision 
future ones” (Vaajakallio & Mattelmäki 2014). 

Design games, also referred to as ‘exploratory 
design games’ have made headway since the 
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1990’s (Brandt, Messeter & Binder 2008:52). 
When dealing with co-design, it is important for 
the design practitioner to recognise that the end 
user is capable of making decisions about their 
environment due to their increased exposure and 
interaction with it. As designers, we therefore 
need to create a platform for engaging with end 
users that allows their views to surface instead of 
being overshadowed (Brandt, Messeter & Binder 
2008:51). Habraken and Gross (1987) support 
the use of design games as an effective tool in 
the design process. Being able to communicate 
effectively throughout the co-design process, with 
end-users who usually do not have a background 
in design understanding, requires a medium to 
find common ground between those involved. 
Multiple projects, such as Hybrid Space Lab (2020) 
and Engagement Lab at Emerson College (2020), 
have found success in the use of design games 
as a medium to collaborate with the end user into 
guiding transformative design decisions about the 
built environment. These projects have been able 
to reach a multitude of participants to holistically 
inform design decisions. 

Design games provide a conceptual world 
to engage in this conversation with a ‘shared 
language’ between practitioner and end user 
(Brandt, Messeter & Binder 2008:51). When 
engaging in a participatory process, it is important 
to understand the mindset of people. People 
‘reason in terms of concepts and principles’ by 
connecting relationships (Devisch, Poplin and 
Sofronie 2016). Conceptual design games make 
use of abstractions, removing the design language 
of the physical design elements of a project, to 
create common ground between end user and 
practitioner (Brandt, Messeter & Binder 2008:58). 
The action of game play, through design games, 
has an interesting role in acknowledging the 
fluidity of real-life. Throughout game play, players’ 
interpretations and understandings of the subject 
of the design game, usually adapt along the way, 
adding a dynamic element mimicking the way 
we socially construct reality (Brandt, Messeter & 
Binder 2008:53). 

Engaging school users in the design process 
of their learning environment largely impacts 
the success of that school. School users offer a 
different perception in comparison to architects 
and through the process of engagement in the 

design process, they are often empowered 
(Higgins et al 2014). A child’s imagination is not 
yet limited by adulthood  (Hagen et al 2012:1), 
therefore their involvement in the design process 
is further praised due to their innovative outlook 
on life which contributes towards creativity 
and challenges the sometimes narrow views of 
adults (Higgins et al 2014). Excluding children 
in the design process of learning environments 
undermines the overall outcome and reduces the 
potential of design (Higgins et al 2014:14).
Systems thinking speaks to the branch of problem 
solving that puts emphasis on the networks and 
links that exist between elements within dynamic 
models (Kaufman & Flanagan 2016:1). Systems 
thinking is a useful method for learners to engage 
in. They are able to understand complex scenarios 
involving the interaction between elements of 
various systems they engage with. When dealing 
with the educational ecosystem it is important to 
understand the “network of interactions among 
organisms, and between organisms and their 
environment” (Mueller & Toutain 2015:6). 

The dissertation deals within a complex system of 
understanding, therefore it is beneficial to have a 
medium to bridge the background understanding 
when engaging with learners. This approach to 
thinking is considered difficult to engage with, 
however it is encouraged to be incorporated into 
the educational experience (Kaufman & Flanagan 
2016:2). To bridge the difficulty, design games are 
currently being promoted throughout educational 
discourse as a way of engaging learners in 
systems thinking. Games naturally encompass 
complex systems that participants have to 
understand and interact with, which contributes 
to the development of a systems thinking skill set. 
Therefore, through the process of design game 
application, participants were better able to grasp 
the concepts dealt with in projects and they were 
better equipped to recognise and understand 
systems present in their personal lives. 

3.4 Design GameKit 

During the Honours year there was limited 
attention given to the documentation of our design 
game experience for future use. I believed that 
there was a missed opportunity to document our 
processes and how we were adapting existing or 
creating new games to cater to the participants 

Fig. 2.3.5. Design GameKit framework development (Naidoo 2020)

Fig. 2.3.6. Design GameKit (Naidoo 2020)

we were engaging with. During the Masters year, 
I sought to continue exploring design games. 
It became important for me to document the 
creation and application of design games, so that 
it would better serve subsequent students in the 
department. This documentation was through 
the creation of the Design GameKit, which was 
intended to provide a foundation of methods for 
engaging participants through design games.

The Design GameKit contains a framework 
which serves as an outline to guide architecture 
students dealing with participatory design on 
how to create, document and apply design 
games to the co-design process. To assist in 
the creation of design games, it is beneficial to 
first outline your design goals in order to direct 
the process of development. Devisch, Poplin 
and Sofronie (2016:87) outline three design 
goals to develop design games that support 
understanding of spatial facts, spatial concepts 
and spatial principles. Once this is identified, it 

becomes easier to develop the game mechanics 
that respond to the design game goal. Therefore, 
the Design GameKit framework acknowledges 
this by including this consideration at the outset 
of the creation process. An outcome of applying 
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Design GameKit Framework

1 2 3

Creation of Design Game Design Game Rule Book Application of Design Game

Format: Digital or Analogue Game Design Game Title Participants

Intention: Which part of the design 
process do I need assistance with 
through co-design

Design Game 
Objective/Overview Participation

Precedent Platform for Game Play Challenges 

Adaptation of precedent for research 
focus

Game Pieces 
Opportunities

Challenges Number of players Documentation of game play

Duration of play Outcomes

Game Play Contribution to the design process

Researchers role during game 
play

Fig. 2.3.7. Design GameKit Framework (Naidoo 2020)

the framework, is to enable future researchers 
to build on, apply or adapt design games 
to other projects. Many games exist online 
for collaboration, however these games are 
generalised. Filtering these games through the 
Design GameKit framework contributes towards 
a library of contextually relevant design games. 
By synthesising the process and providing a 
framework on how to document and run co-design 
games, we are able to create a database of tried 
and tested design games. The Design GameKit 
library can thereafter be utilized or adapted by 
ensuing students.

Along with the framework, the Design GameKit 
consists of analogue and digital design games 
that have been created and applied within the 
dissertation. The digital design games are in 
response to the COVID-19 lockdown restrictions 
within South Africa that prevented physical contact 
with participants. These games exist to provide a 
basis for resilience within co-design processes, to 
provide future students with potential methods of 
engaging participants, when challenges arise.

3.5 Methodology 

The research methodology was positioned within 
the interpretivist paradigm as it had a subjective 
nature and required the researcher to engage with 
their research through interpretation (Research 
Methodology 2020).  The paradigm focuses 
on what was unique to the research where the 
knowledge generated from the research was 
rich in meaning and relative to a particular set 
of variables (time, culture, context) (Research 
Methodology 2020). Therefore, the paradigm 
is applicable to the intentions of the research in 
gaining an understanding of how design game 
creation and application were affected by the 
current context of Mamelodi East. Mamelodi East 
is located in the City of Tshwane, South Africa and 
is a township developed for the African population 
in 1945 as a result of the Apartheid regime (van 
der Waal 2000). The case study school where 
analogue design games were applied, is based 
within this context. Due to the research forming 
part of the interpretivist paradigm, it primarily 
involves qualitative data collection methods. 
Observation, during game play and researcher 
reflection of design game creation and application 
formed the primary methods of data collection.

Both analogue and digital participation involved 
learners from Tsako Thabo Secondary School, 
however separate groups of learners were 
used due to the time-frame of the research and 
accessibility to participants. A group of a minimum 
of 3 learners (ages 13 - 20) were selected at 
random to participate. Consent was received from 
the principal of the school before engagement with 
the learners. Analogue design game play occurred 
on site at the high school of the learners, during 
a 45 minute period from 11h15 to 12h00, when the 
learners were on their lunch break. Participation 
from these learners occurred due to their interest 
in the project, therefore not all participants were 
of the same age or previously acquainted. Digital 
design game play occurred during the Masters 
year, therefore due to the wider time-frame 
and intensity of the project, a wider range of 
participants engaged with digital design games in 
the co-design process. Participation was based on 
participants’ ability to access digital devices and an 
internet connection. 

Empirical data was gathered from 2019 to 2020. 
Research was conducted over the two-year 
period at the school, on the spatial consequences 
of architecture on the educational ecosystem. 
Analogue design game engagement was 
conducted during the first year of the study. Due 
to COVID-19 and lockdown restrictions within 
South Africa, digital platforms for design game play 
needed to be considered. Before digital design 
play engagement, an overview of platforms was 
done, by the 2020 Unit for Urban Citizenship 
Honours Studio, to find a suitable approach for 
digital design game creation and application (see 
Appendix 2H) . This investigation was considerate 
of the presented challenges and limitations. The 
major criteria dictating the selection of online 
platforms for use was determined according to:

•	 Accessibility/usability
•	 Interactive quality
•	 Academic Soundness 

The following platforms were tested according to 
the above criteria:

•	 Telegram
•	 Tabletopia
•	 Bubbl.us
•	 Facebook / Instagram

•	 Reddit
•	 Markup
•	 Samepage
•	 Zoom / Google Meet
•	 Kobo Toolbox
•	 Figma
•	 House Party
•	 Stormboard
•	 Explain everything
•	 Miro
•	 Padlet
•	 Mural
•	 Conceptboard
•	 Google Drive / Forms
•	 Whatsapp

This assessment of digital platforms provided 
direction towards appropriate platforms for 
digital design games creation and application. A 
comparison between the application of design 
games types was made. According to:

•	 Participation
•	 Challenges
•	 Opportunities
•	 Documentation of game play 
•	 Outcomes
•	 Contribution to the design process

The spatial outcomes of each design game 
interaction were distilled to the design indicators 
that were applicable to the dissertation design 
project. Lastly, the comparison according to the 
above-mentioned criteria, was used to engage 
in discussion on how the varied approaches to 
design games differed in their contribution to the 
co-design process. 

3.6 Analogue Design Games in the Co-
design Process 

The application of analogue design games was 
the initial introduction into the co-design process 
for the dissertation in 2019. Access to the site 
allowed us to interact with the end user. Therefore, 
analogue games focussed on learners from Tsako 
Thabo Secondary School, as the participant 
group. Due to the context of the study, several 
challenges presented itself regarding the creation 
and application of these design games. In the 
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application of varying analogue design games 
(Appendix 2A-2C), the site condition posed a 
particular challenge. A simple element such as an 
appropriate venue to carry out the design game 
held a great deal of influence on the outcome. Due 
to the site of focus being a school, interaction with 
the learners was limited to their break-time to not 
disrupt  or impose on the schooling hours of the 
day. Our window for interaction was limited to a 45 
minute period, which was further reduced to allow 
for the learners (participants) to gather their lunch 
from the school feeding scheme. 

The venue for design game application had a 
heightened sense of activity during this period. 
It was a thrilling energy to be around, however it 
was disruptive to the application of the various 
design games.  After a participant group was 
selected, it was difficult to hold their attention 
for the duration of the design game application. 
The audible volume of learners on break made it 
challenging to communicate with the participant 
group, further contributing to the initial challenge 
of the language barrier between primarily 
Northern Sotho speaking participants and English 
speaking researchers. Learners occupied the 
classrooms and external courtyards of the school 
during the break, therefore limiting the venue 
for design game application. In most cases, to 

carry out design game application, a table had 
to be carried to an outlying area of the school 
grounds to maintain communication whilst limiting 
distraction. For the most part, this was successful, 
however finding a solution to this initial challenge 
surfaced a series of others, such as fighting 
against the natural elements such as the wind and 
harsh sunlight. Given the challenges presented, 
participation during the design game application 
was encouraging. Participants were able to easily 
engage with the design games and fed off each 
other’s energy during the process. 

The experience with analogue design games in 
this case allowed for greater interaction amongst 
researchers and participants. The duration of 
design game explanation to the participant group 
was brief due to the ability to easily interact with 
participants and the game elements. Reading 
body language was an important component of 
analogue design game application. It was easier 
to recognise whether the participant group 
understood the intention and instructions of the 
game or if they were losing interest along the way. 

The analogue design games were all composed of 
simple game mechanics which allowed for ease of 
play. This also made it efficient to explain on site 
and was fluid enough to adapt on site depending 

Fig. 2.3.8 Tour Guide design game path taken through school (Naidoo 2020)

Fig. 2.3.9. Tour Guide design game application on site at Tsako Thabo (Naidoo 2019)

on the dynamics of the participant group and the 
direction that game application was headed in. 
The lack of rigid structure to the design games 
allowed opportunity to surface a wider range of 
information that perhaps pushed the limits of the 
initial intentions set out during game creation. 

Overall, the application of analogue design games 
went beyond the intended outcomes and a deeper 
understanding of learners’ perception of their 
educational built environment was uncovered. 
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3.6.1 Tour Guide

See Annexure 2.A

The analogue design game, Tour Guide, was 
directed towards understanding the experience of 
the school through user perspective. The objective 
of the game was to understand the spatial points 
of impact of a learner’s school environment and 
to gain further insight into the elements of their 
environment that they consider important to share. 

For the dissertation application, the researcher 
role-played as a new student transferring to the 
school and learners had to show the new student 
around and point out what the new student should 
know about the school and its functions. The game 
did not require a lot of preparation beforehand 
and therefore did not create any challenges 
during the creation process. Due to the nature 
of the game, it can be easily applied by other 
researchers in several contexts to gain further 
insight into the perspective of the end user and the 
resulting experience of the physical educational 
environment. 
  
The ease of game play made it a simple game 
to participate in. Throughout game play, it 
stimulated curiosity within other learners in the 
school. Participants were able to equally engage 
with the researcher and other participants during 
game play to collectively decide on the tour 
path for the researcher to take. The application 
of this analogue game resulted in a deeper 
understanding of the physical educational 
environment than originally expected during the 
design game creation process. This was achieved 
through the documentation process of design 
game application. 

The use of video has been acknowledged as a 
useful medium in capturing the richness usually 
lost in other media forms (Brandt, Messeter & 
Binder 2008:54). Video recorded during game play 
on site captured dialogue and path taken within 
school. However, having to record the session 
and focus on the participants at the same time 
posed a challenge during game application. It 
would be useful to partner with another researcher 
for this game to ensure that the process is well 
documented. The other researcher can therefore 

scribe dialogue from participants onto the printed 
map according to their space associations. 

3.6.2  Dots

See Annexure 2.B

Fig. 2.3.10. Dots design game application on site at Tsako 
Thabo (Naidoo 2019)

Fig. 2.3.11. Dots design game application on site at Tsako 
Thabo (Naidoo 2019)

The analogue design game, Dots, was created to 
understand learners’ spatial association within the 
school. During game play, players were required 
to allocate a space on site to a question prompted 
by the researcher. In the design game creation 
process the challenging element was deciding 
on the questions to ask the participants (learners) 
beforehand. Having not based the game off a 
precedent, it was difficult to assess how much 
could be achieved during the duration of game 
play. Therefore, at the creation stage, there was 
minimal control over aligning the game creation 
with the game outcome. The variable of time was 

particularly challenging in this case as researcher 
interaction with participants was limited to the 
30-minute duration of the school lunch break. 
The creation of the design game had to therefore 
consider what the most effective method of game 
play would be appropriate to render maximum 
output.

During the process of game play, players were 
easily able to engage with each other’s choices. It 
was evident that game play with peers influenced 
players’ decisions during game play. As a 
researcher, the main challenge was being able to 
facilitate game play as well as document it. Upon 
reflection of design game application, it would 
be beneficial to partner with another researcher 
who focuses on documenting the design game 
outcomes while the main researcher facilitates 
game play. Site choice for game play, in this case, 
was also important. Choosing a venue where 
researchers and participants can engage in clear 
dialogue is crucial, especially when language 
stands as an obstacle. For application by other 
researchers it is valuable to note that the order 

Fig. 2.3.12. Stacked design game application (Naidoo 2019)

Fig. 2.3.13. Stacked design game application (Naidoo 2019)

of game play was fluid enough to adapt to the 
condition on site. In some cases, post discussion, 
alternative questions were raised which were 
easily incorporated into game play.  

3.6.2 Stacked

See Annexure 2.C

Stacked was developed with the intention of 
engaging participants in the spatial construction of 
the educational built environment and to harness 
the potential of the existing site. During game play, 
players made use of model building materials to 
construct their envisioned learning environment 
according to prompts provided by the researcher. 
The challenging element to the design game 
creation was being able to predict the kind of tools 
that would be needed on site. 

Participation from the group was incredibly fruitful 
with participants stimulating and interacting with 
each other through the decision-making process. 
An accumulation of simultaneous action of cutting 
building blocks, allocating space and decision-
making made for successful participation. 

The design game focussed on a spatial outcome 
and was therefore initially challenging to get 
participants to understand the intention of the 
game. Therefore, game play was slow to start, 
however with stimulation from the researcher, 
participants were able to engage and become 
comfortable with decision-making. 
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Fig. 2.3.14. Design GameKit digital presence through website (Naidoo 2020)

From the process of game play, the researcher 
was able to gather information on the quality of 
space learners desired. These spaces were lacking 
within the current context of the school. It was 
also evident of the potential within existing sites 
of the school that was not harnessed within the 
existing use. From the analogue design games 
applied within the dissertation, this was the most 
challenging to get participants to engage with 
in the beginning. This was potentially the case 
due to the design game focussed on spatial 
understanding throughout game play, instead of 
spatial interpretation by the researcher post game 
play. As a design game, should the researcher 
have an extended amount of time to acclimatise 
their participants to the spatial discussion, the 
game has the potential to result in greater co-
design input from participants. 

3.7 Digital Design Games in the Co-
design Process 

Digital design games made up the majority of the 
second year of engagement with the co-design 
process. This was in response to the COVID-19 
pandemic which brought South Africa into a state 
of lockdown. Therefore, physical access to site 
and contact interaction with participants was not 
possible. As a result, a major issue arose regarding 
communication with participants to continue the 
co-design process for the dissertation. Numerous 
attempts to get into contact with learners from 
the school failed. Within this context, access to an 
internet connection as well as appropriate devices 
to maintain digital communication, was a challenge. 
To maintain resilience, we needed to adapt to 
the changing circumstance. Our participant group 
therefore widened to spatial professionals with 
a background in Urban Citizenship and Social 
Inclusion and who were familiar with the context of 
the dissertation. 

Fig. 2.3.15. AutoCorrect game board (Naidoo 2020)

Fig. 2.3.16. Screenshot from AutoCorrect Game Play using TabletopiaTM (Naidoo 2020) 
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Throughout the digital design games user 
personas were developed based on accumulating 
character profiles from the interaction with the 
end user on site. These personas bridged the gap 
created by the lockdown. Access to participants, 
which was once a challenge, turned into an 
opportunity as we were able to interact with local 
and international collaborators within the co-design 
process. It was an interesting shift in mindset 
in the creation and application of digital design 
games. From personal experience, a greater deal 

Fig. 2.3.17. AutoCorrect design game elements (Naidoo 2020)

of preparation needed to be made to ensure that 
the game was structured and working before 
engagement with participants. Due to this, game 
play during application increased in efficiency. 

3.7.1 AutoCorrect

See Annexure 2.D 

Conceptual design games focus on the decision-
making process and conceptual understanding 
of the world in which design decisions are made, 
rather than being confined to specific project 
requirements. Throughout game play, concept 
design games are used to understand players’ 
conceptual thinking process regarding specific 

decisions being made during game play (Habraken 
& Gross 1987). AutoCorrect was developed within 
this spectrum of understanding. The elements 
within the game were not intended to be 
constructed of physical design elements within the 
dissertation. Rather, they represent the conceptual 
framework of the relationship between varied 
influence and resulting action in an educational 
context. 
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AutoCorrect was intended to assist in the 
early stages of the co-design process to assist 
participants in the conceptual understanding of 
the role that different levels of influence have on 
how school typologies are constructed. Initially 
finding a digital medium to host the board game 
was a challenge, however once TabletopiaTM 

was identified, creation through the site was user 
friendly. Creating the game online was a time-
consuming task as all the game pieces needed to 
be developed beforehand and loaded onto the 
platform. However, following the game creation 
process, the game remains digitally accessible 
to participants across the world to engage in the 
research process. 

TabletopiaTM allowed for live game play by all 
participants on a single platform, therefore 
interaction was encouraged between players. 
The process of game play using the site was 
stimulating. Assisting this process with the use of 
Google MeetTM allowed for open dialogue amongst 

Fig. 2.3.18. Persona cards (Naidoo 2020)

participants during game play. A downside to 
the design game application was its internet 
dependency. Participants needed a reliable 
internet connection for game play to flow smoothly 
and to engage in conversation throughout. 
Therefore, with the application to research projects 
where participants do not have access to internet 
or digital devices, the game reflected a shortfall. 

3.7.2 Persona

See Annexure 2.E

The inability to actively engage with learners from 
Tsako Thabo reduced the qualitative concerns of 
the dissertation. User experience and the social 
and psychological quality of the programme 
lacked consideration within the dissertation. The 
intention of the design game was to contribute 
to understanding the user experience in relation 
to the programmatic considerations. Failure to 
successfully establish contact with learners from 

Fig. 2.3.19. Persona design game application (Naidoo 2020)

Tsako Thabo, resulted in the consideration of 
role play. Roleplay is a useful method to engage 
in participation. It can provide a voice for those 
who are not generally heard or considered in the 
design process (Hamdi 2010:74). The digital design 
game, Persona, was intended to understand the 
implications of the programme on user experience 
of the site through role play. Selected participants 
for design game play were chosen from a group 
of students who previously engaged with the 
site and users, and are therefore familiar with the 
context. User personas were created from collating 
collected primary data from interviews on site. 

Throughout game play, players were able to 
place themselves in the position of the user 
profiles to guide their decisions. The game play, 
however, did not lend itself to stimulate discussion 
amongst participants but rather was directional 
between researcher and participant. However 
communication was fruitful throughout game play. 
To document the design game application, the 
use of the recording function on Google MeetTM 

to record the Google SlidesTM was beneficial 
in capturing actions performed by participants 
during game play, as well as the discussion had 
throughout. Physical documentation was achieved 

Fig. 2.3.20. Stakeholder design game (Naidoo 2020)

after each round using the Google SlidesTM. 
The digital platform of Google SlidesTM allowed 
the opportunity to easily duplicate a slide to 
include extra questions that were not considered 
beforehand. Persona was successful in assisting 
the research process. Participants highlighted a 
shortcoming in that the clustered programmatic 
layout resulted in restricted movement throughout 
the site and negatively contributed towards 
creating inactive areas on site.
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Fig. 2.3.21. Stakeholder design game player card (Naidoo 2020)

Fig. 2.3.22. Stakeholder design game play (Naidoo 2020)

3.7.3 Stakeholder

See Annexure 2.F

The intention of the Stakeholder game was to 
collectively involve participants in how we can 
potentially redefine the built environment of 
the classroom. Stakeholder is a role play game 
based on collective democratic decision-making 
(Engagement Lab @ Emerson College 2020). 
Throughout the game, players voice their opinions 
and solutions to issues within the built educational 
environment. Participants provide proposals that 
redefine an alternative learning environment that 
is cognizant of varied learning styles as well as 
the use for community. The game mechanics 
were influenced by @Stake (Engagement Lab 
@ Emerson College 2020). User personas, 
participants’ hidden agendas during game play 
and the questions per round were adapted to 
directly relate to the users within Mamelodi 
East and questions pertaining to redefining the 
classroom. 

Fig. 2.3.23. Interface design game overview (Naidoo 2020)

Throughout game play, the game mechanics 
allowed for a stimulating discussion on the 
question posed per round. Participants were also 
prompted to question and challenge each other’s 
proposals. This lent itself to a fruitful discussion 
and opened up a wider thought process regarding 
the game topic. The structure of play of the game 
was clear enough to be able to use the same game 
mechanics with other themes present in a project. 
The clear structure maximises time and game 
output, therefore when time constraints are an 
issue, this game is particularly useful in achieving a 
great deal within the time-frame. 
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3.7.4 Interface

See Annexure 2.G

A part of the dissertation was repositioning the 
school environment within Mamelodi East as 
publicly accessible. Due to this, there needed to 
be cognizance of the interaction between varying 
degrees of public and private. The game intention 
is to collectively define the articulation of these 
urban edge interfaces that deal with the presented 
conditions. Interface is a design game directed 
towards constructing the urban edge interface 
between a school and its context. During game 
play, participants take on the personas of affected 
stakeholders to guide their decisions. 

Throughout game play, the game mechanics 
allowed for a stimulating discussion. Participants 
were also required to interact with each other 
which allowed for a more fruitful game outcome. 
Time constraint was the biggest challenge. The 
game required in depth thinking from participants 
and interaction between them to guide decisions, 
therefore allowing a lengthier window of time 
would benefit the game outcomes. During game 
play, a round was dedicated for participants to 

Fig. 2.3.24. Interface design game application(Naidoo 2020) 

challenge the variables presented to construct 
their urban interface. Having this round in 
game play widens the scope of the game to 
stimulate creativity from the participant group. 
Therefore, specific qualities that were not decided 
beforehand by the researcher can be introduced 
into the game and incorporated for future 
applications. 

3.8 Discussion and Conclusion

The application of analogue and digital design 
games rendered two varying co-design 
experiences. Participation in the case of analogue 
design games allowed for greater interaction 
amongst participants and researchers. Physically 
interacting with each other during design game 
application was an important part of the co-design 
process and led to a richer experience. In the case 
of digital design games, participation was able to 
occur, but the focus was usually placed on a game 
interface, rather than on visual communication. 
Analogue design games, however, allow this to 
occur simultaneously. Both design game formats 
brought with them their own sets of challenges 
that made it difficult to effectively compare. In 
the case of analogue design games, the main 

challenge was due to the conditions of the context 
and will therefore differ according to varying 
contexts. However, in the case of digital design 
games, the challenges came from the use of online 
tools to host the games as well as the stability of 
an internet connection. The commonality between 
the challenges of the game format, was that in 
both cases, finding a solution to those minor 
issues would lead to much smoother design game 
application. 

In terms of the opportunities provided by the 
formats of the design games, digital design games 
widened the scope for the dissertation. A variety 
of design games could be created with limited 
expense to the researcher, most of the effort that 
went into design game creation was based on 
time, rather than cost. The format also allowed for 
the ability to duplicate digital design games and 
alter them according to varying game intentions. 
Whereas, with analogue design games, the 
physical tools needed on site in most cases were 
not suitable to be reused. An interesting element 
to digital design games was the opportunity it 
presented regarding participation. 

Analogue design games are limited to participants 
whom you have physical access to, however digital 
design games widen the range of access and 
collaborators. This allowed for another dimension 
to the project, to be able to engage with a variety 
of participants familiar with design game thinking 
and co-design processes. 

From personal experience, the challenge 
regarding the application of design games, 
came from managing the process as a single 
researcher. Often, having to mediate the process 
of design game application, as well as focusing 
on documenting the process and outcome was 
challenging. This was a recurring issue within the 
application of analogue design games. It was often 
overwhelming to maintain focus on the participant 
group, as well as ensuring that the information 
uncovered during the application was well 
documented to be able to apply to the project. 

This was not the case with the application of 
digital design games. With the process occurring 
online and the use of the Google MeetTM platform, 
documentation was as simple as recording the 
session using the site. Further documentation also 

occurred using Google SlidesTM. Moves made by 
participants were captured on each slide, which 
provided the option of accumulating those slides 
as an outcome of the design process through the 
design game. 

The two varying formats differed in their 
contribution to the co-design process. In both 
cases, design informants were able to be distilled 
from the design game application to contribute 
to the dissertation outcome. The semi-structured 
nature of analogue design games provided a 
flexible approach that rendered a wider scope of 
information beyond the initial intentions for the 
design game. This was useful during the initial 
exploratory stages of the project. Thereafter once 
the project increased in direction the shift to digital 
design games was appropriate. The structured 
approach of digital design games allowed for 
efficient design game application. It is difficult to 
compare the formats to each other and it does 
not do justice to each to state one as being more 
effective than the other. The richness of the co-
design process was elevated due to the interaction 
with both formats and with future interactions 
could complement each other. 
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urban fabric. At a larger scale, we have the urban 
form imposing on the building. Rocha (2014:187) 
describes this phenomenon as an ‘internal logic’ 
and an ‘external logic’. Internal logic referring to 
the internal conditions and constraints of a building 
that guide its typological response in the condition 
of ‘form follows function’. Whereas, external logic 
references the constraints experienced by a 

4.1 Design Concept

The overall design concept is to move beyond 
isolating the educational experience. It is intended 
for this to be achieved through publicly redefining 
the schooling environment as a “collective urban 
entity” (Heitor & Alegre 2012) and societal support 
structure (Global Education Futures 2018). In 
this light, the design concept strives to create a 
societal structure that integrates the educational 
environment with its context.

Space is understood through a social lens as 
the culmination of a series of interrelationships 
(Wood 2019:5). Redefinition will therefore be done 
through investigation into the relationship between 
space, pedagogy and threshold to encourage 
the qualitative social activities of learning through 
establishing a community school relationship with 
the tangible (spatial) educational environment. 

Within architecture we are constantly battling 
scalar interactions. On a building level we have the 
scale fighting from within and outward onto the 

04
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Fig. 2.4.1. Relationship matrix (Cleveland & Fisher 2013.11)

building due to a scalar condition larger than itself. 
The dissertation responds to ‘internal logic’ 
through the theme of building for pedagogy and 
‘external logic’ through the theme of building as a 
public threshold. 

The dissertation narrows down the analysis 
of space to two concepts. Space in relation to 
threshold and space in relation to pedagogy. 
An adaptation of Cleveland & FIsher (2013:11) 
relationship diagram has been used to guide the 
design process of the dissertation. This diagram 
assisted in understanding the intimacies of the 
relationship amongst the three themes. The 
relationship between space and pedagogy is 
intended to achieve a learning environment that 
challenges traditional approaches by allowing 

for the qualitative social activities of learning. 
Meanwhile the space and threshold relationship is 
directed towards stimulating a community school 
relationship. This relationship is intended to widen 
the interaction between learners and community 
members allowing for a mutually stimulating 
learning environment. 

Fig. 2.4.2. Design concept relationship matrix (Naidoo 2020)
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Fig. 2.4.3. Design concept relationship matrix (Naidoo 2020) 

Fig. 2.4.4. Design process overview (Naidoo 2020)
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4.2 Urban Vision

Before building schools and jumping to the how, 
we must first ask the question of why we are 
building schools. The building of schools across 
the world has pushed the limitations of education 
by using the building of schools as an instrument 
for greater change (Wood 2019:9). School context 
and the social interaction within that context play a 
heavily weighted role in promoting or inhibiting a 
culture of learning within the school environment. 
This is particularly true within the South African 
context, where a study found that social context 
impacts a school’s culture of learning (Weeks 
2012:4). Schools that succeeded in their social 
context were able to establish a sense of pride in 
their school (Weeks 2012:4). 

“Ecosystems are defined by the network of 
interactions among organisms, and between 
organisms and their environment” (Mueller & 
Toutain 2015: 6).

Tsako Thabo Secondary School, along with 
multiple other government schools with a shared 
typology, in Mamelodi East, sit as broken links 
within that ecosystem. An overview of contextual 
mapping done in the area, highlights the evident 
lack of community support structures and the 
large number of educational facilities. However, 
there is a missed opportunity in that these 
educational facilities are mostly isolated from the 
community. The infrastructure and facilities of 
these educational environments could serve as 
community support structures, instead of remaining 
dormant when the school is not active. 

“This is the best time for us to be thinking 
creatively. We can’t go back to thinking those 
old models are going to serve us in the same 
way.” (Campbell 2020)

The home environment for many of the students, 
are unsuited to home schooling and the 
increased capacity. We must rethink the role of 
the educational environment within its context 
(Campbell 2020) to prevent the disruption of 
education to learners and communities within 
economically distressed contexts. 

Fig. 2.4.5. Shared typology schools in Mamelodi East (Naidoo 2020)
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The urban proposal is to redefine the traditional 
teacher-centric classroom and corridor typology 
schools, within Mamelodi East, as nodes for 
lifelong learning. Schools that succeeded in their 
social context were able to establish a sense of 
pride in the school (Weeks 2012:4). Approaching 
schools as a node for lifelong learning has the 
potential to radiate a culture of learning into the 
context to establish lifelong learning as a network 
and element that ties communities together. 

It is suggested that there is a direct link between 
the structure of society, quality of life and quality 
of education (Woods 1969). There is a thought 
process that sees school as urban context and 
urban context as school. Instead of schools serving 
as destinations within the urban context, they are 
decentralised and integrated into the urban fabric. 
Urban context and school tie into one another and 
each reinforce the structure of the other. Isolating 
education from its context, causes it to lose its 
relevance in society. School is repositioned as 
something that is accessible to everyone, much 
like the streets of the city that are accessible to the 
public (Woods 1969). 

It is an interesting notion to think of the school as 
something that belongs to society. In the same 
way that economic activity, in Mamelodi East, 
sprawls out and takes ownership of the streets, the 
school environment can redefine itself to do the 
same and tie itself into its context. The school then 
becomes essential to the character and quality of 
that urban environment. Belonging is not limited to 
the thin layer of location. It is rather multi-faceted 
and constructed from meaning and association 
of place. Multiple layers of opportunities for 
engagement and exchange with one another 
contributes to the sense of belonging (Hamdi 
2010:32). Fig. 2.4.6. Urban vision (Naidoo 2020)
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The approach supports Herbraken’s theory of 
creating ‘support structures’ instead of buildings 
(Hamdi 2010). These support structures/systems 
have adaptable potential allowing “liberating 
range of choice”. However, this range exists within 
limitations that are set by the affected parties 
involved. This approach supports the design 
intention of a school that starts to inform an urban 
grain to tie community and school together. 

The built form is therefore not a building but rather 
a support structure that is descriptive in certain 
areas and non-descriptive in others. Positioning 
schools as societal support structures provides 
the Government with direction on the approach 
they should have to public school infrastructure. 
By providing base infrastructure and allowing 
communities, alongside the school, to grow and 
develop the educational environment it starts to 
create elements of a robust community through 
creating a sense of ownership and responsibility of 
the school environment. (Hamdi 2010). Fig. 2.6.7 Urban Vision (Naidoo 2020)
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Fig. 2.6.8. Urban Vision (Naidoo 2020)



235Volume Two  |  Design Development234 235

Fig. 2.6.9. Urban Vision (Naidoo 2020)
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4.3 User and Programme

4.2.1 User

The programme is directed towards the core user 
being the High School learner and staff member. 
The secondary user is based on the Mamelodi East 
community member, with a specific focus on the 
unemployed. This is to address the unemployment 
margin within the country that is as a result of 
traditional static knowledge transfer (Weeks 
2012:1). 

Fig. 2.4.10. User groups (Naidoo 2020)

4.2.2 Programme intention

The programme supports the non-spatial 
conversation about promoting a community-school 
relationship. The intention is to reposition the role 
of public schools, in Mamelodi East, as a support 
structure for lifelong learning. Repositioning these 
schools in this context is intended to support 
the notion of a school as a node for societal 
transformation (Global Education Futures 2018:7). 

On a contextual level the programme responds 
to the severe lack of community support facilities, 
the high unemployment rate and the high 
concentration of educational facilities in Mamelodi 
East (as reflected in 2.4 Educational Context). 
Redefining the role of a school within this context 
contributes to the need for community support 
structures. 

4.2.3 Programme Structure

Programme structure can be classified according 
to primary, secondary and tertiary elements. The 
relationship between these programmes are 
addressed through a layered approach that speaks 
back to the urban vision (see 4.2 Urban Vision).

The layered approach deals with degrees 
of interaction between elements within the 
educational ecosystem and this way provides 
a structure to guide the spatial response to the 
programme. 

The outermost layer interacts on an urban level 
and responds to the urban vision proposal with 
programmatic elements that branch off from the 
core school. These elements tie the school into 
its context and start informing the urban grain. 

Fig. 2.4.11. Programmatic structure (Naidoo 2020)

Fig. 2.4.12. Programme interaction (Naidoo 2020)



239Volume Two  |  Design Development238 239

The middle layer is about introducing a wider 
learning dynamic through the social interaction 
between community member and learner. This 
layer opens up the school to the public to have 
access to education and resources. The focus here 
is on community education and learner alternative 
education, to challenge static knowledge transfer 
from traditional educational methods (Weeks 
2012:1). The innermost layer is reserved for the 
core functioning of the school and limits interaction 
between community and school. The focus here is 
on learner education. 

Fig. 2.4.13. Programme considerations (Naidoo 2020)
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Fig. 2.4.14. Programme choice informants (Naidoo 2020)

Data collection date: 
2019-2020

Data collection time: 
10h30-11h45

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2019 & 
Naidoo 2020

Participant/s:
Tsako Thabo Learners

Location:
Tsako Thabo Secondary School
& Online

Collection method: 
PAR and co-design

RESEARCH & FINDINGS

4.2.4 Programmatic Informants

Using Participatory Action Research and co-design 
games (see chapter 3 for detailed investigation), 
the programmatic choice and layout has been 
developed. These methods have assisted the 
dissertation in gaining further insight into the role 
of specific programmes in the school, areas that 
the school lacks in as well as the relationship of 
programmes to each other. 

4.2.4.1 Programme choice
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Fig. 2.4.15. Programme layout informants (Naidoo 2020)

Data collection date: 
2019-2020

Data collection time: 
10h30-11h45

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2019 & 
Naidoo 2020

Participant/s:
Tsako Thabo Learners

Location:
Tsako Thabo Secondary School
& Online

Collection method: 
PAR and co-design

RESEARCH & FINDINGS

4.2.4.1 Programme layout
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4.2.5 Programmatic requirements 

The basic programmatic requirements are based 
on the outline provided by the Department of 
Education (2012:  14-18 Annexure A-E) for optimal 
school functioning according to the learner 
capacity of 600 students. 

Fig. 2.4.16. Current programme allocation at Tsako Thabo according to policy requirements (Naidoo 2020) Fig. 2.4.17. Policy Programme Requirements (Department of Basic Education 2012)
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4.4 Building as Public Threshold

4.4.1 Background

4.4.1.1 The meaning of edge: Threshold and 
transition

“For the architect, the spaces or gaps between 
ground, walls and ceiling is not nothingness, 
quite the contrary: the very reason for his 
activity is to create the hollow in order to 
contain. He will give it a concrete form to 
offer that hospitality and relative freedom of 
movement which people require” (Von Meiss 
1990:101). 

According to Gehl (2014:75), the edge refers to 
the interaction between building and city and has 
the power to influence the experience of that city. 
In the case of public schools within Mamelodi 
East, a harsh boundary has been established as 
a result of policy dictating a strict edge condition 
consisting of a 1.8m high fence surrounding the 
site (Department of Basic Education 2012). How the 
edge is dealt with is vital to the resultant effect felt 
by the interactor. Gehl (2014:76) breaks down the 
average walking pace of a person and concludes 
that humans need stimulation every 5 to 6 meters 
to maintain interest. However, in the case of flat 
vertical elements such as monotonous fencing, the 

experience lacks enticement to interact with the 
architecture (Gehl 2014:76). Rethinking boundary 
as threshold space allows for a connection to 
be established between previously detached 
entities (Boettger 2014:10). Threshold allows for 
the opportunity to “interrupt spatial boundaries” 
and creates a connection between those entities 
(Boettger 2014:10).

4.4.1.2 Boundaries within the South African 
context 

Boundaries within a Western and African context 
differ significantly. In a westernised context, 
physical boundaries are used to demarcate 
space. In this scenario, this mechanism is used 
to distinguish ownership over private space. This 
varies when analysing the African context, where 
most of the space is classified as public and only 
under specific conditions will a space be defined 
as private (Rensburg & Costa 2008:32). Within 
the South African context, particularly under the 
Apartheid regime, boundary was used to display 
authority and is therefore experienced in a 
negative light (Rensburg & Costa 2008). Therefore, 
when addressing this within Mamelodi East we 
have to be cognizant of these conditions. 

4.4.1.4 Parameters for Analysis

Boettger (2014:25) pays homage to historical 
precedents from the Acropolis to the Pantheon 
and the lessons these built structures provide in 
furthering our understanding of threshold and 
transition mechanisms. As a result of the author’s 
detailed investigation of multiple historical 
precedents, it can be understood that the spatial 
configuration and interaction between architectural 
elements, such as the vertical and horizontal 
planes, contribute to the experience of threshold 
and transition. 

Fig. 2.4.18. Gehl (2013) principles for public space design (Naidoo 2020)

Fig. 2.4.19. Threshold parameters (Naidoo 2020)

The dissertation adopts Boettger (2014:57) 
following parameters for threshold analysis to 
structure the development of design principles 
that deal with building as a public threshold, to 
encourage a connection between community and 
school:

•	 Spatial delimitation - edges and boundaries 
that encourage or prevent movement 

•	 Spatial sequence - transition and movement
•	 Spatial geometry - organization of the threshold 

in relation to the rest of the architecture
•	 Spatial topography - positioning of architecture 

on the site
•	 Spatial materiality - Independence of threshold 

to the rest of the architecture
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4.4.3 Analysis of the Existing

4.4.2 Considerations: Hierarchy of decision-
making

Due to the focus and acknowledging that the 
proposal is to publicly redefine a schooling 
environment, the dissertation is cognizant of the 
factors that the architecture needs to address 
when allowing for interaction between the public 
and private realm. These factors have been 
collated into the following points to guide the 
design decision-making process:

•	 Vulnerabilities - Safety and security
•	 Mediation - Access and control
•	 User groups - Interaction with motor, 

pedestrian, learner/staff, community member
•	 Energy flux - inactive and active hours
•	 Opportunity - Incremental growth as a node 

and interaction 

Fig. 2.4.20. Threshold considerations (Naidoo 2020)

Fig. 2.4.21. Spatial delimitation analysis of Tsako Thabo 
(Naidoo 2020)

Fig. 2.4.22. Spatial delimitation analysis of Tsako Thabo (Naidoo 2020)

Spatial delimitation of 
school
•	 Site bound by hard 

edge to public
•	 Inactive boundary
•	 Controlled access

Fig. 2.4.23. Current boundary condition at Tsako Thabo (Naidoo 2020)
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Spatial delimitation of economic edge
•	 Activated edge condition onto public
•	 Layering of activity as threshold between 

public and private

Fig. 2.4.24. Typical economic edge condition in Mamelodi East (Naidoo 2020)

Fig. 2.4.25. Typical economic edge condition in Mamelodi East (Naidoo 2019)

Spatial sequence
•	 Minimal progression and transition
•	 Drastic shift from public to private
•	 Lacks spatial differentiation

Fig. 2.4.26. Spatial sequence analysis of Tsako Thabo (Naidoo 
2020)

Fig. 2.4.28. Spatial sequence analysis of Tsako Thabo (Naidoo 2020)

Fig. 2.4.27. Spatial sequence analysis of Tsako Thabo (Naidoo 2020)
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Spatial geometry 
•	 Uniform geometric condition
•	 Lacks threshold opportunity 

Fig. 2.4.29. Spatial geometry analysis of Tsako Thabo (Naidoo 2020)

Fig. 2.4.30. Spatial geometry analysis of Tsako Thabo (Naidoo 2020)

Spatial topography 
•	 Limited engagement with site boundary 

Spatial materiality 
•	 Uniform material condition 

Fig. 2.4.32. Spatial topography analysis of Tsako Thabo (Naidoo 2020)

Fig. 2.4.31. Spatial topography analysis of Tsako Thabo 
(Naidoo 2020)

Fig. 2.4.33. Spatial materiality analysis of Tsako Thabo (Naidoo 
2020)
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4.4.4 Precedent

Curtin University Midland Campus Temple of Karnak Usazazo Hermanus Community Day Centre

•	 Type: Educational facility
•	 Architect: Lyons, Silver Thomas Hanley
•	 Location: Midland, Australia 
•	 Year: 2019

•	 Type: Temple
•	 Location: Karnak, Egypt

•	 Type: Secondary school 
•	 Architect: Wolff architects & Jo Noero
•	 Location: Khayelitsha, Cape Town, South Africa

•	 Type: Community centre
•	 Architect: Gallagher Lourens architects
•	 Location: Hermanus, Cape Town, South Africa
•	 Year: 2015
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•	 Top image: Service space (b) serves as thresh-
old to the rest of the architecture (a) and frames 
the threshold entrance (c). The framing creates 
an external zone (d)

•	 Bottom image: The core building/served space 
(a) is layered with a boundary of serve spaces 
(b) and circulation (e). The break in this bound-
ary allows for entry (c) into the lobby of the 
building (d). Lobby sits unbuffered to the public

•	 Impenetrable boundary on periphery 
•	 Break in boundary at threshold 

•	 The classrooms (a) of the school serve as boundary 
to the site, with openings onto the street edge )b) to 
encourage interaction 

•	 Building (c) forms a hard edge with the site and 
frames the forecourt (a) to establish point of arrival

•	 Break in buildings (c) forms the threshold (b) into the 
site
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•	 The permeability of the lobby (a) allows for 
movement through

•	 Space progressively reduces as you transition 
from public to private. 

•	 Buildings hold internal space along a transition route
•	 Path narrows and widens to control movement and 

pause

•	 Main spine used with the progression of public 
waiting areas. Waiting areas reduce in size as you 
transition from public to private
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Curtin University Midland Campus Temple of Karnak Usazazo Hermanus Community Day Centre
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•	 Threshold (a) cuts away at the massing b) to 
form entry/arrival zone 

•	 Geometry cascades down and reduces in size as 
you transition from public to private

•	 Threshold entrance has hierarchical presence 

•	 Break in geometry distinguishes threshold into the 
site

•	 Entrance overhang lowers at public level for inti-
mate arrival 
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•	 Entrance to building sits in close relation to site 
boundary

•	 Positioning of buildings (b) on site establishes 
intimate connection with street (a), allowing for 
building to form the edge

•	 Building entrance positioned in close relation to the 
site edge and provides frontage onto the street
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•	 Brickwork facade (a) punctured with exposure 
of concrete elements (b) at the threshold (c)

•	 Paving (d) differentiated in pattern and colour at 
the threshold

•	 Thickening of material at threshold allows for a 
deeper opening

•	 Break in material massing highlights entrance 
threshold

•	 Breaks in the facade that interact with the street are 
articulated with an overhang and change in surface 
finish of the brickwork 

•	 Visually permeable material at threshold allows for 
visual access i



259Volume Two  |  Design Development258 259

Taxi Rank No. 2 Kuyasa Transport Interchange Liv Village Kuyasa Library

•	 Type: Taxi rank
•	 Architect: 26’10 South architects
•	 Location: Diepsloot, South Africa

•	 Type: Transport interchange
•	 Architect: Meyer and Vorster Architects
•	 Location:  Khayelitsha, Cape Town, South Africa 

•	 Type: Mixed use 
•	 Architect: Design WorkshopSA
•	 Location: Cottonlands, Kwa-Zulu Natal, South Africa
•	 Year: 2015

•	 Type:  Public library
•	 Architect: CCNI 
•	 Location: Khayelitsha, Cape Town, South Africa
•	 Year: 2013-2016
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•	 Building sits on edge of site to interact with 
street

•	 Stairs front the public facade further stimulating 
interaction 

•	 Building publicly accessible 
•	 Spatial differentiation achieved through level 

change

•	 Walkways used as threshold mechanism to buffer 
individual space

•	 Level change establishes spatial differentiation

•	 Direct access to entrance is prevented through 
greater difference in level change. Longitudinal 
access is encouraged by making the arms of the 
massing accessible
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•	 Layered approach to the public
•	 Landing (a) is fronted by stairs (b) which 

transitions towards intimate seating bays (c) and 
into the building (d) 

•	 Arrival plaza (a) captures public 
•	 Movement stimulated through narrowing of 

pathway. Economic activity (b) takes advantage 
of this opportunity by fronting the movement 
route

•	 Series of courtyards hold space and allow for pause 
before entrance into individual buildings

•	 Movement is directed through angles in wall
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Taxi Rank No. 2 Kuyasa Transport Interchange Liv Village Kuyasa Library
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•	 Top image: break in massing where roof 
exposes itself to form threshold space on 
public edge. Allows for opportunity for public to 
engage with the building

•	 Bottom image: building lifts off street level 
to form threshold between public and 
private. Change in level contributes to public 
engagement and serves as active threshold

•	 Height difference used as mechanism to 
distinguish space and establish layers of 
threshold. Roof lowers over trading platform and 
heightens over public pathway 

•	 Public space (a) serves a hierarchical role through the 
massing in comparison to private space (b)

•	 The roofs of the adjacent masses slope down 
towards the entrance to reduce the volume.
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•	 Building on edge of public site boundary along 
arterial movement route to stimulate interaction

•	 Buildings capture public with a plaza (b) by 
setting back from the site boundary (a)

•	 Public activity (a) sits in close relation to site 
boundary (c) with private space (b) buffered by 
natural elements (d)

•	 Buildings hold site on the public edge and create 
framed landing space before arrival at the threshold
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•	 Material changes to robust concrete where 
public interacts with the architecture 

•	 Floor finish variation between trading platform 
(b) and public footpath (c)

•	 Pathways make use of varied floor finish and create a 
spatial break

•	 The two main masses remain solid with access into 
the building more translucent. Material variation 
when the building is permeable

Fig. 2.4.34. Precedent study table conducted according to Boettger (2014:57) parameters for threshold analysis (Naidoo 2020)
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4.4.5 Design Informants 

Data collection date: 
2020

Data collection time: 
10h30-11h45

Researcher/s:
Naidoo 2020

Participant/s:
Social Inclusion Studio 
Lecturers from Chalmers 
University of Technology, 
Sweden

Location:
Online

Collection method: 
Co-design digital design game: 
Interface (See Chapter 3 & 
Appendix 2G)

RESEARCH & FINDINGS

The Interface digital design game resulted in a series of co-designed responses to how to deal with the 
edge condition. This response considered the interaction between a school and its community within 
the context of Mamelodi East. Each consideration was based off addressing degrees of privacy and 
activating the edge condition. 

Fig. 2.4.35. Results of the interface Design game for methods of addressing varying edge conditions
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Data collection date: 
2019

Data collection time: 
10h30-11h45

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2019 - Achi & 
Venter

Participant/s:
Tsako Thabo Learners

Location:
Tsako Thabo Secondary School

Collection method: 
Participatory Action Research 
workshop: Learners design 
their ideal school

RESEARCH & FINDINGS

Fig. 2.4.36. PAR workshop informants on mechanisms to deal with edge  (Adapted from UP Arch Hons Mamelodi Group 2019 - Achi & Venter)
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4.4.6 Exploration 

Fig. 2.4.37 Building as public threshold design exploration (Naidoo 2020)
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Fig. 2.4.38. Building as public threshold design exploration (Naidoo 2020)
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4.5 Building for Pedagogy: Redefining 
the Teacher-centric Classroom and 
Corridor Typology 

4.5.1 Background

Due to the dissertation focusing on a typological 
study of the schooling environment, parameters 
needed to be established to guide the analysis 
and design process for typological redefinition. 
The following parameters have been selected 
based on a literature overview (Barret et al 2015, 
Candiotes 1997, Dovey & Fisher 2014, Hertzberger 
2008, Kuhn 2012 & Wood 2019) of the common 
themes arising when schooling typology is brought 
into question. These parameters are:

•	 Plan Type 
•	 Circulation
•	 Spatial Configuration

In this investigation, the dissertation positions 
these parameters according to architectural 
responses that challenge the conventional 
educational environment. The learning 
environment should stimulate holistic learner 
growth through providing opportunities to acquire 
life skills (Dudek 2015) and social learning through 
interaction (Kuhn 2012). 
“Higher functions of learning originate as social 
relationships” (Dovey & Fisher 2014:45). The school 
environment is seen as a support structure to the 
greater learning experiences from life. Students 
can build on what they know in terms of the “social 
construction of knowledge” (Dovey & Fisher 
2014:43). 

4.5.1.1 Plan Type

There are three main plan types when it comes to 
secondary schooling typologies: 

•	 Street plan 
•	 Campus plan 
•	 Linked pavilions

The street plan is distinguished by its linear 
volumes that are guided by circulation, which 
makes a metaphor of the street condition. 
This circulation space serves dual function 
and becomes social space within the school. 

The campus plan type is made up of individual 
buildings on open land with external circulation. 
These buildings relate to one another however 
they can be set apart through their purpose 
dictating their architectural expression. The third 
plan type is a hybrid of the first two and consists of 
a series of linked spaces bordering a central core 
(Dudek 2015). 

Fig. 2.4.39. Street Plan Type (Naidoo 2020)

Fig. 2.4.40. Campus Plan Type (Naidoo 2020)

Fig. 2.4.41. Linked pavilion Plan Type (Naidoo 2020)

Tsako Thabo Secondary school, along with 
multiple other schools in Mamelodi east reflect the 
first plan type of the street plan. 

Within this plan type, these schools in Mamelodi 
east reflect basic classroom layouts according to 
policy stipulations dictating a uniform classroom 
unit (Department of Basic Education 2012). This 
has been the inherited plan type for public schools 
in South Africa (see 2.2.2 Relationship between 
Policy and the Built Educational Environment 
in South Africa).  Hertzberger (2008) criticises 
this basic classroom. An articulated classroom 
decentralises the traditional education experience 
and provides multiple learning opportunities 
conducive to varied learning styles (Hertzberger 
2008:25). 

Fig. 2.4.42. Basic classroom plan (Naidoo 2020) Fig. 2.4.43. Articulated classroom plan (Naidoo 2020)

Varied articulation of learning spaces allows for a 
range of individual to group activities (Hertzberger 
2008). Barret et al (2015) acknowledges this 
allowance for individualisation through flexibility 
as a key variable of the physical educational 
environment that enhances the learning 
experience. Flexibility can be achieved by using 
movable partitions and variations in classroom 
sizes (Kuhn 2012). Varied plan shapes are 
suggested for younger learners and larger simpler 
plan shapes for older learners (Barret et al 2015). 
In summary, plan type should accommodate 
differentiations in learning style through variations 
in room size, classroom articulation and flexibility 
of plan.  
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4.5.1.2 Circulation

Dovey & Fisher (2014:43) and Hertzberger (2008) 
draw our attention to the approach to educational 
circulation as the ‘learning street’.  Informal and 
formal learning environments are starting to be 
recognised as integral in the holistic learning 
development of a child. This approach challenges 
the traditional, standard application of circulation 
as mono-functional external space with little 
contribution to the learning experience (Kuhn 
2012). The ‘learning street’ redefines corridors for 
interaction and provides multiple opportunities to 
learn in a variety of ways. 

This space is intended to prevent distraction by 
others but be visible to encourage learning interest 
from others. Movement through this space should 
create curiosity within the passer by. This concept 
of circulation sits as the primary artery where the 
main elements are concentrated, allowing for 
passive surveillance of the school and learners to 
feel included (Hertzberger 2008). 

4.5.1.3 Spatial Configuration 

The learning environment is suggested to 
represent that of a micro city with multiple 
opportunities for learning (Hertzberger 2008:69). 
This approach offers a stimulating learning 
environment that encourages interaction as well 
as cultural, political and intellectual exchange 
(Hertzberger 2008). Break out space, specialised 
learning environments, multi-functional space 
that supports the community and the relationship 
between the interior and exterior become key 
factors in understanding the spatial configuration 
of schooling typologies (Dudek 2015). Easy 
access to attached breakout spaces, well defined 
learning zones and wider corridors are some of 
the main physical elements that affect the learning 
experience (Barret et al 2015). 

Emphasis is placed on social space to draw a 
parallel to the public space of the city (Hertzberger 
2008). This social space forms part of the core 
of the school and serves as ‘an informal meeting 
place and a melting pot’ (Kuhn 2012). Kuhn 
(2012) speaks to the spatial configuration of the 
learning environment and suggests the relevance 
of hierarchy by allowing for an intermediate 

learning space between the ‘classroom’ and 
school. Overall, these strategies for handling the 
spatial configuration of the learning landscape 
allow learners to fluidly obtain varying avenues of 
knowledge (Kuhn 2012). 

4.5.2 Considerations

•	 Opportunities of the current typology in relation 
to context

•	 Limitations of the current typology in relation to 
context

•	 Relationship of the current typology and 
programme 

4.5.3 Analysis of the Existing 

Fig. 2.4.44. General analysis of Tsako Thabo (Naidoo 2020)
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Fig. 2.4.45.  Plan type analysis of Tsako Thabo (Naidoo 2020) Fig. 2.4.46.  Plan type analysis of Tsako Thabo (Naidoo 2020)
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Fig. 2.4.47.  Spatial configuration analysis of Tsako Thabo (Naidoo 2020) Fig. 2.4.48.  Spatial configuration analysis of Tsako Thabo (Naidoo 2020)
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Fig. 2.4.49.  Circulation analysis of Tsako Thabo (Naidoo 2020) Fig. 2.4.50.  Form analysis of Tsako Thabo (Naidoo 2020)
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Precedent Selection

1. Christ Church Grammar School 2. Rafaello Primary School 3. School in Gando 

•	 Type: Preparatory school
•	 Architect: Architecture Studio
•	 Location: Perth, Australia

•	 Type: Primary school
•	 Architect: Herman Hertzberger
•	 Location: Rome, Italy

•	 Type: School
•	 Architect: Diébédo Francis Kéré
•	 Location: Gando, Burkino Faso
•	 Year: 2012

(Archello 2020) (AHH 2020) (Archdaily 2020)

4. Swawou Girls School 5. Chere Botha School 6. Meeste-a-Bophele

•	 Type: School
•	 Architect: Orkid Studio
•	 Location: Kenema, Sierre Leone
•	 Year: 2016

•	 Type: School
•	 Architect: Wolff Architects & Jo Noero 
•	 Location: Western Cape, South Africa

•	 Type: School
•	 Architect: Humphries Jooste
•	 Location: Mamelodi, City of Tshwane, South Africa

(Archdaily 2020) (Wolff Architects 2020) (Constructalia 2020)

4.5.4 Precedent 

Fig. 2.4.51. Table of precedents (Naidoo 2020)
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Precedent Analysis

Plan Type Spatial Configuration Circulation

0
1

•	 Precedent 1: Allows for zone 1 and zone 2 to function independent-
ly with variation of layout A or B. Alternatively the partition can be 
opened to connect zone 1 and 2 for an alternative layout

•	 Precedent 4: Staggering of the classroom blocks (1) frame external 
spaces (2), creating new zones for learning outside the classroom

•	 Precedent 1: Pause space of circulation in relation to entrances of 
classrooms form zone 1

0
2

•	 Precedent 1: Zone 1 and 2 function independently, however a shared 
programme can interlink and occupy the plan layout

•	 Precedent 5: Spatial configuration promotes interaction and communal 
space. Communal space (2) establishes a hierarchy within the school 
and serves as the connector space between the adjacent classrooms

•	 Precedent 1: Circulation widens to form landing to create a central hub 
(1). This creates a new spatial dynamic of external space within the 
school
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Precedent Analysis

Plan Type Spatial Configuration Circulation

0
3

•	 Precedent 1 •	 Precedent 6: Spatial configuration makes use of linear forms spiraled 
around a central core of the school (1). The angle of the classroom 
blocks (3) form private courtyards (2) which can be utilised by specific 
user groups. General shared space is maintained (4)

•	 Precedent 1: Circulation widens at entrances into classrooms for form 
internal space 1

0
4

•	 Precedent 3 •	 Precedent 2: Central axis with adjacent blocks forming framed internal 
courtyards

•	 Precedent 2: Circulation absorbs the arm of the built form (classrooms) 
to form landing space which serves as shared, communal space

0
5

•	 Precedent 4: Zone 1 and 3 form the main spaces with zone 2 serving 
as the communal connector space. The wide access points between 
the zones allow for the spaces to open up and form a single larger 
space

•	 Precedent 2: Configurations of classrooms (2) create external court-
yards (1) in relation to widening of the circulation (3) to form landing 
space (4) 

Fig. 2.4.52. Precedent analysis table (Naidoo 2020)
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Data collection date: 
2019-2020

Data collection time: 
10h30-11h45

Researcher/s:
UP Architecture Honours 
Mamelodi Group 2019 & 
Naidoo 2020

Participant/s:
Tsako Thabo Learners

Location:
Tsako Thabo Secondary School
& Online

Collection method: 
PAR workshops and co-design 
(see chapter 3)

RESEARCH & FINDINGS

4.5.5 Design Informants 

Fig. 2.4.53. Participatory action research workshops (Achi 
2019) Fig. 2.4.54. Building as pedagogy informants (Naidoo 2020)
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Design Iteration 1

•	 Exploring adaptable learning 
configurations

•	 Softening school public edge
•	 Interactive edge condition 
•	 Merging of classroom blocks to allow 

for multi-functional space
•	 Public presence

Fig. 2.4.55. Design Iteration 1 (Naidoo 2020)

4.6 Design Development 
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Design Iteration 2

•	 Considering role of circulation as 
learning opportunity

•	 Opportunities for learning outside the 
classroom 

•	 Spatial configuration allowing 
for variation of external learning 
courtyards

•	 Connection between external and 
internal space

Fig. 2.4.56. Design Iteration 2 (Naidoo 2020)
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Design Iteration 3

•	 Reconsidering the impact of additions 
to the school

•	 New form to interact with the edge 
and activate the public street 
condition

•	 New form to connect onto existing 
school as linkages

•	 Linkages tie school and context and 
serve as threshold into school

Fig. 2.4.57. Design Iteration 3 (Naidoo 2020)
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Design Iteration 4

•	 Pulling programme towards the street 
edge 

•	 Layering of threshold through built 
form and programme

•	 Variation in roof to speak back to 
programme use

Fig. 2.4.58. Design Iteration 4 (Naidoo 2020)
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Design Iteration 5

•	 New form frames existing school
•	 New form extends to form layered 

threshold 
•	 Interaction with public
•	 Established public presence

Fig. 2.4.59. Design Iteration 5 (Naidoo 2020)
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Design Iteration 5

•	 Circulation plays a hierarchical role
•	 Entrance threshold established 

through flat roof structure
•	 Articulation of roof structure 

Fig. 2.4.60. Design Iteration 5 (Naidoo 2020)
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5.1 Technical Concept

There are multiple influences on the language of 
architecture. Architecture maintains a dialogue 
between functional and technological limitations. 
However, the relationship it has with construction 
takes on a symbolic and interwoven nature. 
This is not to say that this relationship is void 
of the concerns of external factors determining 
architectural language. It is the symbolic nature 
of the dialogue between construction and 
architecture that intensifies the meaning behind 
the built form (Rocha 2014:138).

The technical concept of the dissertation looks 
at the symbolic nature between construction 
(connection, materiality and structure) and 
architecture to develop an architectural language 
that reflects pedagogy (adaptable and multi-
functional) and threshold (Robust, interactive and 
reflecting transition). 

5.2 Construction: Structural 
Hierarchy and Materiality

5.2.1. Materiality

To reinforce the technical concept, the structural 
and material approach was used to reflect this 
interaction between public and private. Robust 
elements of concrete and brick engage with the 
public and establish the school as a community 
facility. These heavier elements sit on the edge 
of the site to thicken the threshold condition. The 
lightweight internal elements, such as the steel 
roof structure, interact with the learning spaces. 

Concrete, brickwork and steel have been the 
selected material palette that speaks to the current 
condition on site. The approach to materiality was 
to explore the potential of this simple material 
palette through the configuration of the building 
elements. 

05
TECHNICAL 
DEVELOPMENT

Configurations of brickwork consider the public 
interaction with the architecture. This approach 
aligns with the conceptual intentions of the 
relationship between construction and threshold. 
Surface finish, such as the brick patterns, concrete 
and breaks in finish articulate threshold and 
transition. 

Fig 2.5.1.1. Technical concept diagram (Naidoo 2020)
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Fig. 2.5.2.1. Existing material palette (UP Arch Hons Mamelodi Group 2019)
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Fig. 2.5.2.2. Proposed material palette (Archdaily 2020 & Architizer 2020)

Extruded brick bonds serve as a mechanism 
for preventing physical interaction with the 
architecture by resulting in uncomfortable surfaces. 
Perforated brick opens up the architecture to the 
exterior articulating light and public interaction. 
This provides a softer approach by opening the 
building up to the public but maintains privacy. 
Simpler brick bonds are used within the facade 
when attention is placed on other elements in the 
architecture, such as the structural system. Overall 
the construction of material is used to strengthen 
the architectural language. 
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5.2.2.Structure

5.2.2.1 Structural hierarchy

New intervention onto the site adopts a 
hierarchical approach to the structure. The primary 
structure consists of a concrete column and grid 
system based on the current modular unit of 
3750x4500mm, present within the school. Brick 
infill and concrete slabs make up the secondary 
structure of the building.  The tectonic use of a 
lightweight steel roof sits within this structural 
composition and forms part of the tertiary structure. 

Overall the structure is an interaction between 
the stereotomic elements of concrete and brick 
with the tectonic use of lightweight steel, to reflect 
the interaction between public and private. The 
primary concrete column structure with brick infill 
holds a robust edge whilst protecting the delicate 
steel roof structure within.  

Fig. 2.5.2.3. Structural timeline (Naidoo 2020)

Fig. 2.5.2.4. Interaction between tectonic and stereotomic elements (Naidoo 2020)
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5.2.2.2. Primary structure in relation to the 
architectural approach 

Three approaches were adopted to dealing with 
the interaction between primary and secondary 
structural elements. These approaches were 
intended to assist the architectural language 
developed within the project. The primary structure 
of the concrete column module is expressed in 
the architecture within the private space of the 
building. The secondary structure of brickwork sits 
as infill in this approach. Revealing the structural 
element is intended to provide the visual indication 
of distinguishing private learning zones in an open 
plan arrangement. The primary column structure 
is concealed by the secondary structure in the 
internal, communal public area of the building, 

This structure therefore sits within the cavity wall 
to limit interruption in the continuity of space. 
The secondary structural mechanism of the 
cavity wall guides the concealment of the primary 
structure according to the internal and external 
conditions. When rhythm needs to be established 
to distinguish space, the primary structure is 
revealed. 

Fig. 2.5.2.5. Structural layers (Naidoo 2020)
Fig. 2.5.2.7. Relationship between structure and plan (Naidoo 
2020)

Fig. 2.5.2.6. Role of structure (Naidoo 2020)
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5.2.2.3. Secondary structure in relation to the 
architectural approach

The secondary structure aimed to provide an 
architectural language to the threshold and 
programmatic response of the architecture. A 
series of flat roofs and steel trusses have been the 
acquired architectural language of the site. Points 
of entry into the school are differentiated in the 
roof plane with the use of horizontal elements. 
This threshold response is also reflected within 
the circulation system. The circulation serves a 
hierarchical role with the tertiary roof structure 
transitioning up towards the flat roof structure. 
Breaks within this language provide opportunities 
to be expressed within the architecture, such as 
the change in direction of circulation reflecting on 
elevation.

The secondary structure allows the architecture to 
interact with the external condition and consists of 
the layering of stereotomic elements to establish 
the edge approach of the site with deep openings. 
In the current condition, the vertical plane of 
the classrooms bluntly addresses the exterior. 
However, the thickening of this vertical element 
provides a threshold opportunity to stimulate 
connection. It also serves a functional role in 
contributing to the quality of circulation space 
by creating multiple opportunities for interaction 
and thus learning outside of traditional means. 
The tectonic elements are expressed to create 
interaction with the context and establish external 
space. 

5.2.2.4. Tertiary structure in relation to the 
architectural approach

The tertiary structure consists of a series of 
lightweight steel trusses that articulates the 
space below. Three steel truss types have 
been applied within the project to develop an 
architectural language between the building and 
its construction. Variations in the roof structure 
speak to the programming of the space below. 
The first truss type follows the slope of the roof 
and peaks up towards the secondary circulation 
structure. The intention behind this approach is to 
accommodate the public, communal aspects of 
the programme through the increase in volume. 
The shorter truss spans with horizontal members 
are employed over the private aspects of the 

programme, which speaks to the intimate quality of 
the programme. Considering how these elements 
interact have distinguished the spatial experience 
of the building

5.2.3 Connection

Frascari (1984) states that construction lies in the 
detail and allows for the ‘architectural production 
of meaning’. Therefore detail resolution of a 
building takes on a deeper role. Detail resolution 
of the building was an investigation into the art of 
the connection between the building components. 
Exploration into their various configurations 
allowed for an understanding of the opportunities 
they presented. 

The articulation of junctures and joints between 
elements allowed for opportunity to highlight the 
intersection between tectonic and stereotomic 
elements. The lightweight steel roof is lifted off the 
heavier elements below expressing the connection 
between the two. This was intended to express 
the interaction between public and private. These 
junctures were expressed in the architecture as 
moments to let light into the building. Approaching 
the connections with this conceptual intention 
contributed to the ‘character and style of the 
building’ (Frascari 1984:3). 
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5.3 Building Systems

5.3.1 Acoustic Considerations 

When publicly redefining the school as a collective 
urban entity, acoustic factors needed to be 
considered. Building acoustics, including external 
noise, is a contributing factor that affects learning 
performance (Barret et al 2015). Therefore, to 
mitigate arising issues from adjacent public and 
private programmes, an acoustic investigation was 
done to understand mechanisms to reduce noise 
transfer. 

Fig. 2.5.3.1. Acoustic considerations (Naidoo 2020)
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The current condition of the existing classrooms 
were also considered in terms of their acoustic 
performance. Whilst the current form of the 
classrooms are not acoustically problematic, their 
performance can be improved through acoustic 
panels. 

Fig. 2.5.3.2. Acoustic considerations (Naidoo 2020)
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5.3.2 Water System

Tsako Thabo Secondary school is located in close 
relation to a water body, however this is not the 
case for all the schools in Mamelodi East. The 
building makes use of a rainwater harvesting 
system to illustrate how typologically similar 
schools can adapt a similar method to sustaining 
the increase in programme to the school. The 
proposal for schools, in Mamelodi East, to publicly 
redefine themselves as collective urban entities 
increases the water dependency. Therefore, the 
water system is directed towards maintaining the 
schools increased capacity to function as a public 
facility. 

Process:

1.	 Rainwater is harvested from roof surfaces
2.	 Roof gutter to collect rainwater
3.	 First flush diverter- diverts the first flow of 

water, with sediment and debris, away from the 
storage tank

4.	 Above ground, polyethylene rainwater storage 
tank chosen as a cost effective option in South 
Africa

5.	 Diverter for debris
6.	 Pump to transfer water to point of use. 
7.	 Filter and UV disinfection within the line
8.	 Overflow system 

Fig. 2.5.3.4. Rainwater harvesting calculations (Naidoo 2020)Fig. 2.5.3.3. Water system (Naidoo 2020)
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WATER BUDGET

TANK CAPACITY (m³): 5000
MIN VOLUME (m³): 0

WATER BUDGET INNITIATION PHASE

MONTH
YIELD 

(m³/month)
DEMAND 

(m³/month)

MONTHL
Y 

BALANCE

POTENTIAL 
VOLUME 

(m³)

VOLUME 
IN TANK 

(m³)

Sept 178,9 540,0 -361,1 0,0 0,0

Oct 550,6 548,0 2,6 2,6 2,6

Nov 755,5 360,0 395,5 398,1 398,1

Dec 1150,0 362,0 788,0 1186,1 1186,1

2635,0 1810,0 825,0

WATER BUDGET YEAR 1

MONTH
YIELD 

(m³/month)
DEMAND 

(m³/month)

MONTHL
Y 

BALANCE

POTENTIAL 
VOLUME 

(m³)

VOLUME 
IN TANK 

(m³)

January 1180,3 362,0 818,3 2004,4 2004,4

February 581,0 524,0 57,0 2061,4 2061,4

March 634,1 548,0 86,1 2147,5 2147,5

April 398,9 540,0 -141,1 2006,4 2006,4

May 110,6 548,0 -437,4 1569,0 1569,0

June 65,1 360,0 -294,9 1274,1 1274,1

July 34,8 362,0 -327,2 946,9 946,9

August 57,5 548,0 -490,5 456,4 456,4

September 178,9 540,0 -361,1 95,3 95,3

October 550,6 548,0 2,6 98,0 98,0

November 755,5 360,0 395,5 493,4 493,4

December 1150,0 362,0 788,0 1281,4 1281,4

ANNUAL AVE. 5697,3 5602,0 95,3

0,0

200,0

400,0
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1400,0

Sept Oct Nov Dec

Innitiation Phase
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Fig. 2.5.3.5. Rainwater harvesting calculations (Naidoo 2020)

Fig. 2.5.3.6. School in Gando (Archdaily 2020)

Fig. 2.5.3.7. School in Gando ventilation response(Archello 2020)

Fig. 2.5.3.8. School in Gando ventilation response(Naidoo 
2020)

5.3.3 Ventilation Systems 

Precedent:

Type: School
Architect: Diébédo Francis Kéré
Location: Gando, Burkino Faso
Year: 2012 
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Ventilation system to be implemented at Tsako 
Thabo:

A passive system has been used to naturally 
ventilate the building. To accommodate a 
comfortable physical educational environment that 
does not hinder the learning process, large room 
volumes with window openings at different heights 
have been used. This to allow for ventilation of 
varying conditions (Barret et al 2015). 

The building form articulated itself with circulation 
space serving a hierarchical role. Due to these high 
volume spaces throughout the building, it provided 
the opportunity to implement the stack effect. The 
difference in pressure created from hot air rising in 
the building, and being released through an outlet 
in the circulation ‘tower’, draws cool air into the 
building (Kang & Lutz-Carrillo 2009). Promoting air 
flow is crucial due to the public programme of the 
building. 

Fig. 2.5.3.9. Stacked induced ventilation system (Kang & Lutz-
Carrillo 2009) Fig. 2.5.3.10. Ventilation system (Naidoo 2020)
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5.4 Building Performance 

The physical educational environment directly 
impacts its learners (Hertzberger 2008) and is 
therefore an important aspect to the dissertation. 
Numerous studies have been conducted on the 
impact of internal environments on the health and 
performance of learners, with poor conditions 
relating to detrimental impacts on learning 
(Motsatsi 2015:48). Policy for public school 
infrastructure lacks guidelines relating to building 
performance (Department of Basic Education 
2012). Section 14 and section 16, within these policy 
documents, make mention of lighting conditions 
and comfort levels, however the guidelines are 
limited (Department of Basic Education 2012:12). 
Lighting stipulations state the lux values that 
need to be achieved but not methods of doing so 
through the physical infrastructure. Comfort levels 
do not speak to the relevance of visual and thermal 
comfort in the learning process. This resembles 
the outdated approach of the Administration 
Boards (mentioned in 2.2.2), where school building 
performance in relation to the learning process 
was “not considered in any way whatsoever” 
(Candiotes 1997:20-21). 

The following performance based design 
assessment has been conducted to a single 
classroom block at Tsako Thabo Secondary 
School, to understand the shortfalls within the 
current schooling typology that affect learning 
capabilities. The investigation has been conducted 
on a classroom block due to the fact that learners 
spend most of their time within this single space 
(Barret et al 2015, Motsatsi 2015),  therefore the 
indoor environmental quality of these spaces 
becomes crucial. The particular classroom block 
has been selected as it represents the same 
makeup as the other blocks on site and can 
therefore serve as the base model to compare 
results against. 

This assessment of the building engages with an 
iterative process to investigate the adaptations 
that impact the greatest improvement of the 
building’s performance. In doing so, the intention 
is to provide a guideline of the spatial adaptations 
that can be made to the current typology to 
improve the learning condition, according to 
incremental improvements that schools can 
afford at the time. Aligning with the dissertation 
intentions of responding to policy for public 
school infrastructure, this process needed 
to be conducted with rigour, therefore the 
building performance software tool, Integrated 

Fig. 2.5.4.1. Existing Tsako Thabo school with classroom block highlighted (Naidoo 2020)

Environmental Solutions Virtual Environment 
(IESVE), was used to conduct simulations for the 
following building performance themes: 

•	 Solar Intensity- Daylight capture/shading 
strategy 

•	 Glare- Visual Comfort
•	 Thermal Comfort 

Each parameter assessment is structured 
according to a base model test and analysis of 

the building performance of the current typology. 
This is followed by a series of iterations which are 
compared against the base model results. With 
each iterative test, a single variable to the physical 
quality of the building is changed. This is done 
to understand the level of improvement that the 
isolated variable induces. Results from the iterative 
process informed the final design and technical 
response of the dissertation. 

Current Classroom Block Exterior Conditions:

A: Walls- 230mm double skin brown and cream 
painted brick exterior walls
B: Roof- Standard timber truss with standard 2mm 
corrugated profile, steel roof sheeting and 400mm 
painted fascia board.

Current Classroom Block Interior Conditions:

C: Walls- Painted brick walls with 110mm single skin 
interior partitioning walls  
D: Floor- Red Vinyl Tiles
E: Ceiling- Standard white painted 12mm gypsum 
ceiling board
F: Window- 1310x1490mm Maroon painted mild 
steel window frame with 6mm thick clear glazing 
G: Window- 1490x390mm Maroon painted mild 
steel window frame with 6mm thick clear glazing 
H: Doors- 1200x900mm Standard single leaf 
maroon painted door 

Fig. 2.5.4.2 Classroom block (Naidoo 2020)
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Fig. 2.5.4.3. External conditions at Tsako Thabo (Naidoo 2019)

Fig. 2.5.4.4. Internal conditions at Tsako Thabo (Naidoo 2019) Fig. 2.5.4.5. Internal conditions at Tsako Thabo (Naidoo 2019)
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5.4.1 Solar Intensity: Daylight Capture

“Poor quality of electrical lighting causes 
headaches and impairs visual performance” (Barret 
et al 2015), therefore it is important to consider 
reducing the dependency on artificial lighting 
within the learning environment to minimise the 
impact on learning potential. Natural light however 
has the potential to “significantly influence reading 
vocabulary” (Barret et al 2015). 

The FlucsDL tool in IESVE was used to calculate 
the daylight levels and illuminance on the 
working surfaces within the classroom. For the 
following tests, the working surface was set to 
the height of a desk at 735mm, to determine the 
lighting condition during learning. Before the 
simulations could be conducted, a model of the 
existing classroom block was developed and 
surface finishes were allocated to determine their 
percentage of reflectance. This was important 
in gathering an accurate reading on the daylight 
capture within the classroom. Simulations were 
set to occur during a Standard Overcast Sky, to 
analyse the buildings daylight performance under 
the poorest conditions. 

According to policy for public school infrastructure, 
section 14.1.1,  the artificial lighting level for a 
classroom needs to have a reading of 200 lux, with 
specialised areas requiring 300 lux (Department 
of Basic Education 2012:12). Unfortunately, policy 

Fig. 2.5.4.2 Classroom block (Naidoo 2020)

does not mention strategies for acquiring this lux 
level reading through natural light. For the analysis 
of the following results, the lux levels were read 
with cognizance of the amount of the work surface 
receiving a reading of 200 lux. This figure was 
used as a guide, so that adaptations to the existing 
would minimise the dependency on artificial 
lighting that could hinder learning performance. 
The German Sustainable Building Council (DGNB) 
provided a guideline for the analysis of daylight 
factor (DF) from the results (Velux 2020):

DF greater than 3% : very good
DF greater than 2% : medium
DF greater than 1% : slight
DF lesser than 1% :none

Base Variable Test

Variables

F: Window F Size: 1310x1490mm
G: Window Size: 1490x390mm
B: Overhang: 400mm roof overhang 
D: Floor surface: Red Vinyl Tiles with 10% 
reflectance
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard with 
80% reflectance

Daylight Analysis

Integrated

Environmental

Solutions Limited

Analysis Overview

Threshold Calculation

Calculation Data

Analysis Overview

Analysis Comparison (against previous assessment)

Total Comparison (with previous)

Daylight levels (lux) 492.733 Same

Percentage area above threshold (%) 66.5 Reduced

Analysis History

Date / Time Area-weighted average daylight factor (%) Area-weighted average illumination (lux)

30 Oct 2020 at 10:26 AM 4.0 492.733

Threshold Calculation

Building Results

Total floor

area

(m2)

Total floor area above

threshold

(m2)

Percentage floor area above

threshold

(%)

Area-weighted 

average daylight

factor

(%)

Area-weighted average

illumination

(lux)

52.290 34.781 66.5 4.0 492.733

Rooms included in the analysis

Room ID Room name
Working

plane

Floor area

(m2)

Floor area > threshold

(m2)

Percentage floor area >

threshold (%)

Average illumination

(%)

CL000003
Classroom

block
0 52.290 34.781 66.5 4.03

Rooms not included in the analysis

Room ID Room name Reason

CL000001 Classroom block Not selected for inclusion in report

CL000002 Classroom block Not selected for inclusion in report

RF000000 Roof 4 degree Not selected for inclusion in report

Things to consider:

Increase amount of glazing (assess trade-off with energy consumption)

Evaluate size and shape of glass (glass above 2.3m (7'6") has greater impact)

Fig. 2.5.4.6. Solar intensity base model results (IESVE 2020)

Findings and Discussion 

The base model displayed an average lux 
reading of 492.73 which exceeds the minimum 
requirements of 200 lux set out by policy. 
Unfortunately when looking at the daylight factor 
reading across the work surface in the classroom, a 
major area reflects a lot daylight factor of 1% where 
learner desks would usually be concentrated. The 
periphery of the classroom, along the fenestration 
edges, receive a DF of 3% and above which is 
considered very good. Therefore, within the base 
model, learners seated within this area, have a 
visual advantage due to the daylight condition. 

Fig. 2.5.4.7. Solar intensity base model results (IESVE 2020)
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Iteration One Test

Variables

F: Window F Size: 1310x1490mm
G: Window Size: 1490x2390mm (Variable tested)
B: Overhang: 400mm roof overhang 
D: Floor surface: Red Vinyl Tiles with 10% 
reflectance
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard with 
80% reflectance

Fig. 2.5.4.2 Classroom block (Naidoo 2020)

Findings and Discussion 

Iteration one displayed superior lux levels to the 
base model, with an average reading of 678.02 
lux. This is well above the minimum requirements 
dictated by policy. Within the work surface of the 

Daylight Analysis

Integrated

Environmental

Solutions Limited

Analysis Overview

Threshold Calculation

Calculation Data

Analysis Overview

Analysis Comparison (against previous assessment)

Total Comparison (with previous)

Daylight levels (lux) 678.026 No previous

Percentage area above threshold (%) 98.6 No previous

Analysis History

Date / Time Area-weighted average daylight factor (%) Area-weighted average illumination (lux)

Threshold Calculation

Building Results

Total floor

area

(m2)

Total floor area above

threshold

(m2)

Percentage floor area above

threshold

(%)

Area-weighted 

average daylight

factor

(%)

Area-weighted average

illumination

(lux)

52.290 51.580 98.6 5.5 678.026

Rooms included in the analysis

Room ID Room name
Working

plane

Floor area

(m2)

Floor area > threshold

(m2)

Percentage floor area >

threshold (%)

Average illumination

(%)

CL000003
Classroom

block
0 52.290 51.580 98.6 5.55

Rooms not included in the analysis

Room ID Room name Reason

CL000001 Classroom block Not selected for inclusion in report

CL000002 Classroom block Not selected for inclusion in report

RF000000 Roof 4 degree Not selected for inclusion in report

Things to consider:

Increase amount of glazing (assess trade-off with energy consumption)

Evaluate size and shape of glass (glass above 2.3m (7'6") has greater impact)

Select a glass type with a different visible transmittance (Tvis)

classroom, the previously disadvantaged central 
space from the base model improved with the 
reading shifting from a DF of 1% to a DF of 2%. 
98.6% of the classroom work surface sits above 
this threshold of 2% DF, which is a superior 
performance to the base model. 

Fig. 2.5.4.9. Solar intensity iteration one results (IESVE 2020) Fig. 2.5.4.6. Solar intensity base model results (IESVE 2020)

Fig. 2.5.4.8. Solar intensity iteration one results (IESVE 2020)
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Iteration Two Test

Variables

F: Window Size: 1310x1490mm
G: Window Size: 1490x390mm
B: Overhang: 400mm roof overhang 
Shading: 2000mm shading structure on NW 
elevation (Variable tested)
D: Floor surface: Red Vinyl Tiles with 10% 
reflectance
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard with 
80% reflectance

Fig. 2.5.4.2 Classroom block (Naidoo 2020)

Daylight Analysis

Integrated

Environmental

Solutions Limited

Analysis Overview

Threshold Calculation

Calculation Data

Analysis Overview

Analysis Comparison (against previous assessment)

Total Comparison (with previous)

Daylight levels (lux) 436.224 No previous

Percentage area above threshold (%) 42.1 No previous

Analysis History

Date / Time Area-weighted average daylight factor (%) Area-weighted average illumination (lux)

Threshold Calculation

Building Results

Total floor

area

(m2)

Total floor area above

threshold

(m2)

Percentage floor area above

threshold

(%)

Area-weighted 

average daylight

factor

(%)

Area-weighted average

illumination

(lux)

52.290 22.004 42.1 3.6 436.224

Rooms included in the analysis

Room ID Room name
Working

plane

Floor area

(m2)

Floor area > threshold

(m2)

Percentage floor area >

threshold (%)

Average illumination

(%)

CL000003
Classroom

block
0 52.290 22.004 42.1 3.57

Rooms not included in the analysis

Room ID Room name Reason

CL000001 Classroom block Not selected for inclusion in report

CL000002 Classroom block Not selected for inclusion in report

RF000000 Roof 4 degree Not selected for inclusion in report

Things to consider:

Increase amount of glazing (assess trade-off with energy consumption)

Evaluate size and shape of glass (glass above 2.3m (7'6") has greater impact)

Findings and Discussion 

The average lux levels within iteration two 
performed inferior to the base model. This is also 
reflected in the daylight factor readings across 

the working surface, where the minimum DF % is 
below 1. In this iteration half of the work surface 
in the classroom receives poor daylight whilst the 
other half of the classroom receives a DF & reading 
of 2 and up. 

Fig. 2.5.4.11. Solar intensity iteration two results (IESVE 2020) Fig. 2.5.4.6. Solar intensity base model results (IESVE 2020)

Fig. 2.5.4.10. Solar intensity iteration two results (IESVE 2020)
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Iteration Three Test

Variables

F: Window Size: 2390x1490mm (Variable tested)
G: Window Size: 1490x390mm
B: Overhang: 400mm roof overhang 
Shading: 2000mm shading structure on NW 
elevation (Variable tested)
D: Floor surface: Red Vinyl Tiles with 10% 
reflectance
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard with 
80% reflectance

Fig. 2.5.4.2 Classroom block (Naidoo 2020)

Findings and Discussion 

For iteration three, the variable changes in 
iteration one and two were combined. Increasing 
the openings and providing covered circulation 
space is important to the design response of the 
building (see chapter 4), therefore this iteration 
was intended to see how both variable adaptations 

performed. In combination, the average lux levels 
exceeded the base model. The percentage of DF% 
above the threshold of DF 2%, also performed 
superior to the base model, with a reading of 
85.1%. In combination, the positive effects on 
daylight by iteration one balanced out the negative 
effects of iteration two. 

Daylight Analysis

Integrated

Environmental

Solutions Limited

Analysis Overview

Threshold Calculation

Calculation Data

Analysis Overview

Analysis Comparison (against previous assessment)

Total Comparison (with previous)

Daylight levels (lux) 532.831 No previous

Percentage area above threshold (%) 85.1 No previous

Analysis History

Date / Time Area-weighted average daylight factor (%) Area-weighted average illumination (lux)

Threshold Calculation

Building Results

Total floor

area

(m2)

Total floor area above

threshold

(m2)

Percentage floor area above

threshold

(%)

Area-weighted 

average daylight

factor

(%)

Area-weighted average

illumination

(lux)

52.290 44.482 85.1 4.4 532.831

Rooms included in the analysis

Room ID Room name
Working

plane

Floor area

(m2)

Floor area > threshold

(m2)

Percentage floor area >

threshold (%)

Average illumination

(%)

CL000003
Classroom

block
0 52.290 44.482 85.1 4.36

Rooms not included in the analysis

Room ID Room name Reason

CL000001 Classroom block Not selected for inclusion in report

CL000002 Classroom block Not selected for inclusion in report

RF000000 Roof 4 degree Not selected for inclusion in report

Things to consider:

Increase amount of glazing (assess trade-off with energy consumption)

Evaluate size and shape of glass (glass above 2.3m (7'6") has greater impact)

Fig. 2.5.4.13. Solar intensity iteration three results (IESVE 2020) Fig. 2.5.4.6. Solar intensity base model results (IESVE 2020)

Fig. 2.5.4.12. Solar intensity iteration three results (IESVE 2020)
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Conclusion

Iteration one had the greatest impact of the 
daylighting levels within the classroom block, 
however iteration three with the combination of 
adaptations, was able to meet the design needs 
as well as improve the base models building 
performance. It is important to note however 
that this simulation did reflect uneven lighting 
conditions between the outer and inner working 
surfaces. Therefore, for further consideration, 
mechanisms for bringing in natural light to central 
spaces of the classroom is suggested. Fig. 2.5.4.14. Iterative development of section using solar intensity analysis results (Naidoo 2020)
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5.4.2 Glare: Visual Comfort

Using the RadianceIES tool within IESVE, an 
illuminance analysis was conducted to understand 
the impact of visual comfort experienced by 
learners during learning. This was done through 
investigating the effect of glare. 

Direction of view was an important factor to 
consider when analysing the effect of glare. For 
this reason, the direction of view was set according 
to the teaching method currently conducted at 
the school where learners face a focal point. It is 
important to note that even though the dissertation 
proposes the spatial configuration and play type 
to allow for multiple learning arrangements, it 
was important to establish a base analysis on the 
current learning in place. The direction of view was 
set at a height based on the eye level of a seated 
learner (1200mm), focussed on the height of a 
teacher standing (1.8m) (Motsatsi 2015:64). 

The following results were analysed according to 
the difference in lux levels within the individual 
space, due to the fact that the visual discomfort 
from glare is experienced as a result of the 
difference in light and dark areas within a space. 
The greater the difference between the minimum 
and maximum lux levels results in increased 
difficulty for the eye to adjust, resulting in visual 
discomfort. Therefore the aim through each 
variable iteration, was to reduce this difference. 

Fig. 2.5.4.15. Classroom block with directional arrow (Naidoo 
2020)

Base Variable Test

Variables

F: Window Size: 1310x1490mm
G: Window Size: 1490x390mm
B: Overhang: 400mm roof overhang 
D: Floor surface: Red Vinyl Tiles
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard

Results: 21 June (Winter Solstice)

Total Image:
Minimum =    1.70 Lux
Maximum = 2296.07 Lux
Average =   92.10 Lux
Difference = 2294.37

Results: 22 Dec (Summer Solstice) 

Total Image:
Minimum =    4.59 Lux
Maximum = 3495.34 Lux
Average =  142.39 Lux
Difference = 3490.75 

Findings and Discussion 

The difference in lux values is greater during the 
summer period than it is for the winter. This results 
in learners experiencing an increase in visual 
discomfort during the summer time frame. As a 
result, learner performance could potentially be 
higher during the winter period than the summer. 

Radiance image: image2.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.028, -0.974, 0.224
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image2.map
Sky file = Dec22_1200_cie.sky

Ground Ambient =    33.389
                           =  18776.00 Lux
                           =   1744.35 lm/ft²

Radiance image: image3.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.028, -0.974, 0.224
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image3.map
Sky file = Jun21_1200_cie.sky

Ground Ambient =    21.992
                           =  12366.95 Lux
                           =   1148.93 lm/ft²

Fig. 2.5.4.16. Visual comfort base model results June 21 (IESVE 2020)

Fig. 2.5.4.17. Visual comfort base model results Dec 22 (IESVE 2020)
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Iteration One Test

Variables

F: Window Size: 1310x1490mm
G: Window Size: 1490x2390mm (Variable tested)
B: Overhang: 400mm roof overhang 
D: Floor surface: Red Vinyl Tiles
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard

Variation to window G, keeping the same lintel 
height whilst allowing the classroom space to open 
up towards the exterior. 

Results: 21 June (Winter Solstice)

Total Image:
Minimum =    9.00 Lux
Maximum = 2428.87 Lux
Average =  200.43 Lux
Difference = 2419.87

Results: 22 Dec (Summer Solstice) 

Total Image:
Minimum =   14.73 Lux
Maximum = 3640.12 Lux
Average =  299.25 Lux
Difference = 3625.39

Fig. 2.5.4.15. Classroom block with directional arrow (Naidoo 2020)

Findings and Discussion 

With the change of window size in iterative test 
one, both the summer and winter difference in lux 
values increased. Therefore, isolating this variable 
highlighted that this change negatively impacts 
the visual discomfort through the increase in glare 
within the classroom. Through this simulation, the 
base model with the existing classroom conditions 
performed better. 

Radiance image: image4.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.184, -17.793, 1.000
Focus at: 0.014, -0.990, 0.138
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image4.map
Sky file = Jun21_1200_cie.sky

Ground Ambient =    21.992
                           =  12366.95 Lux
                           =   1148.93 lm/ft²

Radiance image: image5.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.184, -17.793, 1.000
Focus at: 0.014, -0.990, 0.137
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image5.map
Sky file = Dec22_1200_cie.sky

Ground Ambient =    33.389
                           =  18776.00 Lux
                           =   1744.35 lm/ft²

Fig. 2.5.4.18. Visual comfort iteration one results June 21 (IESVE 2020)

Fig. 2.5.4.19. Visual comfort iteration one results Dec 22 (IESVE 2020)



345Volume Two  |  Technical Development344 345

Fig. 2.5.4.15. Classroom block with directional arrow (Naidoo 2020)

Iteration Two Test

Variables

F: Window Size: 1310x1490mm
G: Window Size: 1490x390mm
B: Overhang: 400mm roof overhang
2000mm roof overhang over window G (Variable 
tested)
D: Floor surface: Red Vinyl Tiles
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard

Results: 21 June (Winter Solstice)

Total Image:
Minimum =    2.43 Lux
Maximum = 2272.46 Lux
Average =  101.85 Lux
Difference = 2270.03

Results: 22 Dec (Summer Solstice) 

Total Image:
Minimum =    4.55 Lux
Maximum = 3464.21 Lux
Average =  151.84 Lux
Difference = 3459.66

Findings and Discussion 

Introducing an overhang positively impacted the 
visual comfort experienced in the classroom. 
The difference in lux levels for both the summer 
and winter period reduced in comparison to the 
base model. Therefore, the impact of glare on the 
learning experience was minimised within this 
iteration. 

Radiance image: image5.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.087, -5.849, 0.078
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image5.map
Sky file = Jun21_1200_cie.sky

Ground Ambient =    21.992
                           =  12366.95 Lux
                           =   1148.93 lm/ft²

Radiance image: image1.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.087, -5.849, 0.078
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image1.map
Sky file = Dec22_1200_cie.sky

Ground Ambient =    33.389
                           =  18776.00 Lux
                           =   1744.35 lm/ft²

Fig. 2.5.4.20. Visual comfort iteration two results June 21 (IESVE 2020)

Fig. 2.5.4.21. Visual comfort iteration two results Dec 22 (IESVE 2020)
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Fig. 2.5.4.15. Classroom block with directional arrow (Naidoo 2020)

Iteration Three Test

Variables

F: Window Size: 1310x1490mm
G: Window Size: 1490x390mm
B: Overhang: 400mm roof overhang 
Overhang: 1000mm overhang over window F @ 
2500mm height (Variable tested)
D: Floor surface: Red Vinyl Tiles
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard

Results: 21 June (Winter Solstice)

Total Image:
Minimum =    1.58 Lux
Maximum = 2229.98 Lux
Average =   67.31 Lux
Difference = 2228.4

Results: 22 Dec (Summer Solstice) 

Total Image:
Minimum =    2.79 Lux
Maximum = 3398.83 Lux
Average =   98.14 Lux
Difference=3396.04

Findings and Discussion 

In this iteration, the introduction of a 1000mm 
overhang reduced the experience of glare, in 
comparison to the base model, during the winter 
and summer period. Therefore this change 
in variable to the current condition positively 
influenced the visual comfort experienced by 
learners within the classroom. 

Radiance image: image2.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.015, -1.000, 0.013
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image2.map
Sky file = Jun21_1200_cie.sky

Ground Ambient =    21.992
                           =  12366.95 Lux
                           =   1148.93 lm/ft²

Radiance image: image3.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.015, -1.000, 0.013
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image3.map
Sky file = Dec22_1200_cie.sky

Ground Ambient =    33.389
                           =  18776.00 Lux
                           =   1744.35 lm/ft²

Fig. 2.5.4.22. Visual comfort iteration three results June 21 (IESVE 2020)

Fig. 2.5.4.22. Visual comfort iteration three results June 21 (IESVE 2020)
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Iteration Four Test

Variables

F: Window Size: 1490x1390mm
G: Window Size: 1490x2390mm (Variable tested)
B: Overhang: 400mm roof overhang 
Overhang: 1000mm overhang over window F @ 
2500mm height (Variable tested)
Overhang: 2000mm roof overhang over window 
G (Variable tested)
D: Floor surface: Red Vinyl Tiles
C: Interior wall surface: Cream painted brick 
E: Ceiling: white painted gypsum plasterboard

Results: 21 June (Winter Solstice)

Total Image:
Minimum =    5.33 Lux
Maximum = 2233.49 Lux
Average =  143.27 Lux
Difference=2228.16

Results: 22 Dec (Summer Solstice) 

Total Image:
Minimum =    5.31 Lux
Maximum = 3381.02 Lux
Average =  214.25 Lux
Difference=3375.71

Fig. 2.5.4.15. Classroom block with directional arrow (Naidoo 2020)

Findings and Discussion 

Isolating the variables during iterations 1-3, 
produced varied results, therefore within iteration 
4, the changes in variables were combined to 
understand the visual comfort performance, should 
the school afford to implement all the suggested 
adaptations. The results of this simulation rendered 
lower values for the difference in lux levels for both 
the summer and winter solstice, in comparison to 
the base model. 

Radiance image: image1.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.015, -1.000, 0.013
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image1.map
Sky file = Jun21_1200_cie.sky

Ground Ambient =    21.992
                           =  12366.95 Lux
                           =   1148.93 lm/ft²

Radiance image: image2.pic
 

Illuminance Perspective Image

Perspective View:
Eye at: 21.254, -17.860, 1.000
Focus at: 0.015, -1.000, 0.013
Angle of View: 80 × 60 degrees
Size: 640 × 441 pixels

Map file = image2.map
Sky file = Dec22_1200_cie.sky

Ground Ambient =    33.389
                           =  18776.00 Lux
                           =   1744.35 lm/ft²

Fig. 2.5.4.24. Visual comfort iteration four results June 21 (IESVE 2020)

Fig. 2.5.4.25. Visual comfort iteration four results Dec 22 (IESVE 2020)
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Conclusion

From each iterative test done above, iteration 4, 
with the combination of variable changes, resulted 
in the best performance for visual comfort with 
a reduction in the glare experienced. Iteration 1 
produced disappointing results, in terms of the 
thematic focus for building performance, however 
this change is an important adaptation within the 
spatial configuration potential of the classroom 
to allow for multiple layouts (see 4.5). When the 
variable change was applied in combination with 
iterations 2 and 3, the performance improved. 

As a result, it is suggested that should any of the 
above variable adaptations be made to the current 
typology, that iteration 1 be done in combination 
with iteration 2 and 3, and never in isolation. 
Iterations 2 and 3 both performed superior to 
the base model and can therefore be applied in 
isolation. 
However, should the intention be to adapt a single 
variable in the physical condition to impact the 
greatest improvement, it is suggested that iteration 
3 be applied. Fig. 2.5.4.26. Iterative development of section using visual comfort analysis results (Naidoo 2020)
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5.4.3 Thermal Comfort  

Using the VistaPro tool in IESVE, an analysis of the 
indoor/outdoor temperature and thermal comfort 
of the selected classroom block was conducted. 
This was done to gauge the thermal comfort 
experienced by learners during learning. Learners 
are more susceptible to high thermal conditions 
in comparison to adults (Motsatsi 2015:50).  In an 
extensive study on the physical qualities of the 
learning environment, it was found that the thermal 
condition directly related to learning progress 
(Barret et al 2015:128). This factor also has the 
potential to hinder mental capacity and learner 
focus, in extreme conditions (Motsatsi 2015:49). 
Unfortunately within policy for public school 
infrastructure, section 16 on comfort levels, there is 
no guidance on dealing with thermal performance 
within these learning environments (Department of 
Basic Education 2012). the building space in relation to the number of 

occupants at any given time. These hours were 
set to the average school day and the school year, 
with cognizance of the current inactive hours. The 
number of occupants within the classroom space 
was set in accordance to Candiotes (1997:34), 
which describes the standard classroom to allow 
for 36 learners and 1 teacher. 

To analyse the data the following parameters were 
used:

Dry bulb temperature- External air temperature
Dry resultant temperature- The mean value of the 
indoor room air as well as the radiant temperature
Comfort index- An indication of the comfort 
experienced according to the comfort index scale
People dissatisfied- % of people from the total 
occupancy dissatisfied 

To assess the results from the thermal comfort 
simulations, a comparison between the difference 
in dry bulb and dry resultant temperature was 
made. The intention, through each iteration, was 
to minimise the difference in temperature. This 
analysis was also done with awareness of the 
percentage of people dissatisfied and the reading 
on the comfort index scale. With each iteration, the 
aim was to incrementally improve the results of the 
base model through seeing how a single variable 
change performs. 

Fig. 2.5.4.27. Climatic zones within South Africa (SANS 10400 
2017)

Before running the thermal comfort test, a few 
parameters within the project needed to be set. 
The classroom block was modelled with the 
location set to Pretoria for accurate readings 
on the building performance. Thereafter, the 
construction of the building elements was 
allocated according to the conditions currently 
present on site at Tsako Thabo. An important 
aspect to gathering an accurate reading was 
setting the building occupancy conditions. Indoor 
air temperature as well as the level of occupancy 
by users within a space is crucial for understanding 
thermal comfort (Nicol et al 2012:4). Therefore, 
this involved allocating the activity hours of 

Fig. 2.5.4.28. Thermal comfort index (Konstantinou et al 2019)

Two time periods were used during the analysis. 
The month of March was selected out of the 
summer range (December - March), to understand 
the thermal performance during the hotter parts 
of the year, while the school has full occupancy. 
August was selected as the second period within 
the winter range (June-August), as the school 
would be on holiday during the June and July 
period therefore altering the people dissatisfied 
parameter. Temperatures during this time are 
analysed according to the City of Tshwane’s 
summer and winter comfort zones (Motsatsi 
2015:82):

Summer comfort zone: 20.5°C - 26°C
Winter comfort zone: 20.5°C - 24.5°C 

Base Variable Test

Variables

E: Ceiling- 12mm gypsum ceiling board (R-value = 
0.0595 m2K/W)
H: Doors- 30mm plywood (R-value= 0.2308 m2K/W)
F & G: Windows- Single glazing, 6mm clear float 
glass  (R-value= 0.1700 m2K/W)
D: Floor- 170mm concrete slab with 30mm cement 

screed finished with 3mm vinyl tile  (R-value= 
0.1060 m2K/W)
C: Internal walls- 110mm brick (R-value= 0.1774 
m2K/W)
B: Roof- Standard 2mm corrugated profile, steel 
roof sheeting (R-value= 0.00 m2K/W). 4 degree roof 
pitch with 400mm overhang. 
A: External wall- 230mm masonry wall (R-value= 
0.3284 m2K/W)

Fig. 2.5.4.2 Classroom block (Naidoo 2020)
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Fig. 2.5.4.29. Base model Indoor and outdoor temperature results for March (IESVE 2020)

Fig. 2.5.4.30. Base model Indoor and outdoor temperature results for August (IESVE 2020)
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Fig. 2.5.4.31. Base model People dissatisfied and comfort index results for March (IESVE 2020)

Fig. 2.5.4.32. Base model People dissatisfied and comfort index results for Aug (IESVE 2020
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Base Model Results
March August

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Maximum 
temperature 32 24.2 28 22

Minimum 
temperature 11 18.7 2 18

Difference in 
min and max 
temperature 21 5.5 26 4

Fig. 2.5.4.33. Thermal comfort base model results (Naidoo 2020)

Findings and Discussion

Temperature: 

The maximum temperature for the summer period 
during March is 24.2°C and is within the summer 
comfort zone, however the minimum temperature 
falls to 18.7°C, which is below the comfort zone 
threshold. A similar condition occurs during the 
winter period, in August, where the maximum 
indoor temperature value is within the winter 
comfort zone range, however the minimum value 
falls below. Overall, the greatest issue lies with 
the difference in minimum indoor and outdoor 
temperatures during August, which has the highest 
difference in comparison to the others. 

Thermal comfort:

The comfort index represents that the building 
experiences a greater deal of comfort in the 
summer month of March, in comparison to the 
winter month of August. This is also reflected in a 
higher percentage of people dissatisfied during 
August than in March. In the span of a single 
day, when building occupancy is at its peak, the 
percentage of people dissatisfied increased and 
the comfort index decreased. The comfort index 
increased during periods when the school closed 
in the afternoon. This indicates that during learning 
hours when the school is active, greater thermal 
discomfort is experienced. This is a potential 
hindering agent to the learning process as 
previously discussed. 

Iteration Test One:

Variables

E: Ceiling- 12mm gypsum ceiling board (R-value = 
0.0595 m2K/W)
H: Doors- 30mm plywood (R-value= 0.2308 m2K/W)
F & G: Windows- Single glazing, 6mm clear float 
glass  (R-value= 0.1700 m2K/W)
D: Floor- 170mm concrete slab with 30mm cement 
screed finished with 3mm vinyl tile  (R-value= 
0.1060 m2K/W)
C: Internal walls- 110mm brick (R-value= 0.1774 
m2K/W)
B: Roof- 5mm steel roof sheeting with 100mm 
insulation board (R-value= 2.3257 m2K/W). 4 
degree roof pitch with 400mm overhang. (Variable 
tested)
A: External wall- 230mm masonry wall (R-value= 
0.3284 m2K/W)

Fig. 2.5.4.2 Classroom block (Naidoo 2020)
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Fig. 2.5.4.34. Iteration one Indoor and outdoor temperature results for March (IESVE 2020)

Fig. 2.5.4.35. Iteration one Indoor and outdoor temperature results for Aug (IESVE 2020)
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Fig. 2.5.4.36. Iteration one People dissatisfied & comfort index results for Mar (IESVE 2020

Fig. 2.5.4.37. Iteration one People dissatisfied and comfort index results for Aug (IESVE 2020
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Iteration 1 Results
March August

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Maximum 
temperature 32 23.7 28 22

Minimum 
temperature 11 18.5 2 17.8

Difference in 
min and max 
temperature 21 5.2 26 4.2

Findings and Discussion

Temperature: 

The maximum temperatures for both March and 
August fall within their respective comfort zones 
for the summer and winter season. However, 
in both months, the minimum temperatures still 
sit below the comfort zone. The difference in 
minimum and maximum temperature for interaction 
1, is lower than the base model results. Therefore 
within the summer period, iteration one performs 
superior to the existing condition on site. In 
the winter period of August, this difference in 
temperature increases, therefore the base model 
presents better conditions during winter. Greater 
thermal comfort is experienced during March than 
in August, therefore learning progress potentially 
improves during summer. 

Thermal comfort:

The comfort index, during March, sits within the 
same range as the Base model. However, few days 
within the month experience a lower reading within 
this comfort index scale. Within the summer period, 
the percentage of people dissatisfied decreases 
as the month progresses. Therefore in comparison 
with the base model, iteration one performs better 

during the summer period. During August, the 
percentage of people dissatisfied drops lower in 
the base model than it does in iteration one. This 
condition reflects the data above and is likely 
related to the increase in temperature difference, 
as well as the lower temperatures falling out of the 
comfort zone. 

Fig. 2.5.4.38. Thermal comfort iteration one results (Naidoo 2020)

Iteration Test Two:

Variables

E: Ceiling- 12mm gypsum ceiling board (R-value = 
0.0595 m2K/W)
H: Doors- 30mm plywood (R-value= 0.2308 m2K/W)
F & G: Windows- Single glazing, 6mm clear float 
glass  (R-value= 0.1700 m2K/W)
D: Floor- 170mm concrete slab with 30mm cement 
screed finished with 3mm vinyl tile  (R-value= 
0.1060 m2K/W)
C: Internal walls- 110mm brick (R-value= 0.1774 
m2K/W)
B: Roof- Standard 2mm corrugated profile, steel 
roof sheeting (R-value= 0.00 m2K/W). 4 degree roof 
pitch with 400mm overhang. 
A: External wall- 230mm masonry internal wall 
with 10mm plaster, 240mm cavity and 230mm 
external masonry wall (R-value= 0.8103 m2K/W) 
(Variable tested)

Findings and Discussion

Fig. 2.5.4.2 Classroom block (Naidoo 2020)
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Fig. 2.5.4.39. Iteration two Indoor and outdoor temperature results for Mar (IESVE 2020)

Fig. 2.5.4.40. Iteration two Indoor and outdoor temperature results for Aug (IESVE 2020)
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Fig. 2.5.4.41. Iteration two People dissatisfied & comfort index results for Mar (IESVE 2020)

Fig. 2.5.4.42. Iteration two People dissatisfied & comfort index results for Aug (IESVE 2020)
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Iteration 2 Results
March August

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Maximum 
temperature 32 24 28 22

Minimum 
temperature 11 18.6 2 18

Difference in 
min and max 
temperature 21 5.4 26 4

Fig. 2.5.4.43. Thermal comfort iteration two results (Naidoo 2020)

Temperature: 

The difference in temperature for August remained 
the same for the base model and iteration two. 
Therefore, the variable change had little impact 
on the winter conditions at the school. However, 
during the summer period in March, the difference 
in temperature was lower than the base model. 
With this iteration, the variable change induces 
greater thermal comfort during the summer period 
than it did in the winter period. 

Thermal comfort:

The comfort index dropped to a lower value fewer 
times in March, than it did in the base model. 
This correlates with the percentage of people 
dissatisfied reducing in the later days of the month. 
As with the temperature analysis, the comfort index 
and percentage of people dissatisfied represent 
similar results. 

Iteration Test Three:

Variables

E: Ceiling- 12mm gypsum ceiling board (R-value = 
0.0595 m2K/W)
H: Doors- 30mm plywood (R-value= 0.2308 m2K/W)
F & G: Windows- Single glazing, 6mm clear float 
glass  (R-value= 0.1700 m2K/W)
D: Floor- 170mm concrete slab with 30mm cement 
screed finished with 3mm vinyl tile  (R-value= 
0.1060 m2K/W)
C: Internal walls- 110mm brick (R-value= 0.1774 
m2K/W)
B: Roof- Standard 2mm corrugated profile, steel 
roof sheeting (R-value= 0.00 m2K/W). 4 degree roof 
pitch with 400mm overhang. 
Shading-2000mm shading device on NW 
elevation (Variable tested)
A: External wall- 230mm masonry wall (R-value= 
0.3284 m2K/W)

Fig. 2.5.4.2 Classroom block (Naidoo 2020)
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Fig. 2.5.4.44. Iteration three Indoor and outdoor temperature results for Mar (IESVE 2020)

Fig. 2.5.4.46. Iteration three People dissatisfied & comfort index results for Mar (IESVE 2020)
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Fig. 2.5.4.47. Iteration three People dissatisfied & comfort index results for Aug (IESVE 2020)

Fig. 2.5.4.45. Iteration three Indoor and outdoor temperature results for Aug (IESVE 2020)
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Iteration 3 Results
March August

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Outdoor (Dry 
bulb 

temperature)
Indoor (Dry 

resultant)

Maximum 
temperature 32 24 28 22

Minimum 
temperature 11 18.5 2 17.8

Difference in 
min and max 
temperature 21 5.5 26 4.2

Fig. 2.5.4.48. Thermal comfort iteration three results (Naidoo 2020)

Findings and Discussion

Temperature: 

Although the minimum and maximum temperatures 
for March differ from the base model results, 
their differences in value equate. The maximum 
temperature during March falls within the summer 
comfort zone and in comparison to the base 
model, is slightly cooler. However, the minimum 
value falls out of the summer comfort zone range. 
The maximum value during August sits within the 
winter comfort range, however the minimum value 
does not. The difference in temperature during 
this period is inferior to the base model. Therefore, 
iteration three performs better in summer than it 
does in winter in comparison to the base model, 
when looking at the temperature. 

Thermal comfort:

The comfort index and the percentage of people 
dissatisfied during March and August displays 
similar values in comparison to the base model. 
This could be as a result of the similar difference in 
minimum and maximum temperature. Due to this, 
iteration three does not have a significant impact 
on the thermal comfort experienced. 
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Fig. 2.5.4.49. Iterative development of section using thermal comfort analysis results (Naidoo 2020)

Conclusion

From the iterations conducted, iteration one, 
displayed the greatest improvement on thermal 
comfort during the summer period however 
not in the winter period. Iteration two however, 
presented the best performance for both the 
winter and summer period. Overall it was found 
that the thermal comfort during winter was 
difficult to improve and in each case the variable 
change insignificantly altered the resulting values 
in comparison to the base model. None of the 
iterations conducted drastically impacted thermal 
comfort. Therefore it is suggested that further 
investigation be conducted in this regard. 



373Volume Two  |  Technical Development372 373

5.5 Sustainability 

5.5.1 Ventilation

The building relies on natural ventilation systems 
as depicted in 5.3.3. Therefore, reliance on 
mechanical ventilation is prevented. The explored 
systems employ the wind’s natural force to actively 
ventilate the building using passive methods 
(Kubba 2012:349). 

5.5.2 Light

Due to the amount of time spent in the classroom, 
the quality of natural light becomes an important 
factor that affects learning and well-being 
(Michaelidou 2012). 

Capturing natural daylight into the building was 
an environment strategy adopted by the project. 
Through an iterative process (see 5.4), alterations 
to the current built learning environment was 
adapted to improve the natural lighting conditions. 
As a result, reliance on artificial lighting was 
reduced. 

Fig. 2.5.5.1. Tsako Thabo Solar exposure test results (IESVE 2020)

Fig. 2.5.5.2. Tsako Thabo Solar exposure test results (IESVE 2020)

With the building relying on natural daylight, each 
iteration test was cognizant of the resulting effects 
of light within the learning space. Controlling the 
effects of glare and achieving an optimum daylight 
factor for learning, was therefore crucial.

5.5.3 Energy

A solar exposure study was conducted using the 
building performance software tool, Integrated 
Environmental Solutions Virtual Environment 
(IESVE). This test was conducted on the basic 
classroom block at Tsako Thabo Secondary 
School. As a result of the test, an indication 
of surface sunlight exposure over the period 
of a year was achieved. This provides useful 
information for the placement of photo-voltaic 
panels. The results also provided an indication on 
the solar exposure of facades which guided the 
shading considerations to avoid dependency on 
mechanical cooling. 

5.5.4 Materiality

Within the dissertation, the typological makeup 
of public schools in Mamelodi is challenged. 
However, even though the typology is outdated 
(see 2.2), the materials of the building have 
potential. Consideration for efficient material use is 
essential in understanding sustainability in building 
(Sayigh 2014). Material reuse positively contributes 
to reducing a building’s environment strain (Kubba 
2012:298). 

If it is being questioned how the built environment 
efficiently spends allocated funds, then we need to 
consider the reuse of materials. When adaptations 
to the existing are suggested, the reuse of material 
for additions is advised. Therefore the building 
adopts a ‘design for deconstruction approach’ 
(Sayigh 2014) to facilitate this approach. 

5.5.5 Sustainability 

The iterative tests conducted in 5.4 Building 
Performance were directed towards improving the 
current condition of the physical built environment 
of the classrooms, to enhance learning 
performance. These tests also provided an 
understanding of the sustainability of the building. 

Through the tests, lighting and thermal comfort 
were taken into consideration. The quality and 
intensity of natural light, as well as thermal 
comfort, was optimised to improve the building 
performance. In each case, adaptations to the 
existing building were directed towards optimizing 
the natural environment and reducing dependency 
on artificial energy sources. In doing so, the 
internal condition of the classrooms were altered 
to improve learning capabilities. 
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5.6 Technical development

Fig. 2.5.6.1. Structure and material considerations (Naidoo 2020)
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Fig. 2.5.6.2 Roof structure investigations (Naidoo 2020)
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Fig. 2.5.6.3. Detail investigation (Naidoo 2020)



381Volume Two  |  Technical Development380 381

Fig. 2.5.6.4. Technical investigation (Naidoo 2020)
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Fig. 2.5.6.5. Technical investigation (Naidoo 2020)
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6.1 Spatial Matrix Contribution to 
Policy 

To align with the dissertation intentions of 
providing spatial definition to educational policy, 
the following spatial matrix was developed. This 
is done through developing spatial principles that 
respond to the two themes within the dissertation:

•	 Building as Public Threshold
•	 Building as Pedagogy 

These themes have been investigated in detail in 
Volume 2, Chapter 4 of this dissertation. The matrix 
is a synthesized overview of the investigation into; 
the theoretical background, analysis of the existing 
conditions, precedent studies and PAR and co-
design game informants of each theme.

The first theme of Building as Public Threshold is 
structured according to Boettger (2014) threshold 
principles:

•	 Spatial Delimitation
•	 Spatial Sequence
•	 Spatial Geometry
•	 Spatial Topography
•	 Spatial Materiality

Spatial delimitation is further analysed to respond 
to varying conditions (Moise 2014) of interaction 
between the community and the school:

•	 Strong Boundary- reflects a distinction 
between individual spaces and controls the 
communication between them

•	 Diffuse Boundary- allows for individual spaces 
to overlap and blur into each other to create a 
connection

•	 Spatialised Boundary- creation of a hybrid 
space where individual spaces have common 
ground with shared characteristics 

The architectural language presented within this 
theme is directed towards responding to the 
design concept of publicly redefining the schooling 
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environment.  It aims to show how threshold 
conditions can mediate the relationship between 
a school and its community and influence the 
experience of that context. 
The second theme deals with Building for 
Pedagogy to understand the typological 
characteristics of the physical learning 
environment. This is explored through:

•	 Plan Type
•	 Spatial Configuration
•	 Circulation 

As discussed in 4.5.1, the architectural language 
of this theme is directed towards challenging the 
conventional educational environment. This is 
done through providing opportunities to acquire 
life skills (Dudek 2015) and social learning through 
interaction (Kuhn 2012). The matrix intends to 
provide an architectural language to Policy for 
Public School Infrastructure in South Africa. 
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1. SPATIAL MATRIX
Building as Public Threshold

Spatial Delimitation

Strong Boundary Diffused Boundary Spatialised Boundary

R
e

fe
re

n
ce

 P
la

n

•	 The strong boundary approaches presented below have been 
structured according to the following diagram where space A 
represents private learning programme and space B represents 
communal activity

0
1

S
p

a
ce

 A
 A

p
p

ro
a

ch

•	 Limit close interaction between public and private learning space: 
no provided shade/seating

•	 Acoustic threshold applied due to quieter learning occurring within 
space

•	 Maintains visual connection

•	 Overhang distinguishes threshold zone
•	 Support of overhang to not touch ground to reinforce blurring of 

the threshold space
•	 Overhang protrudes to invite interaction 

•	 External circulation element
•	 Dual shared space between indoors and outdoors 

0
2

•	 Section approach 1 to plan 01 •	 Exterior pergola shading structure as transition zone •	 External circulation element
•	 Dual shared space between indoors and outdoors
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1. SPATIAL MATRIX
Building as Public Threshold

Spatial Delimitation

Strong Boundary Diffused Boundary Spatialised Boundary

0
3
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•	 Section approach 2 to plan 01 •	 Protruding elements frame entrance/permeable threshold •	 Internal circulation element 
•	 Connection and buffer between private and communal programme

0
4

S
p

a
ce

 B
 A

p
p
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a

ch

•	 Maintain privacy for classrooms that sit on the public edge
•	 Controlled visual connection through articulation of openings

•	 Maintain the same level between respective spaces apart from the 
required 170mm step between indoor and outdoor

•	 Courtyard as spatialised threshold
•	 Maintains connection with adjacent spaces

0
5

•	 Section approach 1 to plan 04 •	 Bleeding of programme into external space

0
6

•	 Section approach 2 to plan 04 •	 Protrusion of floor finish through space to create continuity 
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1. SPATIAL MATRIX
Building as Public Threshold

Spatial Delimitation

Strong Boundary Diffused Boundary Spatialised Boundary

0
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•	 Approach used when activity within the private space stimulates 
learning

•	 Articulation of openings allows for visual connection
•	 No buffer between public and private- allow public to closely 

interact with the architecture
•	 Boundary is maintained through strong edge
•	 Thickened edge occupied with programme/supporting space

•	 Overhang to create transitional zone to blur boundary between 
internal and external space

0
8

•	 Section approach to plan 07 through occupied thickened edge

0
9

•	 Section approach to plan 07 through public seating of edge 
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Fig. 2.6.1. Building as public threshold spatial matrix (Naidoo 2020)

1. SPATIAL MATRIX
Building as Public Threshold

Spatial Delimitation

Strong Boundary Diffused Boundary Spatialised Boundary

10

S
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a
ce

 A
 A

p
p

ro
a

ch

•	 Boundary aimed at preventing movement and maintaining 
privacy

•	 Visual connection maintained to allow for surveillance 
•	 Acoustic threshold to accommodate private activity 

11

•	 Section approach 1 to plan 10

12

•	 Section approach 2 to plan 10 
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2. SPATIAL MATRIX
Building as Public Threshold

Spatial Sequence Spatial Geometry Spatial Topography Spatial Materiality 

0
1

•	 Size of space reduces as you transition into private 
space of the building

•	 Permeability of those spaces decreases as you 
transition in. This is reflected through controlling 
access and differentiation in openings

•	 Threshold distinguished by break in massing •	 Main entrance set back from boundary to create 
arrival landing 

•	 Contributes to public presence of the site
•	 Emphasizes the point of arrival

•	 Variation in floor surface finish
•	 Surface material to encourage movement towards 

threshold
•	 Hard surface finish

0
2

•	 Visual/physical access decreases as you transition 
from public to private

•	 Edge condition is defined through geometry
•	 Geometry holds edge to establish threshold

•	 Placement of public programme along arterial 
movement routes to feed activity onto site 
periphery

•	 Floor surface finish within roof overhang over 
threshold space

0
3

•	 Guiding elements used towards the main 
threshold into a space

•	 Change in floor surface as you transition towards 
your arrival point 

•	 Flat roof elements distinguish threshold space •	 Layering of buffer zones between public and 
private programme

•	 Design of public frontage to a private programme 
is intended to stimulate movement and prevent 
pausing

•	 Permeable material at the threshold to allow for 
visual permeability as first level of threshold into 
the site
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Fig. 2.6.2. Building as public threshold spatial matrix (Naidoo 2020)

2. SPATIAL MATRIX
Building as Public Threshold

Spatial Sequence Spatial Geometry Spatial Topography Spatial Materiality 

0
4

•	 Structural elements used as a mechanism to guide 
movement through building 

•	 These elements demarcate space

•	 Staggered massing frames threshold space •	 Layering of public programme as buffer between 
private and public

•	 Intended to activate site boundary 

•	 Exposure of material and structure at the threshold 
and points where public interacts with the 
architecture

0
5

•	 Along a transition/movement route, adjacent 
buildings narrow the pathway to encourage 
movement and widen to allow for moments of 
pause

•	 Roof overhang used to highlight the threshold •	 Widening of public pathways where the 
architecture allows for interaction with the public 
programme of the building 

•	 Exposure of material differentiation at the 
threshold

0
6

•	 Level change used to demarcate space an control 
movement 

•	 Thickening of material allows for deeper openings 
to articulate and emphasize the threshold
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3. SPATIAL MATRIX
Building for Pedagogy 

Plan Type Spatial Configuration Circulation 

In
te

n
tio

n

•	 Varied articulation of learning spaces allows for a range of individual 
to group activities (Hertzberger 2008). 

•	 Barret et al (2015) acknowledges this allowance for individualisation 
through flexibility as a key variable of the physical educational 
environment that enhances the learning experience.

•	 Plan type should accommodate differentiations in learning style 
through variations in room size, classroom articulation and flexibility 
of plan.

•	 The learning environment is suggested to represent that of a micro 
city with multiple opportunities for learning (Hertzberger 2008:69) 
and encourages interaction 

•	 Easy access to attached breakout spaces, well defined learning 
zones and wider corridors are some of the main physical elements 
that affect the learning experience (Barret et al 2015). 

•	 Emphasis is placed on social space to draw a parallel to the public 
space of the city (Hertzberger 2008). 

•	 Kuhn (2012) speaks to the spatial configuration of the learning 
environment and suggests the relevance of hierarchy by allowing for 
an intermediate learning space between the ‘classroom’ and school. 

•	 Approach to educational circulation as the ‘learning street’ (Dovey & 
Fisher 2014:43, Hertzberger 2008) . 

•	 Informal and formal learning environments are starting to be 
recognised as integral in the holistic learning development of a child. 

•	 The ‘learning street’ redefines corridors for interaction and provides 
multiple opportunities to learn in a variety of ways. 

•	 Circulation sits as the primary artery where the main elements are 
concentrated, allowing for passive surveillance of the school and 
learners to feel included (Hertzberger 2008). 

0
1

•	 Adjacent private learning spaces with an internal communal 
connecting space

•	 Staggering of buildings to frame courtyard spaces
•	 Provides opportunity for external learning in a new environment

•	 Circulation absorbs arm of built form to create a landing space which 
serves as shared space for learning

0
2

•	 Partition between adjacent learning spaces to allow for opportunity 
multiple learning arrangements

•	 Communal space serves a hierarchical role within the spatial 
configuration

•	 The volume encourages group learning activities and accommodates 
the communal activity

•	 Circulation widens at the entrance into a space to form a new internal 
zone
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Fig. 2.6.3. Building for pedagogy spatial matrix (Naidoo 2020)

3. SPATIAL MATRIX
Building for Pedagogy 

Plan Type Spatial Configuration Circulation 

0
3

•	 Main axis used to guide placement of building •	 Circulation widens to form external seating at the entrance into class-
room

•	 Opportunity for learners to socially engage 

0
4

•	 Private learning spaces buffered by communal learning zones •	 Central axis that is held at either end
•	 Building units along the axis fame internal courtyard space 
•	 Buildings absorb courtyards to create a series of semi private zones 

•	 Circulation widens to form a landing creating the opportunity for an 
external social zone 

0
5
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6.2 Final Response to Case Study: 
Tsako Thabo Secondary School

Fig. 2.6.4. Model image (Naidoo 2020)
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Fig. 2.6.5. Site plan. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.6. Roof plan. NTS. Original scale 1:100 (Naidoo 2020)



413Volume Two  |  Reflection412 413

Fig. 2.6.7. Model image of design response (Naidoo 2020)

Fig. 2.6.8. Model images of design response (Naidoo 2020)
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Fig. 2.6.9. Ground floor plan with footprint of existing highlighted. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.10. Model image from the north western perspective (Naidoo 2020)



419Volume Two  |  Reflection418 419

Fig. 2.6.11. Ground floor plan focusing on the main library intervention. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.12. Model images focusing on the main library 
intervention (Naidoo 2020)

Fig. 2.6.13. Model image focusing on the main entrance on the south eastern boundary (Naidoo 2020)
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Fig. 2.6.14. Section A cutting through the library and economic edge. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.15. North eastern perspective of economic edge (Naidoo 2020) Fig. 2.6.16. South eastern elevation of the library intervention. Image style adopted from Macfarlane (2020) (Naidoo 2020)
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Fig. 2.6.17. North eastern perspective of the economic edge (Naidoo 2020)
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Fig. 2.6.18. South eastern perspective of the economic edge (Naidoo 2020) Fig. 2.6.19. South western perspective of the economic edge (Naidoo 2020)
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Fig. 2.6.20. Roof plan of the public interface of the main library and economic edge intervention . NTS. Image style adopted 
from Macfarlane (2020) (Naidoo 2020)
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Fig. 2.6.21. South Western perspective of the economic edge (Naidoo 2020) Fig. 2.6.22. South eastern perspective of the library and economic edge (Naidoo 2020)
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Fig. 2.6.23. Ground floor plan focusing on the administration and hall. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.24. Perspective of the main entrance into the school (Naidoo 2020)

Fig. 2.6.25. Administrative block perspectives (Naidoo 2020)
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Fig. 2.6.26. Section B cutting through the reception. NTS. Original scale 1:100 (Naidoo 2020) Fig. 2.6.27. Model image (Naidoo 2020)
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Fig. 2.6.28. Ground floor plan focusing on alterations to the existing. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.29. Model images of the classroom blocks (Naidoo 2020)
Fig. 2.6.30. School courtyard (Naidoo 2020)
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Fig. 2.6.31. Section C cutting through classrooms and administration. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.32. North western perspective of classroom blocks (Naidoo 2020)
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Fig. 2.6.33. Ground floor plan focusing on skills centre. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.34. Model image of the skills centre (Naidoo 2020)

Fig. 2.6.35. Model images of the skills centre (Naidoo 2020)
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Fig. 2.6.36. First floor plan. NTS. Original scale 1:100 (Naidoo 2020)
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Fig. 2.6.37. 1:100 sectional model through the library to illustrate structure and internal quality (Naidoo 2020)
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Fig. 2.6.38. Technical section C. NTS. Original scale 1:20 (Naidoo 2020)
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Fig. 2.6.39. 1:100 sectional model through the library to illustrate structure and internal quality (Naidoo 2020)
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Fig. 2.6.40. Technical section C. NTS. Original scale 1:20 (Naidoo 2020)
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Fig. 2.6.41. Technical section C. NTS. Original scale 1:20 (Naidoo 2020)
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Fig. 2.6.42. Detail A. NTS. Original scale 1:10 (Naidoo 2020)

Fig. 2.6.43. Detail B. NTS. Original scale 1:10 (Naidoo 2020)

Fig. 2.6.44.  1:100 sectional model through the library to 
illustrate structure and internal quality (Naidoo 2020)
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Fig. 2.6.45. 1:100 sectional model through the library to illustrate structure and internal quality (Naidoo 2020)

Fig. 2.6.46. Detail C. NTS. Original scale 1:10 (Naidoo 2020)

Fig. 2.6.47. Detail D. NTS. Original scale 1:10 (Naidoo 2020)

Fig. 2.6.48. Detail E. NTS. Original scale 1:10 (Naidoo 2020)
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Fig. 2.6.49. Model image of design intervention built at 1:500 (Naidoo 2020) Fig. 2.6.50. Model image of design intervention built at 1:500 (Naidoo 2020)
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Fig. 2.6.51. Model image of design intervention built at 1:500 (Naidoo 2020)
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7.1 Conclusion

With an increased awareness of the physical 
educational environment, it is crucial for the 
architectural discipline to establish a spatial 
standard. This input should be in response to the 
dynamic growth within education towards lifelong 
learning. The lack of spatial development of public 
schooling typologies in South Africa has been 
problematic in this regard. 

Establishing a community-school relationship is 
integral to the holistic development of a learner. 
Participatory Action Research (PAR) findings 
support the notion for an integrated community 
school relationship. However, as a result of policy 
stipulations, such as the boundary guidelines, 
the built educational environment is doing little 
to stimulate this relationship. Therefore, it can 
be concluded that there is a causal impact of 
policy on the typology of schools and thus the 
relationship between community and school. 
The lack of relationship has a detrimental impact 
on encouraging lifelong learning and is a crucial 

aspect addressed in the dissertation.  

This dissertation intimately investigated the 
spatial consequences of architecture on the 
educational ecosystem. This was achieved through 
a typological investigation into the methods of 
building as public threshold and building for 
pedagogy, in the context of Mamelodi East. The 
dissertation set out to develop a spatial matrix to 
address the redefinition of typology, in relation to 
the above mentioned themes, to achieve lifelong 
learning. This was achieved through:

•	 Establishing a set of criteria from a literature 
overview to understand how typology is 
addressed within each theme

•	 Analysing the existing built educational 
environment through the established criteria

•	 Studying precedents for methods of 
approaching the criteria

•	 Distilling informants from PAR and co-design 
game application 
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•	 Testing the application of surfaced 
mechanisms on the case study school, 
Tsako Thabo Secondary School, through an 
exploratory process

•	 Synthesizing the surfaced mechanisms into 
design principles categorized according to the 
established criteria

This process resulted in a table (spatial matrix) 
which highlighted a distilled set of design 
principles to respond to varied conditions on site. 
Design principles from the matrix were applied 
to Tsako Thabo Secondary School, as a case 
study, to illustrate how the matrix serves as a 
guide. Through developing spatial mechanisms 
for building as a public threshold and building for 
pedagogy, the dissertation objective was achieved.

The developed architectural language of the 
matrix was further elaborated through the technical 
concept of the dissertation. Interaction between 
building elements took on a symbolic nature to 
depict the relationship between the architecture 
and the intimacies of its construction. The technical 
and design approaches reflected each other by 
consisting of a series of elements articulated 
through their varied configurations, according to 
the presented conditions. 

Ultimately lifelong learning is achieved by 
stimulating interaction between a community 
and its school through the tangible (spatial) built 
environment. The spatial principles presented 
are directed towards encouraging this intangible 
(non-spatial) relationship by providing various 
mechanisms to encourage and mediate interaction 
between a school and its context. In doing so, it 
responds to the concept of publicly redefining 
a school within its context. Through developing 
the design principles according to typological 
criteria, the outcome of the study was not isolated 
to a particular school and could inform similar 
typological schools. 

Two major contributions from the dissertation have 
been the spatial matrix and research into digital 
and analogue design games in the co-design 
process. The investigation and varied medium 
approach to design games is a contributing factor 
to co-design discourse. This is particularly relevant 
in the changing dynamic of researcher-participant 
interaction in light of the COVID-19 pandemic. 

The spatial matrix is an important contribution to 
South African educational policy for public school 
infrastructure. It provides the necessary spatial 
definition to achieve the government’s intention 
for lifelong learning. It also has the potential to 
stimulate the learning environment and position 
public schools as collective urban entities. 
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Fig. 2.7.1. Model image of design intervention built at 1:500 (Naidoo 2020)
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THE UNIT FOR URBAN CITIZENSHIP STUDIO_MAMELODI
GROUP INTRODUCTION

Involvement in NRF Research Project “Stitching the City”

Lauren Konstantinou, Purll Naidoo and Kelsey Smith are personally involved in 
an ongoing NRF Research Project, titled ‘Stitching the City” 

The research project involves a collaboration between the architecture 
departments of Chalmers University of Technology, in Sweden, and University 
of Pretoria, in South Africa. 

The intention of the project is to develop a data collection methodology 
that results in efficient storage of collected information in an online data 
warehouse. This data warehouse allows for layers of information to be 
accumulated each year and easily accessed. 

As part of our dissertation outcome, we have contributed to the creation of 
the ukuDoba Method, which we have applied to our individual dissertations 
as a research methodology

Purll NaidooLauren Konstantinou Kelsey Smith

UKUDOBA
Timeline
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UKUDOBA
Timeline
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ukuDoba 
Methodology

Version 1.0

A Methodological Framework for Effective Data 
Collection and storage



499Appendix B498 499

Preface

The ukuDoba handbook is the outcome of the 
Swedish-South African project “Stitching the City” 
that integrates education and research. The project 
aims at developing a method and digital library of 
geolocated data for knowledge facilitation to support 
data re-use in architectural courses. It also aims at 
establishing a collaboration between the University of 
Pretoria, South Africa, and the Chalmers University of 
Technology in Gothenburg, Sweden. 

 “Stitching the City” has been hosted by the 
course Planning and Design for Social Inclusion in 
Gothenburg (2019 and 2020) and the Urban Citizen 
studio in Pretoria (2020). Many thanks Emilio and 
Carin!

ukuDoba has been tested in field studies by students 
in two areas: Mamelodi-East in the City of Tshwane 
and Hammarkullen in Gothenburg and the handbook 
has been developed by the six master students in 
an iterative process. Thank you, Robin, Lauren, Purll, 
Mumtaheena, Kelsey and Markus for your invaluable 
work! Without you, no handbook.

A special thank you goes also to Cameron and 
Victoria for development of the GeoNode structure 
to store and share our data. Finally, thank you Marco, 
Monica, Serena for your support and constructive 
input. 

Liane & Chrisna
October 2020

Preface

Swedish team - Chalmers University 
of Technology:
Liane Thuvander, project leader
Marco Adelfio
Emilio Brandao
Monica Billger
Department of Architecture and Civil Engineering

South African team - University of Pretoria:
Chrisna du Plessis, project leader
Carin Combrink
Department of Architecture
Serena Coetzee 
Victoria Rautenbach
Cameron Green
Department of Geography, Geoinformatics and Meteorology

The research has been financed by The Swedish Foundation 
for International Cooperation in Research and Higher 
Education (STINT) and South Africa’s National Research 
Foundation (NRF).
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ukuDoba

Over time, physical maps and folders are 
being stacked in bookshelves. This format 
of data collection is difficult to access 
and build upon. Year, after year, these 
research processes are repeated, by both 
universities,  leaving layers of rich data 
disjointed.

ukuDoba - the methodological framework, 
has been developed for the collection and 
sharing of non-traditional types of spatial 
economic data at a street and precinct 
level in an online platform. These cross-
disciplinary micro-data can be layered and 
easily accessed by researchers from different 
disciplines as well as students and community 
members.

ukuDoba

The methodological framework, ukuDoba, 
and online platform, Geonode, are 
currently being tested in two study areas: 
Mamelodi East in Tshwane, South Africa 
and Hammarkullen in Gothenburg, 
Sweden.

Here, we present a step by step guide 
to follow the ukuDoba methodology of 
how to effectively digitally collect, convert 
and store data in an online platform, 
GeoNode. 

In Zulu the word ukuDoba means ‘fishing’. 
With this booklet, we hope to help users 
‘fish’ for the data they need for their 
project.
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10

Data Collection

• Kobo Toolbox is an open access Digital data collection tool that allows you to 
create a questionnaire that can be downloaded to your mobile device, filled in 
on the ground, offline, and geo-referenced on site. You can take  photographs, 
record video and voice clips, or write text.

• After fieldwork, you can then upload the data to the internet over WiFi and 
access the data via your computer. This data can then be shared with others and 
they can then use it or edit it.

• Other tools used for similar data collection are: Maptionnaire, FieldPapers, 
EpiCollect5 etc.

• Communities to share their knowledge.
• To digitally store data in a Digital platform (easier to access and use).
• To geolocate collected data

What?

Why?

11

Data Collection

• Always collect data in groups of three 
people. 

• The first person is in charge of taking 
notes and should focus on gathering 
data using the data collections tool.

• The second person is in charge of 
leading the interview and can have the 
questions open on their phone as a 
guide. 

• The third person is in charge of 
documentation of the process and 
takes pictures, video and audio 
records.

How?
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12

KoBo Toolbox

1. Use your computer to start. You will only use 
your phone when filling out the form on site.

2. https://www.kobotoolbox.org/  > Scroll down  
> Researchers, Aid Workers and Everyone 
Else > Create an Account > Verify in email 

1. Open KoBo Toolbox on your computer 
browser > New > Build from Scratch > Fill in

2. Project Name > Use a set format (e.g. 2020_
Location_Project Name) > Create Project

3. “+” > types of questions (see glossary for 
types of questions)

• Question 1: select  Acknowledge 
question (digital consent for 
interview). See example below:

• Question 2: select Point question 
(current location of interview).

• Question Settings > Mandatory 
Response > Yes (Question 1 and 
Question 2)

Getting started

Creating a questionnaire

I hereby voluntarily grant permission for participation in this project, as explained to me 
by the researcher. I am aware that the results of the investigation may be used for the 
purposes of publication. I will remain anonymous: my comments may be used without 
giving any geographic or personal references (name, address, ID, occupation, age, income 
etc) that may accidentally imply my identity.

4. Layout and Settings > Select Start Time and 
End Time

5. Save & Preview
6. Return to List (top left corner)

13

KoBo ToolboxKoBo Toolbox

Glossary: Question Types & Examples

Point: tracks your current location*

Acknowledge: gives consent to the interview*

Text: add in between questions for additional notes

Quantitative Tools examples:
How many children do you have? 
Which ones are applicable to you?

Qualitative Tools examples:
How would you rate this park?
When did the music festival happen?

Media: captures images, sounds and videos

Line and Area: highlights a route or area

* Make these questions mandatory to fill in. 

Note: Some tools present challenges in application due to internet 
access and device compatibility.
_______________________________________________________________________
Calculate tool example: 

“How many girls?” ► Settings ► Data column name ► “girls”

“How many boys?”► Settings ► Data column name ► “boys”

${girls} + ${boys} ► Settings ► Data column name ►”total_children”

“There are ${total_children} in this room.” 
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Point: tracks your current location* 

Acknowledge: gives consent to the interview* 

Text: add in between questions for additional notes 

Quantitative Tools examples: 
  How many children do you have?  
  Which ones are applicable to you? 

Qualitative Tools examples: 
  How would you rate this park? 
  When did the music festival happen? 

Media: captures images, sounds and videos 

Line and Area: highlights a route or area 
 

Glossary: question types & examples

Calculate tool example: 

“How many girls?” > Settings > Data column name > “girls”

“How many boys?” > Settings > Data column name > “boys”

${girls} + ${boys} > Settings > Data column name > ”total_
children”

“There are ${total_children} in this room.” 

* Make these questions mandatory to fill in.  

Note: Some tools present challenges in application due to internet access and 
device compatibility.



511Appendix B510 511

14

KoBo Toolbox

KoBo Toolbox
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“Which colour is your favourite?” 
• Blue
• Red 
• Yellow 
• Other 

“If other, explain.”

To use your questionnaire

1. Menu > Draft > Your Project > Deploy
2. To share with others: Hover over project name 

> share icon (right hand side)

Carry-on question example

Settings of question > Skip Logic > Add a Condition > Select a Question 
> “Which colour is your favourite?” > “Other”
Now the text box question will only pop up if “other” is selected.

15

KoBo Toolbox

Android Users: “Android Application”
Download KoboCollect > Follow instructions on KoBo Toolbox  to open form   
(enter given unique URL) > To fill in form on your phone: Fill in blank form

iOS Users: “Online-Offline (multiple submission)”
Click Open > copy URL of form > Open https://www.the-qrcode-generator.com/ in a 
new tab > select URL > paste URL of form > Save > scan QR Code on phone to open 
form

1. Internet access needed to open form on phone
2. No internet access needed when using form in field 

 
Note: Save form as Draft if editing needs to be done after the interview. 

Data collection

There are two ways to collect data. Follow the relevant steps:
Collect Data > dropdown options
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KoBo Toolbox

After collection

Step 1 Complete

1. Edit data before uploading forms.
2. Android Users: 

 To Edit = Edit Saved Form 
 To Upload = Send Finalized 
Form >    Select All > Send Selected 
 
iOS Users: 
 To Edit = Save form as draft > 
Select    form in side menu > edit 
it 
 To Upload = Open side menu > 
Select   Forms > Upload (iPhone 
will automati  cally upload forms when 
connected to   internet if not saved as 
draft) 

3. Desktop PC > Kobo website > Deployed > 
Your Project 

4. Summary of data collected > Data > 
Reports

5. Downloads > Export Type > CSV (Legacy) > 
New Export > Pending >  Click to Refresh 
> click the file link to download 2Data Conversion
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Data Conversion

What?

Why?

A geographic information system (GIS) is a framework which provides a platform for 
users to engage with spatial data, through analysis and editing. There are alternative 
platforms that can perform this function, however we will use QGIS as it is a free 
service, making it more accessible to a wider range of people.   

For the purpose of this framework, QGIS will be used to convert the data  into a 
usable file type that can be imported and stored in the data warehouse GEONODE.

19

QGIS

Getting started

Importing CSV Legacy files

Download QGIS Standalone Installer Version 3.10 (64 bit)  > Install QGIS > Run QGIS

1. Open QGIS application on your computer > Project tab > New
2. Side Browser Menu > Drop down tab XYZ Tiles  > Right click on Openstreetmap 

> Add Layer to project 

3. Main menu > Layer tab > Add Layer > Add Delimited Text layer 



517Appendix B516 517

20

QGIS

4. File name > Click (...) to browse > Select your CSV (Legacy) File > Open

5. Drop down tab > File Format > select CSV (comma separated values)
6. Drop Down tab > Geometry definition > Select Geometry CRS = Project CRS: 

EPSG:4326-WGS 84 > Select X field = Longitude and Y field = Latitude > Add > 
Close window 
 
Note:  
Once editing the X and Y fields, if the points appear on a blue screen then delete 
your imported CSV (legacy) layer, re-import it and let X field= Latitude and Y field 
= Longitude. 
If you do not use a CSV legacy file, you will not have the option to select the x   
and y fields.

21

QGIS

Exporting ESRI shape files

Notes

Tips

1. Layers Menu > Insure Openstreetmap layer is  below your Layer
2. Right click on your layer > Export > Save feature as
3. Create a new folder on your computer with your project name to export your 

shapefiles to
4. Drop down tab Format > Select ESRI Shapefile > File Name > Click (...) to browse 

> Write your file name > Drop down tab CRS  > Select Project CRS: EPSG:4326 - 
WGS 84 > Ok 
(There should be 6 shapefiles exported)

There is no need to save QGIS files as the only files that 
are required are the ESRI Shapefiles that you export.

To learn more check the Youtube tutorial:  
https://www.youtube.com/watch?v=sQ2z-D8TN2E

Step 2 Complete
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Data Warehouse

What?

GeoNode is a web-based application and platform that facilitates the creation, 
sharing and collaborative use of geospatial and non-geospatial data.

The Geospatial data can be stored as Layers, formats that GeoNode supports:
Shapefiles & its associated files (.cpg, .dbf, .prj, .qpj, .shp, .shx)
GeoTiffs (.tiff, .tif)
American Standard Code for Information Interchange (ASCII)
The Non-geospatial data can be stored as Documents, formats that GeoNode 
supports:
Microsoft Word (.doc & .docx), Powerpoint (.ppt & .pptx), Excel (.xls & .xlsx)
Image Formats (.gif, .jpg, .jpeg, .png, .tiff, .tif)
OpenDocument File Formats (.ods, .odt,. odp)
Portable Document Format (.pdf)
Compressed Files (.rar, .zip, .gz)
Markup Languages (.sld, .xml, .qml)
Text documents (.txt)

Both of these could be linked with each other. Also documents that are non-
spatial in nature can still be uploaded to GeoNode and then linked to a spatial file 
afterwards.

You are able to take all other files that are not individually supported and create a 
.zip file in order to upload them.
(Cheat file : .zip file)

25

Data Warehouse

Why?

To store and share the data we collectected with geolocation in an open source 
platform.
To manage and catalogue geospatial data and keep track of metadata. Each dataset 
in the system can be shared publicly or restricted to allow access to only specific 
users. 
To manage and share data if the project is occurring over several years such as a 
longitudinal study so that the data can be used for numerous years after the date of 
collection as long as it is labelled and managed correctly.
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Uploading layers

Geonode

Getting started
Please refer to The Stitching the City geonode link and not the genode 
demo when the document refers to geonode.

Open Geonode (https://geocatalogue.co.za/) 
Register ► Wait for approval ► Sign In
Main Menu ► About ► People  ► Find other users and yourself
(Edit your profile to include your contact information)

Geonode (Stitching the City QR Code)

26

GeoNode

Getting started

Please refer to The Stitching the City GeoNode link and not the GeoNode demo 
when the document refers to geonode.

1. Main Menu > Data > Upload Layer
2. Drag the shapefiles and its associated files in 

Drop files here. 
(Exported from previous tool, eg: QGIS/Kobo, 
make sure all six file types are there - .cpg, .dbf, 
.prj, qpj, shp, shx. and avoid duplicates.)

3. Permission > Select Users and Groups in all 
tabs > Upload Files 
(To control who you want to share the collected 
data with.)

4.  Inspect Data > Next  
(Recheck the list of data uploaded and edit if 
needed. Leave Advanced tabs on default.)

5. Layer uploaded. 
(Find the preview window, Infos, Attributes. 
You can Share, Rate, Comment or make it 
Favourite)

6. Editing tools > Styles > Edit > Edit if needed 

(Stitching the City QR Code)

Open GeoNode (https://geocatalogue.co.za/) 
Register > Wait for approval > Sign In
Main Menu > About > People > Find other users 
and yourself
(Edit your profile to include your contact 
information)
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GeoNode

7. Editing tool > Metadata > Wizard
8. Edit > Fill in Basic Metadata > Fill in Location and Licences > Fill in Optional 

Metadata  > Fill in Dataset attributes 
(Make sure you go through all the mandatory boxes as everything you input here 
is important for documentation accuracy and for other users who will be looking 
for data.)

9. Preview > Check.
10. Settings > Edit if needed, or leave it default.
11. Update > Return to Layer

Uploading documents

1. Main menu  > Data  > Upload Document.
2. Create a Title > Browse the File > Add URL, if needed.
3. Permission > Select Users and Groups in all tabs  

(To control who you want to share the collected data with.)
4. Link to > Choose Layer/ Map > Upload.
5. Edit Metadata (Follow the same steps as Layer.)
6. Document uploaded. 

(Find the Infos. You can Share, Rate, Comment or make it Favourite)
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GeoNode

Creating map

1. (Single layer) Go to your Layer > Create a Map 
Or, (Multiple layers) Main menu  > Data  > Layers > Click (+) and select the Layers 
> Create a Map

2. Layers > Edit if needed
3. Options > Save as  > Edit Properties > Fill in > Save
4. Map added

29

GeoNode

Linking documents to layer/map

Downloading layer/ documents

1. Go to your Document > Edit Document > Metadata > Advanced Edit (You can 
use the Wizard)

1. (Layer) Go to your Layer > Download Layer > Select File type/ format.
2. Or, (Document) Go to your Document > Download Document.

2. Link to > Choose Layer/ Map > Update
3. Document Linked. 

(Check in your Layer page if the document is there)



527Appendix B526 527

30

Geonode

Tips
● Select appropriate file names when renaming Layers, Maps and 

Documents to ensure that data is kept clean.
● Fill out the metadata as best as you can, be as descriptive as 

possible as that will help identify files later. If you are unsure of 
anything you can fix it later.

● Set permissions for each layer, this is important for data security. 
The default is set to 'Anyone', meaning that anyone who can log 
in can edit the data.

● Use all the tagging and legend options to make the data filter 
process convenient for users.

● For linking multiple files as Documents to one Layer or Map, 
upload them as a zip folder rather than uploading separate files.

● To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-S
TINT_Wiki/blob/master/README.md)

(CDL WIKI  QR Code)

Step 3 Completed
33

GeoNode

Tips

• Select appropriate file names when 
renaming Layers, Maps and Documents to 
ensure that data is kept clean.

• Fill out the metadata as best as you can, 
be as descriptive as possible as that will 
help identify files later. If you are unsure of 
anything you can fix it later.

• Set permissions for each layer, this is 
important for data security. The default is 
set to ‘Anyone’, meaning that anyone who 
can log in can edit the data.

• Use all the tagging and legend options to 
make the data filter process convenient for 
users.

• For linking multiple files as Documents to 
one Layer or Map, upload them as a zip 
folder rather than uploading separate files.

To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-STINT_
Wiki/blob/master/README.md)

Step 3 Complete
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ukuDoba 
Methodology

A Methodological Framework for Effective Data 
Collection and storage

Version 2.0

Preface

The ukuDoba handbook is the outcome of the 
Swedish-South African project “Stitching the City” 
that integrates education and research. The project 
aims at developing a method and digital library of 
geolocated data for knowledge facilitation to support 
data re-use in architectural courses. It also aims at 
establishing a collaboration between the University of 
Pretoria, South Africa, and the Chalmers University of 
Technology in Gothenburg, Sweden. 

 “Stitching the City” has been hosted by the 
course Planning and Design for Social Inclusion in 
Gothenburg (2019 and 2020) and the Urban Citizen 
studio in Pretoria (2020). Many thanks Emilio and 
Carin!

ukuDoba has been tested in field studies by students 
in two areas: Mamelodi-East in the City of Tshwane 
and Hammarkullen in Gothenburg and the handbook 
has been developed by the six master students in 
an iterative process. Thank you, Robin, Lauren, Purll, 
Mumtaheena, Kelsey and Markus for your invaluable 
work! Without you, no handbook.

A special thank you goes also to Cameron and 
Victoria for development of the GeoNode structure 
to store and share our data. Finally, thank you Marco, 
Monica, Serena for your support and constructive 
input. 

Liane & Chrisna
October 2020
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ukuDoba

Over time, physical maps and folders are 
being stacked in bookshelves. This format 
of data collection is difficult to access 
and build upon. Year, after year, these 
research processes are repeated, by both 
universities,  leaving layers of rich data 
disjointed.

ukuDoba - the methodological framework, 
has been developed for the collection and 
sharing of non-traditional types of spatial 
economic data at a street and precinct 
level in an online platform. These cross-
disciplinary micro-data can be layered and 
easily accessed by researchers from different 
disciplines as well as students and community 
members.
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ukuDoba

The methodological framework, ukuDoba, 
and online platform, Geonode, are 
currently being tested in two study areas: 
Mamelodi East in Tshwane, South Africa 
and Hammarkullen in Gothenburg, 
Sweden.

Here, we present a step by step guide 
to follow the ukuDoba methodology of 
how to effectively digitally collect, convert 
and store data in an online platform, 
GeoNode. 

In Zulu the word ukuDoba means ‘fishing’. 
With this booklet, we hope to help users 
‘fish’ for the data they need for their 
project.

The ukuDoba  

Methodology

Data
Collection

Maptionnaire

Data
Conversion

QGIS

Data
Warehouse

Geonode
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Data Collection

• Maptionnaire is a paid subscription based service that allows you to create 
questionnaires that can be sent out to participants or be filled in out on the field 
by yourselves. It is georeferenced and supports multiple types of media.

• After fieldwork, you can access the data via your computer. This data can then be 
shared with others and they can use it or edit it.

• Other tools used for similar data collection are: Kobo Toolbox, FieldPapers, 
EpiCollect5 etc.

• Let communities to share their knowledge
• To digitally store data in a Digital platform (easier to access and use)
• To geolocate collected data

What?

Why?
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Data Collection

• Always collect data in groups of three 
people. 

• The first person is in charge of taking 
notes and should focus on gathering 
data using the data collections tool.

• The second person is in charge of 
leading the interview and can have the 
questions open on their phone as a 
guide. 

• The third person is in charge of 
documentation of the process and 
takes pictures, video and audio 
recordings.

• It is important to have a dialogue 
between the interviewer and 
interviewee. 

• This could be ensured by sending the 
questionnaire link online for people to 
fill up and discussing / having dialogue 
over the phone or internet with audio 
calls. 

• Filling up the questionnaire together 
and discussing / having dialogue with 
video calls, sharing screens options 
can help.

• If multiple participants need to fill out 
the same form in the same browser, 
they have to use incognito mode

How?

On-site collection

Remote collection

12

Maptionnaire

• Use your computer to start. You can only use 
your smartphone or tablet for collecting data

• Visit the link below to log in 
https://app.maptionnaire.com/en/login/

1.  Questionnaire > Create new 
2.  Edit > Fill in Name and Description  

(This is the first page people would see, so introduction, background and 
purpose should be included in the description)

3.  Pages > (+) > Create at least 3 pages
4. Write Page names for all pages 

(Suggested as ‘Consent’, ‘Name of Survey’, ‘Thanks for Participating’)
5. First page > (+) > Multiple choice question > Question > Choose one > Type 

in your consensual agreement in the question box and create two options “Yes” 
and “No”

6. Next page > (+) > Select the types of questions (see glossary for types of 
questions) > Click the Question to edit

7. Last page > (+) > Paragraph of Text > Type in a note of thanks with the contact 
info of your team for further inquiries > Page settings > Check “This is an 
exit page (Additional questions could be added such as, asking for reasons if 
answered no to the consent)

Getting started

Creating a questionnaire
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Maptionnaire

Carry-on 
Creating a questionnaire

8.  Branching rules at the top > Triggering question > Select your 
triggering question > Triggering answers > Choose Yes > Choose 
target page > Choose “Name of survey” > Save > Go back to Edit  
(Using branching rules are not recommended to use with individual 
questions, only pages)

9.  Location at the beginning under the pages> Set your site area 
(This is the default background of your questionnaire pages, could be 
changed for each page in the settings tab)

10.  Maps > Select the type of map
11.  General Settings > Edit as per your preferences > Find the link for  the 

questionnaire > Set a Questionnaire Password if you want limited 
access > Go back to Edit

12.  Data and Privacy settings > Edit as per your preferences
13.  Style settings > Edit the style of your questionnaire
14.  Language settings > Select the additional language, if needed> Click 

Translate to add all the questions in selected language > Save 
15.  View > Check the questionnaire

Note:
Make sure to keep your form clean of 
unnecessary datapoints before deploying 
the questionnaire. This will ensure effective 
collection of data, save you time during 
analysis, and keep the participants engaged.
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Maptionnaire

Setting up background maps for forms

1.  Location at the beginning > zoom in to set the viewport > save
2. Under Maps you tick the boxes you want your participants to be able to toggle 

between
• If you wish to set a different map for only one of your pages:  

Click the page > Click settings > follow the steps above

I hereby voluntarily grant permission for participation in this project, as explained to me 
by the researcher. I am aware that the results of the investigation may be used for the 
purposes of publication. I will remain anonymous: my comments may be used without 
giving any geographic or personal references (name, address, ID, occupation, age, income 
etc) that may accidentally imply my identity.

KoBo Toolbox

Glossary: Question Types & Examples

Point: tracks your current location*

Acknowledge: gives consent to the interview*

Text: add in between questions for additional notes

Quantitative Tools examples:
How many children do you have? 
Which ones are applicable to you?

Qualitative Tools examples:
How would you rate this park?
When did the music festival happen?

Media: captures images, sounds and videos

Line and Area: highlights a route or area

* Make these questions mandatory to fill in. 

Note: Some tools present challenges in application due to internet 
access and device compatibility.
_______________________________________________________________________
Calculate tool example: 

“How many girls?” ► Settings ► Data column name ► “girls”

“How many boys?”► Settings ► Data column name ► “boys”

${girls} + ${boys} ► Settings ► Data column name ►”total_children”

“There are ${total_children} in this room.” 
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Drawbutton: mark out points, highlight a route or area, upload a  
 media file 

Multiple choice: choose one, choose many, dropdown, priority  
  assessment

Open question: big answer field, small answer field 

Number questions: integer numbers, string of digits, decimal   
     numbers, range of numbers 

Video & document: link a video from youtube or upload your own  
    to show inbetween questions

Paragraph or text: add in between questions for additional   
   information to participants 

Glossary: question types & examples
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Maptionnaire

To use your questionnaire

Simply distribute the link to the web-based 
questionnaire to allow participants to fill it in 
and start collecting your data!

Branching questions

Using skip logic in your survey is a great way of controlling the navigation in the 
form depending on what the answers are.

The most important thing to consider is that the target answer is a page and that 
it is only compatible with multiple choice questions. Be careful with using the 
branching as it can lead to undesireable outcomes in the collected data.

After collection

1. Find your questionnaire > Response Data  
> Analyze > Check and edit if needed

2. Find your questionnaire > Response Data 
> Download > Download ESRI Shape file

Step 1 Complete
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2Data Conversion
If your chosen data collection tool does 
not provide a shapefile or if you for some 
other reason have a csv file that needs to be 
geolocated, follow this portion of the handbook. 
Maptionnaire provides shapefiles in the file-
format .shp

18

Data Conversion

What?

Why?

A geographic information system (GIS) is a framework which provides a platform for 
users to engage with spatial data, through analysis and editing. There are alternative 
platforms that can perform this function, however we will use QGIS as it is a free 
service, making it more accessible to a wider range of people.   

For the purpose of this framework, QGIS will be used to convert the data  into a 
usable file type that can be imported and stored in the data warehouse GEONODE.
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QGIS

Getting started

Importing CSV Legacy files

Download QGIS Standalone Installer Version 3.10 (64 bit)  > Install QGIS > Run QGIS

1. Open QGIS application on your computer > Project tab > New
2. Side Browser Menu > Drop down tab XYZ Tiles  > Right click on Openstreetmap 

> Add Layer to project 

3. Main menu > Layer tab > Add Layer > Add Delimited Text layer 

20

QGIS

4. File name > Click (...) to browse > Select your CSV (Legacy) File > Open

5. Drop down tab > File Format > select CSV (comma separated values)
6. Drop Down tab > Geometry definition > Select Geometry CRS = Project CRS: 

EPSG:4326-WGS 84 > Select X field = Longitude and Y field = Latitude > Add > 
Close window 
 
Note:  
Once editing the X and Y fields, if the points appear on a blue screen then delete 
your imported CSV (legacy) layer, re-import it and let X field= Latitude and Y field 
= Longitude. 
If you do not use a CSV legacy file, you will not have the option to select the x   
and y fields.
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QGIS

Exporting ESRI shape files

Notes

Tips

1. Layers Menu > Insure Openstreetmap layer is  below your Layer
2. Right click on your layer > Export > Save feature as
3. Create a new folder on your computer with your project name to export your 

shapefiles to
4. Drop down tab Format > Select ESRI Shapefile > File Name > Click (...) to browse 

> Write your file name > Drop down tab CRS  > Select Project CRS: EPSG:4326 - 
WGS 84 > Ok 
(There should be 6 shapefiles exported)

There is no need to save QGIS files as the only files that 
are required are the ESRI Shapefiles that you export.

To learn more check the Youtube tutorial:  
https://www.youtube.com/watch?v=sQ2z-D8TN2E

Step 2 Complete
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3Data Warehouse
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Data Warehouse

What?

GeoNode is a web-based application and platform that facilitates the creation, 
sharing and collaborative use of geospatial and non-geospatial data.

The Geospatial data can be stored as Layers, formats that GeoNode supports:
Shapefiles & its associated files (.cpg, .dbf, .prj, .qpj, .shp, .shx)
GeoTiffs (.tiff, .tif)
American Standard Code for Information Interchange (ASCII)
The Non-geospatial data can be stored as Documents, formats that GeoNode 
supports:
Microsoft Word (.doc & .docx), Powerpoint (.ppt & .pptx), Excel (.xls & .xlsx)
Image Formats (.gif, .jpg, .jpeg, .png, .tiff, .tif)
OpenDocument File Formats (.ods, .odt,. odp)
Portable Document Format (.pdf)
Compressed Files (.rar, .zip, .gz)
Markup Languages (.sld, .xml, .qml)
Text documents (.txt)

Both of these could be linked with each other. Also documents that are non-
spatial in nature can still be uploaded to GeoNode and then linked to a spatial file 
afterwards.

You are able to take all other files that are not individually supported and create a 
.zip file in order to upload them.
(Cheat file : .zip file)
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Data Warehouse

Why?

To store and share the data we collectected with geolocation in an open source 
platform.
To manage and catalogue geospatial data and keep track of metadata. Each dataset 
in the system can be shared publicly or restricted to allow access to only specific 
users. 
To manage and share data if the project is occurring over several years such as a 
longitudinal study so that the data can be used for numerous years after the date of 
collection as long as it is labelled and managed correctly.

26

Uploading layers

Geonode

Getting started
Please refer to The Stitching the City geonode link and not the genode 
demo when the document refers to geonode.

Open Geonode (https://geocatalogue.co.za/) 
Register ► Wait for approval ► Sign In
Main Menu ► About ► People  ► Find other users and yourself
(Edit your profile to include your contact information)

Geonode (Stitching the City QR Code)

26

GeoNode

Getting started

Please refer to The Stitching the City GeoNode link and not the GeoNode demo 
when the document refers to geonode.

1. Main Menu > Data > Upload Layer
2. Drag the shapefiles and its associated files in 

Drop files here. 
(Exported from previous tool, eg: QGIS/Kobo/
Maptionnaire, .cpg, .dbf, .prj, qpj, shp, shx. and 
avoid duplicates.)

3. Permission > Select Users and Groups in all 
tabs > Upload Files 
(To control who you want to share the collected 
data with.)

4.  Inspect Data > Next  
(Recheck the list of data uploaded and edit if 
needed. Leave Advanced tabs on default.)

5. Layer uploaded. 
(Find the preview window, Infos, Attributes. 
You can Share, Rate, Comment or make it 
Favourite)

6. Editing tools > Styles > Edit > Edit if needed 

(Stitching the City QR Code)

Open GeoNode (https://geocatalogue.co.za/) 
Register > Wait for approval > Sign In
Main Menu > About > People > Find other users 
and yourself
(Edit your profile to include your contact 
information)
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GeoNode

7. Editing tool > Metadata > Wizard
8. Edit > Fill in Basic Metadata > Fill in Location and Licences > Fill in Optional 

Metadata  > Fill in Dataset attributes 
(Make sure you go through all the mandatory boxes as everything you input here 
is important for documentation accuracy and for other users who will be looking 
for data.)

9. Preview > Check.
10. Settings > Edit if needed, or leave it default.
11. Update > Return to Layer

Uploading documents

1. Main menu  > Data  > Upload Document.
2. Create a Title > Browse the File > Add URL, if needed.
3. Permission > Select Users and Groups in all tabs  

(To control who you want to share the collected data with.)
4. Link to > Choose Layer/ Map > Upload.
5. Edit Metadata (Follow the same steps as Layer.)
6. Document uploaded. 

(Find the Infos. You can Share, Rate, Comment or make it Favourite)

28

GeoNode

Creating map

1. (Single layer) Go to your Layer > Create a Map 
Or, (Multiple layers) Main menu  > Data  > Layers > Click (+) and select the Layers 
> Create a Map

2. Layers > Edit if needed
3. Options > Save as  > Edit Properties > Fill in > Save
4. Map added
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GeoNode

Linking documents to layer/map

Downloading layer/ documents

1. Go to your Document > Edit Document > Metadata > Advanced Edit (You can 
use the Wizard)

1. (Layer) Go to your Layer > Download Layer > Select File type/ format.
2. Or, (Document) Go to your Document > Download Document.

2. Link to > Choose Layer/ Map > Update
3. Document Linked. 

(Check in your Layer page if the document is there)

30

Geonode

Tips
● Select appropriate file names when renaming Layers, Maps and 

Documents to ensure that data is kept clean.
● Fill out the metadata as best as you can, be as descriptive as 

possible as that will help identify files later. If you are unsure of 
anything you can fix it later.

● Set permissions for each layer, this is important for data security. 
The default is set to 'Anyone', meaning that anyone who can log 
in can edit the data.

● Use all the tagging and legend options to make the data filter 
process convenient for users.

● For linking multiple files as Documents to one Layer or Map, 
upload them as a zip folder rather than uploading separate files.

● To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-S
TINT_Wiki/blob/master/README.md)

(CDL WIKI  QR Code)

Step 3 Completed
33

GeoNode

Tips

• Select appropriate file names when 
renaming Layers, Maps and Documents to 
ensure that data is kept clean.

• Fill out the metadata as best as you can, 
be as descriptive as possible as that will 
help identify files later. If you are unsure of 
anything you can fix it later.

• Set permissions for each layer, this is 
important for data security. The default is 
set to ‘Anyone’, meaning that anyone who 
can log in can edit the data.

• Use all the tagging and legend options to 
make the data filter process convenient for 
users.

• For linking multiple files as Documents to 
one Layer or Map, upload them as a zip 
folder rather than uploading separate files.

To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-STINT_
Wiki/blob/master/README.md)

Step 3 Complete
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TOUR GUIDE
Analogue Design Game

Analogue Design Game: Tour Guide

Creation of Design Game

Format: Digital or Analogue Game Analogue

Intention: Which part of the design 
process do I need assistance with 
through co-design Understanding experience of school through user perspective

Precedent

Mission from Mars (Hagen et al 2012), Within this design game the researcher role-plays as an alien and 
participants are inhabitants of the planet, who have to guide the researcher through the planet to 
familiarise them with the context. The game is aimed at empowering the participant during the process of 
game play and allows the researcher to understand how participants perceive their environment.

Adaptation of precedent for research 
focus

For the dissertation application, the researcher role played as a new student transferring to the school 
and learners had to show the new student around and point out what the new student should know 
about the school and its functions

Challenges
The game did not require a lot of preparation beforehand and therefore did not create any challenges 
during the creation process.

Fig. 1. Tour Guide design game path taken through school (Naidoo 2020) Fig. 2. Tour Guide design game application on site at Tsako Thabo (Naidoo 2019)
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TOUR GUIDE
Analogue Design Game

Design Game Rule Book

Design Game Title Tour Guide

Design Game Objective/Overview
To understand the spatial points of impact of a learner's school environment and to gain further insight 
into the elements of their environment that they consider important to share

Platform/Site for Game Play
On site at Tsako Thabo Secondary School, Mamelodi East, South Africa (Entire school used as a platform 
for game play)

Game Pieces 

• Map of school so learners can locate themselves
• Video recording equipment to record journey tour through the school (capture participant body 
language, dialogue and the feel of space)

Number of players 4-6 Participants

Duration of play 15 Minutes

Game Play

• Inform your participants that you are role playing as a new student and their duty is to introduce you to 
the school
• Allow the participants (learners) to take ownership of the activity by guiding the researcher/s through 
the school from their perspective, highlighting important elements that the researcher/s should be aware 
of as 'new students' to the school
• Start recording the tour and allow participants to guide the researcher/s
• During the tour, researcher/s ask questions to gain further insight into the choices made participants (ie. 
Why are we not walking through this part of the school?)
• Game play ends when participants have concluded the tour they wish to take researcher/s on

Researchers role during game play 

• Observe users in field
• Take photographs
• Inferior to the participant

Application of Design Game

Participants 6 Learners (ages 16-20) from Tsako Thabo Secondary School, Mamelodi East, South Africa

Participation

 The ease of game play made it a simple game to partake in. Throughout game play, it stimulated 
curiosity within other learners in the school. Participants were able to equally engage with the researcher 
and other participants during game play to collectively decide on the tour path for the researcher to take.

Challenges 

Having to record the session and focus on the participants at the same time posed a challenge during 
game application. It would be useful to partner with another researcher for this game to ensure that the 
process is well documented. The other researcher can therefore scribe dialogue from participants onto 
the printed map according to their space associations.

Opportunities

Game play is quite flexible and can therefore be easily adapted on site depending on different paths 
participants want to take. Data obtained during game application documentation is also not limited to the 
partipant group, as video recording captures the wider activity occuring during the school at that time. 

Documentation of game play

The use of video has been acknowledged as a useful medium in capturing the richness usually lost in 
other media forms (Brandt, Messeter & Binder 2008:54). Video recorded during game play on site 
captured dialogue and path taken within school

Outcomes 

The participants took ownership of the game and were excited to guide the researcher/s  through the 
school. They were able to easily locate themselves on the map of the school. It was interesting that they 
guided the researcher/s to the 'dangerous' spaces of the school first, where it was briefly observed from 
a distance. Thereafter continued the tour to their preferred spaces of the school.

 

Contribution to the design process
Understand the points of tension within the school as well as the preferred spaces of the school. Attained 
a deeper spatial understanding of the educational environment within the school.

Fig. 3. Design informants from game application (Naidoo 2019)

Fig. 4. Design informants from game application (Naidoo 2019)
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Analogue Design Game

Fig. 5. Design informants from game application (Naidoo 2019)



A
P

P
E

N
D

IX
 2

.B

2.B

DOTS
Analogue Design Game



573Appendix 2B572 573

DOTS
Analogue Design Game

Analogue Design Game: Dots

Creation of Design Game

Format: Digital or Analogue Game Analogue

Intention: Which part of the design 
process do I need assistance with 
through co-design To understand learners spatial association within the school

Precedent -

Adaptation of precedent for research 
focus -

Challenges

The challenging element to the design game creation was deciding on the questions to ask the 
participants (learners) beforehand. Having not based the game off a precedent, it was difficult to assess 
how much could be achieved during the duration of game play. Therefore, at this stage, there was 
minimal control over aligning the game creation with the game outcome. The variable of time was 
particularly challenging in this case as researcher interaction with participants was limited to the 30 
minute duration of the school lunch break. The creation of the design game had to therefore consider 
what the most effective method of game play would be appropriate to render maximum output.

Fig. 1. Dots design game application on site at Tsako Thabo 
(Naidoo 2019)

Fig. 2. Dots design game application on site at Tsako Thabo 
(Naidoo 2019)

Design Game Rule Book

Design Game Title Dots

Design Game Objective/Overview Players are posed a question and allocate a space on site to the question

Platform/Site for Game Play On site at Tsako Thabo Secondary School, Mamelodi East, South Africa (Quiet space/room with a table)

Game Pieces 

• Map or model of the school
• Small coloured tokens to allocate a different colour per player
• List of questions to ask players
• Recording device

Number of players 5-6 Players

Duration of play 15-20 minutes

Game Play

• Each player gets a coloured token
• The researcher poses a question to the group:
Introvert- Where would you go to in the school for a quiet moment alone before, during and after school?
Safety- Where in the school do you feel safe?
Respect- If there were people vanalising the school, but you had the power to stop them, which part of 
the school would you protect?
Respected- Where in the school do you feel heard and untroubled?
Importance- If the school was being demolished but you could save one part, which would it be?
• Players place their coloured token on the map to where they spatially associate their answer to the 
question
• Engage in discussion to understand reasoning behind player decisions
• Continue in this sequence until all questions are asked

Researchers role during game play Facilitator: Poses the questions, stimulates dialogue and documents process of game play

Application of Design Game

Participants 5 Learners (ages 16-20) from Tsako Thabo Secondary School, Mamelodi East, South Africa

Participation

During the process of game play, players were easily able to engage with each others choices. It was 
evident that game play with peers influenced players decisions during game play. In a few cases, some 
players altered their initial placement of their token to align with their peers decisions. 

Challenges 

The main challenge was being able to facilitate game play as well as document it. It would be beneficial 
to partner with another researcher who focuses on documenting the design game outcomes while the 
main researcher facilitates game play. It was also challenging to work on site under the trees with a table 
taken from a classroom, to remove from the nise of the learners during their break time. The natural 
environment and wind made it difficult to deal with the game pieces effectively. 

Opportunities
The order of game play was fluid enough to adapt to the condition on site. In some cases, post 
discussion, alternative questions were raised which were easily incorporated into game play

Documentation of game play
Recorded during game play which documented dialogue as well as question raised and resulting 
placement of player token

Outcomes 
Reflection post game play was able to highlight whether the learners answers to the questions were 
related to the space itself or the people/activity occupying the space

Contribution to the design process

Able to gain deeper understanding of the spatial connotations students place on the school environment. 
Overlaying the choices of students highlighted key spaces within the school that had positive 
connotations to the learners. 
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STACKED
Analogue Design Game

Analogue Design Game: Stacked

Creation of Design Game

Format: Digital or Analogue Game Analogue

Intention: Which part of the design 
process do I need assistance with 
through co-design

To engage participants in the spatial construction of the educational built environment and to harness the 
potential of the existing site

Precedent -

Adaptation of precedent for research 
focus -

Challenges
The challenging element to the design game creation was being able to predict the kind of tools that 
would be needed on site. 

Design Game Rule Book

Design Game Title Stacked

Design Game Objective/Overview
To start envisioning an educational environment, through the use of model building, with considerations 
for the existing

Platform/Site for Game Play On site at Tsako Thabo Secondary School, Mamelodi East, South Africa (Quiet space/room with a table)

Game Pieces 

• Massing model of the site as movable elements
• Box cardboard
• Coloured paper
• Cutting tools
• Pens, pencils and ruler
• Prestik 
• Recording device/ camera

Number of players 5-6 Players

Duration of play 25 minutes

Game Play

1. Define
• Participants define an envisioned learning environment 
2. Massing
• Using the cardboard, participants allocate a massing block to a site in the school to spatially develop 
their vision
• Participants allocate a quality to their massing block (ie. enclosed, covered or open)
• Participants work amongst themselves to continue developing their envisioned site within the school 
boundary
• Engage in discussion as to the quality of space and experience of the envisioned site
3. External Quality
• Coloured paper is used to allocate external surface quality of the site 
4. Hierarchy
• Participants allocate hierarchy to site by stacking cardboard to massing elements to highlight 
importance from participants perspective
5. Discussion
• Participants engage in a relective session to discuss their decisions throughout game play and the final 
achieved vision

Researchers role during game play Facilitator: Poses the questions, stimulates dialogue, documents process of game play but allows the 
participant to guide decision making during game play

Application of Design Game
Participants 6 Learners (ages 16-20) from Tsako Thabo Secondary School, Mamelodi East, South Africa

Participation

Participation from the group was incredibly fruitful with participants stimulating and interacting with each 
other through the decision making process. An accumulation of simultaneous action of cutting building 
blocks, allocating space and decision making made for successful participation. 

Challenges 

The design game heavily focussed on a spatial outcome and was therefore initially challenging to get 
participants to understand the intention of the game. Therefore game play was slow to start, however 
with stimulation from the researcher, participants were able to engage and become comfortable with 
decision making. Another challenge was being able to mediate game play with the distraction of other 
learners on their lunch break and unsuitable location to carry out game play on site (a single desk outside 
under the trees)

Opportunities

The game pieces allowed for flexible interpretation because participants were not limited to prescribed 
shapes/building blocks to construct their vision. The fluidity of the game rendered creativity. If spatial 
depiction was limited, then the dialogue surrounding spatial quality contributed to decision making and 
the design game outcome

Documentation of game play
Video recorded during game play on site which captures dialogue and design decisions made by 
participant group

Outcomes Participants were able to spatially define their envisioned educational built environment on site. 

Contribution to the design process

From the process of game play, the researcher was able to gather information on the quality of space that 
was aspired for by learners but lacking within the current context of the school. It was also evident of the 
potential within existing sites of the school that was not harnessed within the existing use 

Fig. 1. Application of analogue design game on site at Tsako 
Thabo (Achi 2019) Fig. 3. Stacked design game application (Naidoo 2019)

Fig. 2. Stacked design game application (Naidoo 2019)
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AUTOCORRECT
THE (TYPO)LOGY GAME

Digital Design Game

Digital Design Game: AutoCorrect

Creation of Design Game

Format: Digital or Analogue Game Digital

Intention: Which part of the design 
process do I need assistance with 
through co-design

AutoCorrect was intended to assist in the early stages of the co-design process to assist participants in 
the conceptual understanding of the role that different levels of influence have on how school typologies 
are constructed

Precedent -

Adaptation of precedent for research 
focus -

Challenges

Initially finding a digital medium to host the board game was a challenge, however once TabletopiaTM 
was identified, creation through the site was user friendly. Creating the game online was a time 
consuming task as all the game pieces needed to be developed beforehand and loaded onto the 
platform. 

Fig.1. Autocorrect Game (Naidoo 2020)

Design Game Rule Book

Design Game Title AutoCorrect

Design Game Objective/Overview

AutoCorrect is an architectural game where participants construct a school typology using building 
blocks according to the restrictions provided by Government and the community in the context. 
Government policy for public school infrastructure provide you with the building patterns for your school 
typology and external factors guide your actions on how you construct those building patterns together. 

Platform for Game Play TabletopiaTM for Digital Play and Google MeetsTM for communication during play

Game Pieces 

• 1x Game Board - Each player constructs their school typology within their quadrant. Each quadrant 
represents a different context
• 1x Die - Coloured side to represent player colours during game play
• 12x Policy Cards - Dictate the number of rounds in the game. The Policy Cards represent the different 
guidelines within government policy for public school infrastructure
• 48x Action Cards - There are 3 types of Actions Cards in the game. The Action Cards play an individual 
role in each player's construction of their typology. This card represents the external factors from a school 
context that affect the educational environment.
• 4 sets of 54x Building Blocks - Each player uses an individual colour set of building blocks to construct 
their school typology. You have different layers of influence that affect the spatial and non-spatial 
environment of a school. Building blocks represent these spatial elements
• 48x Problem/Opportunity Tile - Collected at different points during the game. These tiles affect a player’
s score. You have different layers of influence that affect the spatial and non-spatial environment of a 
school. Problem / Opportunity Tiles represent these non- spatial elements.

Number of players 4 Players

Duration of play 40-60 Minutes

Game Play

• The game begins with each player selecting quadrant of the game board to construct their school 
typology
• Shuffle each card pile and place them face down on the game board
• To start the round, Player 1 draws a Policy Card and places it face up on the game board
• Each player draws a single Action Card
• Using Building Blocks for your colour quadrant, each player must construct the pattern of the Policy 
Card according to their individual Action Card
• Each player who successfully constructs their pattern collects 1 Opportunity Tile and places it in their 
Opportunity Pile on the game board
• Each player who is unsuccessful, rolls the die to determine the number of Problems Tiles to collect and 
place in their Problem Pile on the game board
• End of round 1
• Round 2-12 repeats the steps of round 1 but rotates clockwise between the players to determine the 
order of drawing Policy and Action Cards
• End of Round 12
• Each player places their collected Opportunity Tiles from their Opportunity Pile in the open spaces on 
their quadrant
• Thereafter if any players have excess Opportunity tiles, they must roll the die to land on a colour of 
another player, to donate their Opportunity Tiles.
• Calculate the scores (The player with the lowest score wins! Each player calculates their score based 
on: Blank spaces on the game board quadrant = 1 Point each Collected Problem Tile = 2 Points each)

Researchers role during game play • Observe player decisions 
• Facilitate conversation post game play on the conceptual understanding of the design game
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AUTOCORRECT
THE (TYPO)LOGY GAME

Digital Design Game

Application of Design Game

Participation

TabletopiaTM allowed for live game play by all participants on a single platform, therefore interaction was 
encouraged between players. The process of game play using the site was stimulating. Assisting this 
process with the use of google meets allowed for open dialogue amongst participants during game play

Challenges 
Participants needed a reliable internet connection for game play to flow smoothly and to engage in 
conversation throughout

Opportunities

Hosting the game using TabletopiaTM, allows for wide range of participants internationally and locally. It 
provides the opportunity to easily send a link to participants at any given time and immediately engage in 
game play without the worry of putting together game pieces

Documentation of game play 

Using Google MeetsTM as a communication medium allows the opportunity to record the session 
through the screen sharing option. This way the entire video footage of game play, accompanied by 
dialogue, is documented and immediately uploaded to the researchers linked Google DriveTM

Outcomes from participants

Game play with participants highlighted how the game also allows for interpretation. Participants were 
able to become aware of the policy that guides public school infrastructure and also challenged the 
limitations present within the game mechanics

Contribution to the design process

AutoCorrect allowed the researcher to grasp the conceptual understanding of the dissertation topic in 
order to communicate with participants clearly. It assisted the process by providing participants with 
background knowledge regarding the context that following co-design sessions would be dealing with

Fig. 2. Autocorrect (Naidoo 2020)

Fig. 3. Screenshot from AutoCorrect Game Play using TabletopiaTM (Naidoo 2020) 

Fig. 4. AutoCorrect game board (Naidoo 2020)
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Digital Design Game

Fig. 5. AutoCorrect Design Game Rulebook (Naidoo 2020)
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Digital Design Game

Fig. 6. AutoCorrect Design Game Rulebook (Naidoo 2020)
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AUTOCORRECT
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Digital Design Game

Fig. 7. AutoCorrect Design Game Rulebook (Naidoo 2020)
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AUTOCORRECT
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Digital Design Game

Fig. 8. AutoCorrect Design Game Rulebook (Naidoo 2020)
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Digital Design Game

Fig. 9. AutoCorrect Design Game Rulebook (Naidoo 2020)
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Digital Design Game

Fig. 10. AutoCorrect Design Game Rulebook (Naidoo 2020)
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Fig. 11. AutoCorrect Design Game Policy Cards (Naidoo 2020)
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Fig. 12. AutoCorrect Design Game Action Cards (Naidoo 2020)
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PERSONA
Digital Design Game

Digital Design Game: Persona

Creation of Design Game

Format: Digital or Analogue Game Digital

Intention: Which part of the design 
process do I need assistance with 
through co-design

The inability to actively engage with learners from Tsako Thabo has reduced the qualitative concerns of 
the dissertation. User experience and the social and psychological quality of the programme has lacked 
consideration within the dissertation. The intention of the design game is to contribute to understanding 
the user experience in relation to the programmatic considerations. Failure to successfully get in contact 
with learners from Tsako Thabo, has resulted in the consideration of role play.  Roleplay is a useful 
method to engage in participation. It can provide a voice for those who are not generally heard or 
considered in the design process (Hamdi 2010:74). Selected participants for design game play have been 
chosen from a group of students who have previously engaged with the site and users and are therefore 
familiar with the context. 

Precedent -

Adaptation for research focus User personas were created from collating collected primary data from interviews on site. 

Challenges
The creation of the design game did not present any major challenges and was easily created in digital 
format using Google SlidesTM without an excessive amount of time taken

Design Game Rule Book

Design Game Title Persona

Design Game Objective/Overview Understand the implications of programme on user experience of the site through role play

Platform for Game Play

Google SlidesTM- for visual and physical interaction with game elements
Google MeetTM- for voice communication during game play

Game Pieces 

•User profile cards
•Developed programme layout diagrams on a site plan (imported as a jpeg. into Google SlidesTM)
•User scenario questions for each round:

Where would you be most active on site during school hours?
Where would you be most active on site out of school hours?
Where would you be most active on site during the evening?
Where would you feel the safest on site?

•Coloured tokens to track user decisions (shape tool using Google SlidesTM)

Number of players 4-6 Participants

Duration of play 45 minutes

Game Play

• Researcher introduces game objective and overview to participants
• Each participant selects a user profile card to roleplay as that character during the game
• A colour token is allocated to the corresponding user profile to track decisions made during game play
• The facilitator runs through the programme diagram to orientate the participants
• The game is played in rounds. Each round a scenario is presented to the user/participant 
• The user/participant then places their coloured token on the programme site plan
• Discussion amongst participants and facilitator after each round to understand user decisions

Researchers role during game play Facilitator 

Application of Design Game

Participants

4 Participants with a background in Urban Citizenship and experience with Tsako Thabo Secondary 
School, South Africa, were selected for design game play. These participants were selected to bridge the 
lockdown gap, due to the COVID-19 pandemic, that prevented contact with participants from the case 
study school. Participants took on user personas, developed based on interaction with user groups on 
site over a two year period, to guide their decisions during game play

Participation

Throughout game play, players were able to place themselves in the position of the user profiles to guide 
their decisions. The game play, however, did not lend itself to stimulate discussion amongst participants 
but rather was directional between researcher and participant. However communication was fruitful 
throughout game play

Challenges 
The base layer showing the plan could not be locked down on Google SlidesTM. Therefore, when 
participants selected their colour token to place on the plan, in some cases that base plan shifted.

Opportunities
The digital platform of Google SlidesTM allowed the opportunity to easily duplicate a slide to include 
extra questions that were not considered before hand

Documentation of game play

To document the design game application, the researcher sets up the google meeting and shares their 
screen with the google slides. Thereafter, they can record the session using the google meet option 
which then gets backed up to the linked google drive. This is beneficial for documenting the conversation 
had each round. Physical documentation was achieved after each round using the google slides.

Outcomes 
Participants found the design game easy to engage with and were able to take on the user personas with 
ease

Contribution to the design process

Design game play highlighted a shortcoming in the programmatic layout that clustered programme 
therefore limited movement throughout the site and negatively contributed towards creating inactive 
areas on site

Fig. 1. Persona cards (Naidoo 2020)



A
P

P
E

N
D

IX
 2

.F

2.F

STAKEHOLDER
Digital Design Game



607Appendix 2F606 607

STAKEHOLDER
Digital Design Game

Digital Design Game: Stakeholder

Creation of Design Game

Format: Digital or Analogue Game Digital

Intention: Which part of the design 
process do I need assistance with 
through co-design

The intention of the game was to collectively involve participants in how we can potentially redefine the 
built environment of the classroom

Precedent
The game mechanics were influenced by @Stake (Engagement Lab @ Emerson College 2020) - A game 
from EngagementLab at Emerson College intended to stimulate discussion amongst participants

Adaptation of precedent for research 
focus

User personas, participants hidden agendas during game play and the questions per round were 
adapted to directly relate to the the users within Mamelodi East and questions pertaining to redefining 
the classroom

Challenges

Converting the format of the game into a medium that would be user friendly for the participant group 
was an initial challenge. Using Google SlidesTM as a digital platform to host the game was successful, 
however it was limiting with the tools available such as a timer needed for game play

Fig. 1. Stakeholder design game player card (Naidoo 2020)

Design Game Rule Book

Design Game Title Stakeholder

Design Game Objective/Overview

Stakeholder is a role play game based on collective democratic decision making (Engagement Lab @ 
Emerson College 2020) . Throughout the game players voice their opinions and solutions to issues within 
the built educational environment. Participants provide proposals that redefine an alternative learning 
environment that is cognizant of varied learning styles as well as the use for community.

Platform for Game Play

Google SlidesTM- for visual interaction with game elements
Google MeetTM- for voice communication during game play

Game Pieces 

• Slide sequence explaining game play
• Slide showing questions per round
• Slide to send to participants with their hidden agenda and persona
• Timer

Number of players 4-6 Players dependent on the number of user profiles

Duration of play
Introduction to the game: 8-10 minutes
Each Round of Play: 10-15 minutes

Game Play

1. Introduction
• Introduce game objective to participants
• Highlight theme for the game session (ie. The focus of this session is on the ‘classroom’ spaces of public 
schools in Mamelodi East)
• A question is presented each round for players to find a solution to, that resolves the issue
• Each player receives a persona card to roleplay as a specific character. Each player is to take on the 
qualities of their character when making decisions throughout the game
• Along with the persona characteristics, each player has a hidden agenda each round. Your goal is to 
present a solution to the presented issue and integrate your hidden agenda into the solution
• Each round is guided by a player whose role is the decider. The decider selects the winning player from 
the best proposal. The winner receives all the coins from the pot
• After a winner is selected, the hidden agendas are revealed. If agendas are included in winning 
proposal, that player earns bonus coins
• The winner of the round, becomes the Decider in the next round. The player with the most coins at the 
end of three rounds wins!
• Start Round 1 (Researcher as the Decider for Round 1). Each player starts with 200 coins and the house 
pot holds 300 coins
• Give each player their persona card with hidden agenda. Allow them to introduce their persona (but not 
their hidden agenda)
2. Think
• In this phase participants will have 60 seconds to think of a proposal that addresses the question for the 
round 
Round 1: How can we adapt the built environment of the classrooms to accommodate varied learning 
styles?
Round 2: How can the built environment of the classroom be adapted for activities other than learning?
3. Pitch
• Now each participants will have 60 seconds to pitch their proposal to the group
4. Deliberate
• The Decider leads an open discussion with all participants about their proposals
5. Double Down
• Each participant has the option to spend 50 coins to buy an extra 30 seconds of time to add to their 
proposal or question another participant
6. Decide
• The round Decider selects the best proposal and winner of the round
• Participants reveal their hidden agendas to see who will receive a bonus 100 coins for having their 
agenda in the winning proposal
7. Score
• Which ever participant is in the lear will go on to be the decider in the next round. 
• Game play ends after all the rounds have been played (2-3 rounds)
(Engagement Lab @ Emerson College 2020) 

Researchers role during game play Facilitate game play and guide players through game play in first round.
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Application of Design Game

Participants

4 Participants with a background in Urban Citizenship and experience with Tsako Thabo Secondary 
School, South Africa, were selected for design game play. These participants were selected to bridge the 
lockdown gap, due to the COVID-19 pandemic, that prevented contact with participants from the case 
study school. Participants took on user personas, developed based on interaction with user groups on 
site over a two year period, to guide their decisions during game play

Participation

Throughout game play, the game mechanics allowed for a stimulating discussion on the question posed 
per round. Participants were also prompted to question and challenge each others proposals. This lent 
itself to a fruitful discussion and opened up a wider thought process regarding the game topic

Challenges Having to use a YouTubeTM timer on Google SlidesTM was problematic in getting it to play fluidly 

Opportunities

The structure of play of the game is clear enough to be able to use the same game mechanics with other 
themes present in a project. The clear structure maximises time and game output, therefore when time 
constraints are an issue, this game is particularly useful in achieving a great deal within the timeframe

Documentation of game play

To document the design game application, the researcher sets up the Google MeetTM and shares their 
screen with the Google SlidesTM open. Thereafter, they can record the session using the Google 
MeetTM option which then gets backed up to the linked Google DriveTM. 

Outcomes 

Round 1: How can we adapt the built environment of the classrooms to accommodate varied learning 
styles

• Player 1 Proposal: "Classrooms become open to the public on certain days, almost like an open day. It 
can be repetitive like on Mondays and Wednesdays or Saturdays. That would encourage people to move 
through the school. To encourage more people to attend, you can have sports days or market days on 
the same days community members can come in so that there are many different people interacting with 
the school and learning differently". 
• Player 2 Proposal: Agreed with Player 1's proposal and added "Spaces to allow for both formal and 
informal learning. The spaces should be multifunctional, where we use them as learning spaces but also 
social spaces. Maybe to host a wedding or church event in there as well"
• Player 3: "I think we should have spaces that are adaptable to various purposes and get rid of the boring 
approach to education. It would be nice to include physically active engaging learning instead of sitting 
all day listening to the teacher. Spaces that allow me to be physically active as if I'm playing, but at the 
same time I get to learn something. Maybe the spaces incorporate visual learning and make me transition 
physically as part of my learning" 
• Player 4: "I propose to have classrooms that expand beyond their boundaries. Maybe become a form of 
mobile learning. Having maybe trolleys of knowledge that pass through the school and thy share 
knowledge and learning. It could be in the form of a kitchen or library that it connects the classrooms 
with. Events could be linked to these. It could relate to co-curricular activities".

Round 2: How can the built environment of the classroom be adapted for activities other than learning?

• Player 1: "Have market days. It would be interesting for the classrooms to be adapted in ways that can 
open up to the street and to the internal courtyards so it invites people in and catches peoples attention 
as they walk past. Perhaps there can be live music stations. Places where you can buy food and come 
and sit down. It becomes a nice social space. So its an attraction for the community and for students to 
come in and have a vibe, spend time with their family and friends" 
• Player 2: "Multifunctional spaces that can accomodate different activity throughout. It can be dedicated 
spaces for music and sport but within those spaces it can change for multifunctionality. It has that element 
of adaptability. It must accomodate different qualities like say a sacred space vs a fun space"
• Player 3: "Im thinking how it can be to incorporate many more people. So maybe the current boundaries 
can be extended or they could be made open. The boundary of the classroom could be open or closed 
when needed. It could be adapted to accomodate booths for various people to use. Expand the 
connections to the outdoors. Maybe the surrounding neighborhood to be connected in a way that 
supports physical engagement with the school" 

Contribution to the design process
Three themes emerged from the collective discussion regarding the redefinition of the classroom: 
adaptability/multifunctionality, social activity of learning and knowledge beyond the boundary

Fig. 2. Stakeholder design game player card (Naidoo 2020)

Fig. 3. Stakeholder design game player card (Naidoo 2020)
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Stakeholder
Architectural Design Game

Adapting the game @stake to a Master of Architecture Dissertation

Stakeholder is a role play game based on collective 
democratic decision making. Throughout the game 
players voice their opinions and solutions to issues 

within the built educational environment

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)

The focus of this session is on the ‘classroom’ spaces of 
public schools in Mamelodi East

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)
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A question is presented each round for players to find a 
solution to, that resolves the issue

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Each player receives a persona card to roleplay as a 
specific character. Each player is to take on the 

qualities of their character when making decisions 
throughout the game

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)

Along with the persona characteristics, each player has 
a hidden agenda each round. Your goal is to present a 

solution to the presented issue and integrate your 
hidden agenda into the solution

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Each round is guided by a player whose role is the 
decider. The decider selects the winning player from 
the best proposal. The winner receives all the coins 

from the pot

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)
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After a winner is selected, the hidden agendas are 
revealed. If agendas are included in winning proposal, 

that player earns bonus coins

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

The winner of the round, becomes the Decider in the 
next round. The player with the most coins at the end of 

three rounds wins!

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)

ROUND 1
Stakeholder

For Round One, I will be the Decider. Everyone have a 
look at your Persona Card

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)
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Let’s get to know each other! 
Patricia, please introduce yourself. But remember not to 

reveal your hidden agenda
Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Let’s get to know each other! 
Jacob, please introduce yourself. But remember not to 

reveal your hidden agenda
Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)

Let’s get to know each other! 
Lucky, please introduce yourself. But remember not to 

reveal your hidden agenda
Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Let’s get to know each other! 
Linda, please introduce yourself. But remember not to 

reveal your hidden agenda
Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
INTRO

Stakeholder design game process of play (Naidoo 2020)
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Now let’s move onto the problem solving phase!

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
THINK

In this phase you will have 60 seconds to think 
of a proposal that addresses the question: 

How can we adapt the built environment of 
the classrooms to accommodate varied 

learning styles?

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

THINK

Stakeholder design game process of play (Naidoo 2020)

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7
THINK

Remember your persona perspective and 
hidden agenda. After 60 seconds you will 

present your proposal to the group

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

THINK

Stakeholder design game process of play (Naidoo 2020)
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Your time starts now!!
?

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

THINK

Now each player will have a 60 seconds to 
pitch their proposal to the group

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

PITCH

Stakeholder design game process of play (Naidoo 2020)

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

PITCH

First up, Patricia

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

PITCH

Now, Jacob

Stakeholder design game process of play (Naidoo 2020)
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Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

PITCH

Now, Lucky

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

PITCH

Lastly, Linda

Stakeholder design game process of play (Naidoo 2020)

Now the Decider will lead an open discussion 
with all players about your proposals

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

DELIBERATE

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

DOUBLE DOWN

Each player now has the option to spend 50 
coins to buy an extra 30 seconds of time to 
add to their proposal or question another 

player

Stakeholder design game process of play (Naidoo 2020)
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Now to select the best proposal and winner of 
the round

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 300

DECIDE

Now to reveal the hidden agendas to see who 
will receive a bonus 100 coins for having their 

agenda in the winning proposal

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 0

DECIDE

Stakeholder design game process of play (Naidoo 2020)

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 0

DECIDE

Score time! Who is in the lead and will go on 
to be the decider in the next round

Adapted from https://atstakegame.org/ 

1 2 3 4 5 6 7

$

$

$

$ 200

200

200

200

$
$

$ 0

SCORE

Stakeholder design game process of play (Naidoo 2020)
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Digital Design Game: Interface

Creation of Design Game

Format: Digital or Analogue Game Digital

Intention: Which part of the design 
process do I need assistance with 
through co-design

A part of the dissertation was repositioning the school environment within Mamelodi East as publicly 
accessible. Due to this, there needed to be cognizance of the interaction between varying degrees of 
public and private. The game intention is to collectively define the articulation of these urban edge 
interfaces that deal with the presented conditions

Precedent -

Adaptation of precedent for research 
focus -

Challenges Finding an appropriate platform that would be accessible to all participants

Fig. 1. Interface design game application (Naidoo 2020)

Design Game Rule Book

Design Game Title Interface

Design Game Objective/Overview
Interface is a design game based on constructing the urban edge interface between a school and its 
context. Participants take on the personas of affected stakeholders to guide decisions during game play

Platform for Game Play

Google SlidesTM- for visual and physical interaction with game elements
Google MeetTM- for voice communication during game play

Game Pieces • Slide sequence explaining game play 
• Slide setting up game interface

Number of players 4 Participants

Duration of play
Introduction to the game: 8-10 minutes
Each Round of Play: 20-25 minutes

Game Play

1. Introduction
• Introduction of design game objective to participants
• A specific urban edge condition is presented for which participants must construct the interface 
qualities
• Throughout the game, each participant has an agenda that directs their decisions
• Participants receive a loan from the bank with an allocated budget to construct their urban edge
• Participants spend their budget on urban edge qualities from the bank
• During game play the other participants can invest some of their budget in the lead participant of the 
round's proposal
• The player who pitches the best urban edge proposal has their loan converted to a donation by the 
bank
• Each round is guided by the number of participants
• In each round, a player guides the session with the remaining players acting as potential investors 
2. Agenda
• All participants are given an agenda and persona to guide their decisions during game play
3. Context
• Round 1: Participant 1 is allocated a site condition that they have to consider the urban edge condition 
for
4. Purchase
• Participant 1 has the opportunity to spend their budget to purchase urban edge interface qualities from 
the bank
5. Negotiate
• Participant 1 can thereafter negotiate with participants 2-4 to invest in their urban edge site. If investors 
see the proposal aligning with their personal agendas, they have the option to spend a portion of their 
budget on participant 1's site
6. Arrange
• Now that participant 1 has gathered their interface qualities, they have to arrange them according to 
how they will sit from the private edge on site to the public edge
7. Request
• Participant 1 can thereafter make a special request from the bank if the bank did not stock a specific 
urban edge quality that was necessary for the proposal
8. End turn
• Participant 1 ends their turn and the next round begins with a new context location and participant 2 as 
leader. Therefore, participant 1 becomes an investor in the following rounds
9. Score
A winner is collectively decided by the group according to the participant who effectively spent their 
allocated funds, was successful in negotiation and whose final proposal best aligned with their persona 
and agenda

Researchers role during game play Facilitate game play and guide players through game play in first round.
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Application of Design Game

Participants
4x Social Inclusion Studio (Department of Architecture) Lecturers from Chalmers University of 
Technology, Sweden

Participation
Throughout game play, the game mechanics allowed for a stimulating discussion. Participants were also 
required to interact with each other which allowed for a more fruitful game outcome

Challenges 

Time constraint was the biggest challenge. The game required in depth thinking from participants and 
interaction between them to guide decisions, therefore allowing a lengthier window of time would benefit 
the game outcomes

Opportunities

Having point 7 of game play widens the scope of the game to stimulate creativity from the participant 
group. Therefore, specific qualities that were not decided beforehand by the researcher can be 
introduced into the game and incorporated for future applications

Documentation of game play

To document the design game application, the researcher sets up the google meeting and shares their 
screen with the google slides. Thereafter, they can record the session using the google meet option 
which then gets backed up to the linked google drive. 

Outcomes 

Participants were able to interact and engage with their personas to let it guide their decisions. 
Participants also widened the scope of the game by opening up the site to interpretation and adding on 
function/scenarios to consider in their decision making process

Contribution to the design process

Articulation of urban edge interface qualities for:
Public-Private interaction
Semi-public and Public Interaction
Public Interaction

Interface
Architectural Design Game

Interface design game process of play (Naidoo 2020)

Interface is a design game based on constructing the 
urban edge interface between a school and its context

WHAT IS THE GAME ABOUT

A specific urban edge condition is presented for which 
players must construct the interface qualities

GAME OVERVIEW

PRIVATE AGAINST 
PUBLIC

CLASSROOM 
AGAINST 

STREET EDGE

SEMI-PRIVATE AGAINST 
PUBLIC

SPORTS 
FIELD 

AGAINST 
STREET EDGE

PUBLIC

ARRIVAL 
PLAZA

Interface design game process of play (Naidoo 2020)
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Throughout the game, each player has an agenda that 
directs their decisions

GAME OVERVIEW

Community member who 
lives close to the school

Agenda: Place to 
socialise

Learner within the school

Agenda: Feel safe within 
the school

Entrepreneur from the 
community

Agenda: Sell produce to 
community and school

Players receive a loan from the bank with an allocated 
budget to construct their urban edge 

GAME OVERVIEW

$$$ 450450450

Interface design game process of play (Naidoo 2020)

Players spend their budget on urban edge qualities from 
the bank

GAME OVERVIEW

200 1005050100

200 200 100 100

The player who pitches the best urban edge proposal 
has their loan converted to a donation by the bank

GAME OVERVIEW

Interface design game process of play (Naidoo 2020)
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Process of play

HOW TO PLAY

1
AGENDA

2
SITE

3
PURCHASE

4
NEGOTIATE

5
ARRANGE

6
REQUEST

HOW TO PLAY

Potential Investors

$$

Learner within the school
Agenda: Feel safe within 

the school

PRIVATE AGAINST 
PUBLIC

CLASSROOM 
AGAINST 
STREET 
EDGE

$

-C
LA

S
S

R
O

O
M

 
ED

G
E-

-S
TR

EE
T 

ED
G

E-

A R R A N G E

P U R C H A S E

BANK

Resource from the 
bank

R E Q U E S T

450

150 150

100 50 50 200 100 200 200 100 100

Interface design game process of play (Naidoo 2020)

LET’S PLAY
Interface

GAME PLAY

Potential Investors

$$

Learner within the school
Agenda: Feel safe within 

the school

PRIVATE AGAINST 
PUBLIC

CLASSROOM 
AGAINST 
STREET 
EDGE

$

-C
LA

S
S

R
O

O
M

 
ED

G
E-

-S
TR

EE
T 

ED
G

E-

A R R A N G E

P U R C H A S E

BANK

Resource from the 
bank

R E Q U E S T

450

150 150

100 50 50 200 100 200 200 100 100

Interface design game process of play (Naidoo 2020)
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GAME PLAY

Potential Investors

$$

SEMI-PRIVATE 
AGAINST PUBLIC

SPORTS 
FIELD 

AGAINST 
STREET 
EDGE -F

IE
LD

 E
D

G
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-S
TR

EE
T 

ED
G

E-

A R R A N G E

P U R C H A S E

BANK

Resource from the 
bank

R E Q U E S T

150 150

100 50 50 200 100 200 200 100 100

Entrepreneur from the 
community

Agenda: Sell produce to 
community and school

450

$

GAME PLAY

Potential Investors

$$

PUBLIC

ARRIVAL 
PLAZA
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G
E-

-S
TR
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T 

ED
G

E-

A R R A N G E

P U R C H A S E

BANK

Resource from the 
bank
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Community member who 
lives close to the school
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socialise
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$

Interface design game process of play (Naidoo 2020)

Loan Conversion by the bank

WINNER

Interface design game process of play (Naidoo 2020)
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DESIGN 
GAMEKIT

Website
https://purllnaidoo.wixsite.

com/designgamekit

Fig. 1. Design GameKit Home Page (Naidoo 2020)

Fig. 2. Design GameKit About Page (Naidoo 2020)

Fig. 3. Design GameKit dissertation page with presentation video (Naidoo 2020)

Fig. 4. Design GameKit framework page (Naidoo 2020)
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DESIGN 
GAMEKIT

Website
https://purllnaidoo.wixsite.

com/designgamekit

Fig. 5. Design GameKit design games page (Naidoo 2020)

Fig. 6. Design GameKit Tour Guide game page (Naidoo 2020)

Fig. 7. Design GameKit Tour Guide game page (Naidoo 2020)

Fig. 8. Design GameKit AutoCorrect game page (Naidoo 2020)
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Reference number: EBIT/117/2020

Miss P Naidoo
Department: Architecture
University of Pretoria
Pretoria
0083

Dear Miss P Naidoo

FACULTY COMMITTEE FOR RESEARCH ETHICS AND INTEGRITY 

Your recent application to the EBIT Research Ethics Committee refers.

Approval is granted for the application with reference number that appears above. 

1. This means that the research project entitled "Redefining South African Government School 
Typologies to Encourage Lifelong Learning Potential" has been approved as submitted. It is important 
to note what approval implies. This is expanded on in the points that follow.

2. This approval does not imply that the researcher, student or lecturer is relieved of any accountability in terms of 
the Code of Ethics for Scholarly Activities of the University of Pretoria, or the Policy and Procedures for 
Responsible Research of the University of Pretoria. These documents are available on the website of the EBIT 
Research Ethics Committee. 

3. If action is taken beyond the approved application, approval is withdrawn automatically.

4. According to the regulations, any relevant problem arising from the study or research methodology as well as 
any amendments or changes, must be brought to the attention of the EBIT Research Ethics Office.

5. The Committee must be notified on completion of the project.

The Committee wishes you every success with the research project.

Prof K.-Y. Chan
Chair: Faculty Committee for Research Ethics and Integrity
FACULTY OF ENGINEERING, BUILT ENVIRONMENT AND INFORMATION TECHNOLOGY

ETHICS
Approval

 
 
 

10/03/2020 

EBIT FACULTY COMMITTEE FOR RESEARCH ETHICS AND INTEGRITY 
Dear Prof Chan, 
 
ETHICS RENEWAL 2020 

In terms of document reference number: EBIT/9/2018 

HONOURS STUDENTS, DEPARTMENT OF ARCHITECTURE: “STITCHING THE CITY: FROM 
MICRO-DATA TO MACRO-VIEWS” 

In terms of the conditions of approval granted for research to be undertaken as part of the RFS and RFP modules 
in the Honours programme, I would like to notify the committee that the research will be ongoing for the 2020 
academic year. I understand that all the conditions and responsibilities as stipulated in the approval will remain 
applicable to the project. 

Kindly note that the method of investigation will apply to two distinct geographic areas, namely Mamelodi 
(specifically centred around the Tsako Thabo Secondary School) and Moreleta East (specifically centred around 
the informal settlements of Plastic View and Cemetery View). Students will be engaging with ad-hoc members 
of the affected community as informants rather than subjects. 

I would like to declare that the following MArch(Prof) students will be involved with the project as a 
continuation of their Honours work undertaken during 2019 and will make use of the data for their 
mini-dissertations: 

 

Yours sincerely, 

 
Dr C Combrinck 
Senior Lecturer: Department of Architecture  
University of Pretoria 
Tel         +27 (0)12 420 6536 
Email      ​carin.combrinck@up.ac.za 

Student number Surname Name 

15042482 du Bois Morné 
15203329 Khoswe Vitukumbe 
15001700 Konstantinou Lauren 
12148131 Matena Dipuo 
15032371 Mulder Idelette 
15362282 Naidoo Purll 
15209106 Simeon Aimee 
13070330 Smith Kelsey 
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